SAP NetWeaver Composition Environment 7.1 SR5 on Windows: SAP MaxDB

Production Edition

Target Audience

- System Administrators
- Technical Consultants

Document version: 1.1 – 05/16/2008
Caution
Before you start the implementation, make sure you have the latest version of this document. You can find the latest version at http://www.sdn.sap.com/irj/sdn/nw-ce.

The following table provides an overview of the most important document changes.

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1</td>
<td>5/16/2008</td>
<td>Initial Version</td>
</tr>
</tbody>
</table>
## Table of Contents

### Chapter 1

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>7</td>
</tr>
<tr>
<td>1.1 How to Use This Guide</td>
<td>7</td>
</tr>
<tr>
<td>1.2 New Features</td>
<td>8</td>
</tr>
<tr>
<td>1.3 SAP Notes for the Installation</td>
<td>10</td>
</tr>
<tr>
<td>1.4 Online Information from SAP</td>
<td>11</td>
</tr>
<tr>
<td>1.5 Accessing the SAP Library</td>
<td>12</td>
</tr>
<tr>
<td>1.6 Naming Conventions</td>
<td>13</td>
</tr>
</tbody>
</table>

### Chapter 2

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning</td>
<td>15</td>
</tr>
<tr>
<td>2.1 Installation Options Covered by this Guide</td>
<td>15</td>
</tr>
<tr>
<td>2.1.1 Standard System</td>
<td>16</td>
</tr>
<tr>
<td>2.1.2 Distributed System</td>
<td>17</td>
</tr>
<tr>
<td>2.1.3 High Availability System</td>
<td>17</td>
</tr>
<tr>
<td>2.1.4 Additional Application Server Instance</td>
<td>18</td>
</tr>
<tr>
<td>2.1.5 Standalone Host Agent</td>
<td>19</td>
</tr>
<tr>
<td>2.2 Domain or Local Installation</td>
<td>21</td>
</tr>
<tr>
<td>2.3 Distribution of Components to Disks</td>
<td>21</td>
</tr>
<tr>
<td>2.4 SAP System Transport Host</td>
<td>24</td>
</tr>
<tr>
<td>2.5 Running Adobe Document Services on Non-supported Platforms</td>
<td>24</td>
</tr>
<tr>
<td>2.6 Integration of LDAP Directory Services</td>
<td>25</td>
</tr>
<tr>
<td>2.7 Installation of Multiple Components in One Database</td>
<td>28</td>
</tr>
</tbody>
</table>

### Chapter 3

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparation</td>
<td>31</td>
</tr>
<tr>
<td>3.1 Basic SAP System Parameters</td>
<td>32</td>
</tr>
<tr>
<td>3.2 Hardware and Software Requirements</td>
<td>39</td>
</tr>
<tr>
<td>3.2.1 Running the Prerequisite Checker in Standalone Mode (Optional)</td>
<td>40</td>
</tr>
<tr>
<td>3.2.2 Requirements for a Standard System</td>
<td>41</td>
</tr>
<tr>
<td>3.2.3 Requirements for a Distributed System</td>
<td>43</td>
</tr>
<tr>
<td>3.2.4 Requirements for a High-Availability System</td>
<td>46</td>
</tr>
<tr>
<td>3.2.5 Requirements for the Additional Application Server Instance</td>
<td>50</td>
</tr>
<tr>
<td>3.2.6 Requirements for the Host Agent as a Separate Installation</td>
<td>50</td>
</tr>
<tr>
<td>3.3 Preparing User Management for an External ABAP System</td>
<td>52</td>
</tr>
<tr>
<td>3.4 Checking the Windows File System</td>
<td>55</td>
</tr>
<tr>
<td>3.5 Checking the Windows Domain Structure</td>
<td>55</td>
</tr>
<tr>
<td>3.6 Reducing the Size of the File Cache</td>
<td>56</td>
</tr>
</tbody>
</table>
3.7 Required User Authorization for the Installation ........................................ 57
3.8 Performing a Domain Installation Without Being a Domain Administrator .... 58
3.9 Preparing the SAP System Transport Host .............................................. 61
3.10 Generating the SAP Solution Manager Key ........................................... 62
3.11 Preparing the Installation DVDs ............................................................ 63

Chapter 4

Installation .................................................................................................. 67
4.1 Running SAPinst ...................................................................................... 68
4.2 SAPinst Installation Options ................................................................. 72
4.3 Installing Additional Components (Optional) ........................................ 76
4.4 Installing SAP Memory Analyzer (Optional) .......................................... 78

Chapter 5

Post-Installation ......................................................................................... 81
5.1 Configuring the Windows Server 2008 Firewall .................................... 82
5.2 Logging On to the Application Server .................................................. 83
5.3 Ensuring User Security ......................................................................... 84
5.4 Installing the SAP License ................................................................. 87
5.5 Creating Symbolic Links on Windows Server 2008 for Application Servers . 87
5.6 Configuring the Transport Management System ................................... 88
5.7 Configuring the Remote Connection to SAP Support ............................ 89
5.8 Applying the Latest Kernel and Support Packages ............................... 89
5.9 Installing or Upgrading Database Studio for SAP MaxDB .................... 90
5.10 Secure Sockets Layer Protocol for Database Server Communication ........ 92
5.10.1 Installing the SAP Cryptographic Library ..................................... 92
5.10.2 Generating the Personal Security Environment .............................. 94
5.11 Backing Up the SAP MaxDB Database ............................................. 96
5.12 Updating the Database Software to the Current Release ..................... 97
5.13 Post-Installation Steps for the Host Agent ......................................... 97
5.14 Checking the SAP Java Documentation ............................................. 97
5.15 CE-Specific Post-Installation Activities ............................................. 99
5.16 Performing a Full System Backup ...................................................... 102
5.17 Post-Installation Steps for the Diagnostics Agent ............................... 102

Chapter 6

Additional Information .............................................................................. 103
6.1 Transporting Self-Developed Software Component Archives (SCA) into the System ................................................................. 103
6.2 Troubleshooting — Repairing an Inconsistent SAP MaxDB Installation ... 104
6.3 Restarting the SAP MaxDB Server Manually ....................................... 104
6.4 Configuration Templates .................................................................... 105
6.5 Uninstalling SAP NetWeaver Composition Environment .................... 106
6.6 SAP Directories ................................................................................. 106
6.7 Starting and Stopping the SAP System .............................................. 110
Chapter 7

High Availability with Microsoft Cluster Service

7.1 Planning ........................................................................... 118
7.1.1 System Configuration in MSCS ................................. 119
7.1.1.1 SAP System Components in an MSCS Configuration ... 119
7.1.1.2 Enqueue Replication Server in an MSCS Configuration . 122
7.1.2 Distribution of SAP System Components to Disks for MSCS . 123
7.1.3 Directories in an MSCS Configuration ......................... 127
7.1.4 IP Addresses in an MSCS Configuration ..................... 128
7.1.5 Obtaining and Determining IP Addresses for MSCS .......... 131
7.2 Preparation ..................................................................... 134
7.2.1 Assigning Drive Letters for MSCS ......................... 134
7.2.2 Mapping Host Names to IP Addresses for MSCS .......... 135
7.2.3 Checking the Mapping of Host Names for MSCS ........... 136
7.3 Installation .................................................................... 137
7.3.1 Clustering the SQL Server 2008 Database Server Software . 138
7.3.2 Moving MSCS Groups .............................................. 138
7.3.3 Rebooting During the Installation or Conversion for MSCS . 139
7.3.4 Installing the Central Services Instance (SCS) .............. 139
7.3.5 Configuring the First MSCS Node ............................. 141
7.3.6 Installing the Database on the First Node ................. 142
7.3.7 Configuring the Database on the Additional Node ....... 142
7.3.8 Installing the Database Instance ............................. 143
7.3.9 Installing the Host Agent on the Additional MSCS Node ... 143
7.3.10 Configuring the Additional MSCS Node ................. 144
7.3.11 Installing an Enqueue Replication Server ............... 145
7.3.12 Installing the Primary Application Server Instance ....... 146
7.3.13 Installing the Additional Application Server Instance .... 147
7.4 Post-Installation ......................................................... 148
7.4.1 Post-Installation Checks for Enqueue Replication Server . 149
7.4.1.1 Checking the Status of the Enqueue Replication Server with ENSMON . 149
7.4.1.2 Monitoring the Lock Table During Failover with ENQT .... 150
7.4.2 Starting and Stopping the SAP System in an MSCS Configuration .... 152
1 Introduction

This document explains how to install an SAP NetWeaver Composition Environment system as productive edition.
For more information about SAP NetWeaver Composition Environment, see http://sdn.sap.com/irj/sdn/nw-ce.

Constraints
You need to consider the following constraints before you start your installation:

- You must only use the SAP installation tools according to the instructions and for the purposes described in the SAP installation document. Improper use of the SAP installation tools can damage files and systems already installed.
- SAP system installations should only be performed by SAP Technical Consultants certified for your operating system, your database, and the SAP system that you are installing.
- For downward-compatible releases of DB/OS platforms for SAP products, SAP plans to regularly release the newest database (DB) and operating-system (OS) versions of SAP products. These releases are downward-compatible with earlier SAP system releases.

Note that for already shipped SAP components, we only support the installation for database versions proposed by the installation tool. Therefore, you must install an SAP component or perform a system copy using a downward-compatible database as follows:

- Install the component with the old proposed database version.
- Upgrade the old database version to the downward-compatible new version.

1.1 How to Use This Guide

At the beginning of each installation phase – planning, preparation, installation, post-installation, and (if relevant) high availability with Microsoft Cluster Service (MSCS) – you can find a list of the steps that you have to perform in that phase, as well as additional information. Detailed information about the steps for each phase is available in the relevant chapter.

When you plan the installation, you have to decide what exactly you want to install, because the steps within each phase vary according to the installation option you choose. The following installation options are described in this document:

- Standard system (formerly known as central system)
- Distributed system
1.2 New Features

Here you can find the new features in this release.

⚠️ Caution

Make sure that you read the release notes for your SAP system. You can find these at [http://service.sap.com/releasenotes](http://service.sap.com/releasenotes).

### SAP System Installation

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAPinst</td>
<td>SAPinst has the following new features:</td>
</tr>
<tr>
<td></td>
<td>The technical terms used for the instances of an SAP system have changed as follows:</td>
</tr>
</tbody>
</table>
|        | - “Central instance” (CI) is now called “primary application server instance”.
|        | - “Dialog instance” (DI) is now called “additional application server instance”.
<p>|        | <img src="image" alt="Note" /> The technical terms “Database instance”, “Java central services instance” (SCS). |
|        | “Central system” — meaning an SAP system running on one single host — is now called “standard system”. |
|        | <img src="image" alt="Host agent" /> Host agent |
|        | The host agent contains all of the required elements for centrally monitoring any host with the Alert Monitor or the SAP NetWeaver Administrator. It is automatically installed during the installation of all SAP NetWeaver components, except TREX. |
|        | The host agent is automatically installed with your SAP system. |
|        | You can also install a standalone host agent with SAPinst. There is a new installation option Host Agent available under <a href="http://service.sap.com/releasenotes">Software Life-Cycle Options → Additional Preparations</a>. |
|        | You only need to install a standalone host agent in the following cases: |
|        | - You want to centrally monitor a host that does not have an SAP component. |
|        | - You want to perform an upgrade to SAP NetWeaver. |
|        | The locations of all installation DVDs can be entered on one screen. |</p>
<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software Development Manager (SDM) no longer available in the Application Server Java</td>
<td>The Software Deployment Manager (SDM) is no longer part of the primary application server instance of a Java-only system. Therefore, there is no longer any technical difference between the primary application server instance and the additional application server instance of a Java-only system. The SAP system directory of both instances is now called J&lt;instance_number&gt;. J&lt;instance_number&gt; no longer exists.</td>
</tr>
<tr>
<td>Installation DVDs</td>
<td>You start the installation from the Installation Master DVD for your database.</td>
</tr>
<tr>
<td>Java Library</td>
<td>There is no longer a Java library for Java systems. Everything is now in the kernel. You no longer need APYJ2EELIB and RMVJ2EELIB.</td>
</tr>
<tr>
<td>SAP Java Virtual Machine (SAP JVM)</td>
<td>You no longer have to download and install a Java Development Kit (JDK) from another software vendor as a prerequisite for the installation with SAPinst. The SAP JVM is a Java Development Kit (JDK) provided and supported by SAP. The SAP JVM is fully compliant to the Java Standard Edition 5. It is available on the Installation Master DVD and is installed automatically by SAPinst when you start the installation.</td>
</tr>
</tbody>
</table>
| Visual Administrator tool integrated in SAP NetWeaver Administrator  | SAP NetWeaver Administrator is a brand new solution for monitoring and administering Java systems and their applications. It is a web-based tool for administration, configuration, and monitoring. The Visual Administrator tool is no longer available as a separate tool. It has been integrated in the SAP NetWeaver Administrator. SAP NetWeaver Administrator offers you most of the functions previously available in Visual Administrator, but redesigned for the task-oriented approach of SAP NetWeaver Administrator. For more information about SAP NetWeaver Administrator, see the SAP NetWeaver Master Guide and the following:  
  - Lifecycle Management  
  - Operations  
  - Knowledge Center  
  - Administration Note  
  There is a terminology change with Windows Cluster. As of Windows Server 2008 the high-availability feature is called “Failover Clustering”. For practical reason we are continuing to use the general abbreviation MSCS.
You have the following options to install a high-availability system with MSCS:
- You install one SAP system in one MSCS cluster.
- You install one SAP system in two MSCS clusters.
In both cases the following restrictions apply:
- You must install the (A)SCS instance on two MSCS nodes in one MSCS cluster.
- If your database supports the installation on several MSCS nodes, you can install the database instance on more than two MSCS nodes in one MSCS cluster. |
| SAP Solution Manager Diagnostics Agent                                | A SAP Solution Manager Diagnostics Agent (Diagnostics Agent) is a standalone Java program that runs on each of the systems managed by SAP Solution Manager Diagnostics. It gathers information and reports to the SAP Solution Manager system. For more information about the Diagnostics Agent, see [http://service.sap.com/diagnostics](http://service.sap.com/diagnostics). The installation of the Diagnostics Agent is now part of the Installation Master DVD. That is, you can choose between the following options: |
### Area | Description
---|---
If there is no Diagnostics Agent already installed on this physical or virtual host, it is installed automatically with an ASJava primary application server instance and additional application server instance.  
You can also install it as a standalone engine, for example if you want a non-SAP system to be managed by SAP Solution Manager Diagnostics.  
The installation of the Diagnostics Agent as a standalone engine is not described in this installation guide, but in the Diagnostics Agent Setup Guide, which is available at http://service.sap.com/diagnostics.

### Operating Systems

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
</table>
| Support of Operating Systems | **Note**  
This guide already includes information about the new Windows operating system, Windows Server 2008, which is not yet supported by all databases running an SAP system.  
- For supported operating system and database releases, see the Product Availability Matrix at http://service.sap.com/pam.  
- For forums, blogs, content, and community related to all of the supported databases and operating systems, see the Database and Operating Systems area at http://sdn.sap.com/irj/sdn/dbos. |

### Documentation

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Notes</td>
<td>You can now access SAP Notes directly in SAP Service Marketplace from your PDF. Place the cursor on the SAP Note &lt;number&gt; and double-click. A separate browser window opens to display the SAP Note.</td>
</tr>
</tbody>
</table>
| Links to the Internet | You can use the new links in the PDF files of the guides as follows:  
- Click the section headings such as New Features to jump back to the table of contents at the beginning of the guide.  
- Click an internet link such as http://service.sap.com to jump to the corresponding internet page. |

### 1.3 SAP Notes for the Installation

You **must** read the following SAP Notes **before** you start the installation. These SAP Notes contain the most recent information on the installation, as well as corrections to the installation documentation. Make sure that you have the up-to-date version of each SAP Note, which you can find at http://service.sap.com/notes.
1.4 Online Information from SAP

More information is available online as follows.

### Documentation

<table>
<thead>
<tr>
<th>Description</th>
<th>Internet Address</th>
<th>Title</th>
</tr>
</thead>
</table>

### SAP Notes for the Installation

<table>
<thead>
<tr>
<th>SAP Note Number</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>965569</td>
<td>SAP NetWeaver Installation Based On Kernel 7.II: Windows</td>
<td>Windows-specific information about the SAP system installation and corrections to this documentation.</td>
</tr>
<tr>
<td>73606</td>
<td>Supported Languages and Code Pages</td>
<td>Information on possible languages and language combinations in SAP systems.</td>
</tr>
<tr>
<td>953763</td>
<td>Installation of SAP NetWeaver Composition Environment 7.1</td>
<td>CE-specific information about the installation and corrections to this documentation.</td>
</tr>
<tr>
<td>966526</td>
<td>SAP NetWeaver Installation based on Kernel 7.II: MaxDB/Win</td>
<td>Platform-specific information about the SAP system installation (ABAP and Java) and corrections to this documentation.</td>
</tr>
<tr>
<td>820824</td>
<td>FAQ: MaxDB</td>
<td>Frequently asked questions (FAQ) on MaxDB.</td>
</tr>
<tr>
<td>855498</td>
<td>Installation Prerequisite Checker</td>
<td>SAP Software on UNIX, Windows and System i: Checking OS Dependencies.</td>
</tr>
<tr>
<td>73606</td>
<td>Supported Languages and Code Pages</td>
<td>Information on possible languages and language combinations in SAP systems.</td>
</tr>
<tr>
<td>1067221</td>
<td>Central Note for Heterogeneous Installation</td>
<td>Heterogeneous ABAP system landscapes on different operating systems have been released for some time. Heterogeneous Java system landscapes on different operating systems have now also been released. However, not every combination of operating system and database system is released. This SAP Note and its related SAP Notes describe the released operating system and database combinations.</td>
</tr>
</tbody>
</table>
1.5 Accessing the SAP Library

For more information about SAP NetWeaver, access the SAP Library from the SAP Help Portal at [http://help.sap.com](http://help.sap.com).

The references to SAP NetWeaver Library documentation in this documentation always refer to the following entry point on the SAP Help Portal:

---

**Note**

For information on Windows operating system security, see: [http://www.microsoft.com/security](http://www.microsoft.com/security)
1.6 Naming Conventions

In this documentation, the following naming conventions apply:

**Terminology**

- **SAP system** refers to *SAP NetWeaver CE 7.1*.
- **Diagnostics Agent** refers to *SAP Solution Manager Diagnostics Agent*.

| Only valid for: HA (MSCS) |

**Terminology for High Availability on Windows**

As of *Windows Server 2008* there are the following terminology changes for a cluster configuration:

- The cluster feature is now called *Failover Clustering*. For practical reasons we are continuing to use the general abbreviation *MSCS* in this guide.
- *Cluster groups* are now called *services and applications*.
- The *Cluster Administrator* is now called *Failover Cluster Management*.

| End of: HA (MSCS) |

**Variables**

<table>
<thead>
<tr>
<th>Variables</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;SAPSID&gt;</td>
<td>SAP system ID in uppercase letters</td>
</tr>
<tr>
<td>&lt;sapsid&gt;</td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;sid&gt; and &lt;sapsid&gt;</td>
<td>SAP system ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;DBSID&gt;</td>
<td>Database ID in uppercase letters</td>
</tr>
<tr>
<td>&lt;dbsid&gt;</td>
<td>Database ID in lowercase letters</td>
</tr>
<tr>
<td>&lt;host_name&gt;</td>
<td>Name of the corresponding host</td>
</tr>
<tr>
<td>&lt;INSTDIR&gt;</td>
<td>Installation directory for the SAP system</td>
</tr>
<tr>
<td>&lt;DVD_DIR&gt;</td>
<td>Directory on which a DVD is mounted</td>
</tr>
<tr>
<td>&lt;OS&gt;</td>
<td>Operating system name within a path</td>
</tr>
<tr>
<td>&lt;SCHEMAID&gt;</td>
<td>Database schema ID</td>
</tr>
</tbody>
</table>

The following example shows how the variables are used:

**Example**

Log on as user `<sapsid>adm` and change to the directory `\usr\sap\<SAPSID>`.
If your SAP system ID is C11, log on as user `c11adm` and change to the directory: `\usr\sap\C11`. 

05/16/2008
This page is intentionally left blank.
2 Planning

This section provides general planning information.

You must first:

1. Plan your SAP system landscape according to the Master Guide and the Technical Infrastructure Guide available for your product.
2. Decide on your installation option [page 15].

Now continue with the section for your chosen installation option below.

Standard, Distributed, or High-Availability System

1. You decide whether you want to perform a domain or local installation [page 21].
2. For the database installation, you decide on how to distribute your system components [page 21].
3. You decide on the transport host to use [page 24].
4. If you want to use Adobe Document Services (ADS), you check what you have to do if your platform is not supported for ADS [page 24].
5. You decide whether you want to install multiple components in one database (MCOD) [page 28].

Only valid for: HA (MSCS)

6. If you want to install a high-availability system with Microsoft Cluster Service (MSCS), see the MSCS-specific planning activities [page 118].

End of: HA (MSCS)

7. You can now continue with Preparation [page 31].

Additional Application Server Instance

You do not have to perform any planning steps.

You can immediately continue with Preparation [page 31].

Host Agent as a Standalone Installation

You do not have to perform any planning steps.

You can immediately continue with Preparation [page 31].

2.1 Installation Options Covered by this Guide

This section shows the installation options covered by this installation guide.

- Standard system [page 16] (formerly known as central system)
2 Planning
2.1 Installation Options Covered by this Guide

- **Distributed system** [page 17]
  
  Only valid for: HA (MCS)

- **High-availability system** [page 17]
  
  End of: HA (MCS)

You can install one or more additional application server instance(s) [page 18] to an existing standard, distributed or high-availability system.

You can install a standalone host agent [page 19].

### 2.1.1 Standard System

You can install a standard system on a single host.

In a standard system, all main instances run on a single host:

- Central services instance (SCS)
- Database instance (DB)
- Primary application server instance

**Figure 1**: Standard System

![Standard System Diagram](image)

SCS = Java central services instance  
PAS = Primary application server instance  
DB = Database instance

Optionally you can install one or more additional application server instances. For more information, see *Additional Application Server Instance* [page 18].
2. Planning
2.1 Installation Options Covered by this Guide

2.1.2 Distributed System

In a distributed system, every instance can run on a separate host:

- Central services instance (SCS)
- Database instance (DB)
- Primary application server instance

Optionally you can install one or more additional application server instances. For more information, see Installation of an Additional Application Server Instance [page 18].

Figure 2: Distributed System

\[\text{SCS = Java central services instance} \]
\[\text{PAS = Primary application server instance} \]

2.1.3 High Availability System

For more information on the system components you have to install and how to distribute them on the specific hosts, see System Configuration in MSCS [page 119].
2.1.4 Additional Application Server Instance

You can install one or more additional application server instance(s) for an existing SAP system. An additional application server instance can run on:

- The host of any instance of the existing SAP system
- On a dedicated host

**Note**

It is not recommended to install additional application server instance(s) on the SAP global host.

**Additional Application Server Instance for a Standard System**

The following figure shows additional application server instances that are running on dedicated hosts.

**Figure 3: Additional Application Server Instance for a Standard System**

For additional information, see *Standard System* [page 16].

**Additional Application Server Instance for a Distributed System**

The following figure shows additional application server instances that are running on dedicated hosts.
2.1.5 Standalone Host Agent

Using the host agent you can centrally monitor any host with the Alert Monitor or the SAP NetWeaver Administrator or the Adaptive Computing Controller (ACC). In addition, the host agent is used by the ACC for starting, stopping, and relocating SAP instances and databases. For more information on the ACC see http://sdn.sap.com/irj/sdn/adaptive.

The host agent is automatically installed during the installation of all SAP NetWeaver instances and components.

You only need to install a standalone host agent in the following cases:

- You want to manage a host that does not have an SAP instance or component.
You have upgraded your SAP system to SAP NetWeaver 7.1 or higher and want the instances of the upgraded system to be managed by the ACC.

**Figure 5: Host Agent**

The host agents contain the following elements:

- The control program `saphostexec`
- The SAP NetWeaver Management agent `SAPHostControl` (`sapstartsrv` in host mode)
- The `sapacosprep` executable of the Adaptive Computing Infrastructure
- The operating system collector `saposcol`

**Note**

The installed programs are automatically started when the host is booted. On Microsoft Windows hosts, the services `SAPHostControl` and `SAPHostExec` do this.

**More Information**

For more information about the host agent, see the SAP Library [page 12]:

- Function-Oriented View
- Application Server ABAP
- Administration Tools for AS ABAP
- Monitoring in the CCMS
- Infrastructure of the NetWeaver Management Agents
2.2 Domain or Local Installation

Before you install the SAP system, you have to decide whether you want to perform a domain or local installation, since this affects how the user account information is stored and accessed. For more information about the differences between a local and domain installation, see the Microsoft article Deciding Between Workgroups and Domains at: http://technet2.microsoft.com/windowsserver/en/library/

Domain Installation

In a domain installation, the user account information is stored centrally in one database on the domain controller and is accessible to all hosts in the system. You have to perform a domain installation if one of the following applies:

- You install a distributed system (strongly recommended to avoid authorization problems).
- You install a high-availability system with MSCS.
- You use a common transport host for several SAP systems running on different computers.

Local Installation

In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system. If the SAP system is to run on a single machine (standard system), you can perform a local installation.

Note
If your SAP system was installed as a local installation and you want to later change to a domain installation, you must perform a homogeneous system copy. For more information, see the documentation Homogeneous and Heterogeneous System Copy for SAP Systems based on SAP NetWeaver at: http://service.sap.com/instguides <your product> 4

More Information
Required User Authorization for the Installation [page 57]

2.3 Distribution of Components to Disks

When you install the SAP system, the installation tools prompt you to enter drive letters for the main components of the system. This lets you distribute components to disks in the system as required. How you do this significantly affects system throughput and data security, so you need to plan it carefully.
The best distribution depends on your environment and must reflect factors such as the size of the components involved, security requirements, and the expected workload. When you work out the assignment of components to disks, you first need to get an overview of the main components and their corresponding directories. On the basis of sample configurations and the recommendations provided in this documentation, you can then choose the best setup for your particular system.

In most situations, SAP systems are installed on RAID arrays to guarantee data redundancy. Therefore, this documentation focuses on RAID subsystems and drives.

**Features**

The following graphic shows how you can distribute the main directories created during the installation to Redundant Arrays of Independent Disks (RAID). The distribution is suitable for an average-sized production system. Keep in mind that this is only an example and that no single solution fits all environments.

**Figure 6: Directory Distribution for RAID**

This configuration is suitable for the main host of a central system or the database server of a standalone database system. You can assign the components on the left to any of the arrays shown. You do not necessarily have to place the transport directory on the central instance host.
This setup has the following key features:

- **Security of the Logs**
  The security of the logs is crucial. The logs record all the changes made to the database and so provide the information that is necessary to recover a damaged database. Therefore, it is important that they are stored securely and that you never lose them at the same time as the database data. By placing the redo logs on a **different** array to the database data, you can make sure that they are not lost if the array with the database data is severely damaged.

- **Performance**
  You can reduce I/O bottlenecks by placing the original logical log on a different array than the mirrored log. Original and mirrored logs are written in parallel. If they are located on the same array, this results in a high level of write activity that has to be handled by the same controller. By separating original and mirrored logs, you can distribute the write activity to two different arrays, so reducing I/O bottlenecks.

- **RAID**
  By using RAID 1 arrays for the original and mirrored logs, you get high data security and good performance. The data is written to a primary disk and duplicated identically to a second disk. If one disk fails, the data is still intact on the second disk.
  The use of RAID 5 for the database ensures fault tolerance. The data is striped over all the disks in the array together with parity information. If one disk fails, the parity information is used to automatically reconstruct the data lost on the damaged disk.

- **Number of RAID Arrays**
  In the example above, three RAID 1 arrays are used for the redo logs to ensure optimal performance and security. If you do not need the disk capacity offered by three arrays and can accept reduced performance, consider using a single array. In this case, you can use a single RAID 1 array for the original and mirrored logs.


2.4 SAP System Transport Host

The transport host contains the transport directory that is used by the SAP transport system to store transport data and change information of SAP systems, such as software programs, data dictionary data, or customization data. If you have several SAP systems they are usually organized in transport domains. In most cases, all SAP systems in a transport domain have a common transport directory. For more information, see the SAP Library [page 12]:


When you install an SAP system, SAPinst by default creates the transport directory on the primary application server instance host in /usr/sap/trans.

[Only valid for: HA (MSCS)]

Note

In an MSCS configuration, SAPinst by default creates the transport directory on the (ABAP) central services instance host in /usr/sap/trans.

[End of: HA (MSCS)]

You have to prepare this host for use by the new SAP system if one of the following applies to you:

- You want to locate the transport directory on another host.
- You want to use an existing transport host and directory in your SAP system landscape.

For more information, see Preparing the SAP System Transport Host [page 61].

More Information

SAP Directories [page 106]

2.5 Running Adobe Document Services on Nonsupported Platforms

Adobe document services (ADS) are currently not supported to run natively on all platforms supported by SAP systems based on SAP NetWeaver, in particular on 64-bit platforms.

Procedure

To use ADS in SAP landscapes on nonsupported platforms, install an additional standalone AS Java on a platform supported by ADS.

For more information, see SAP Note 925741.
More Information

For more information about running ADS on SAP systems based on SAP NetWeaver, see http://sdn.sap.com/irj/sdn/adobe.

2.6 Integration of LDAP Directory Services

This section explains the benefits of using the SAP system with the Lightweight Directory Access Protocol (LDAP) directory and gives an overview of the configuration steps required to use an SAP system with the directory.

LDAP defines a standard protocol for accessing directory services, which is supported by various directory products such as Microsoft Active Directory, and OpenLDAP slapd. Using directory services enables important information in a corporate network to be stored centrally on a server. The advantage of storing information centrally for the entire network is that you only have to maintain data once, which avoids redundancy and inconsistency.

If an LDAP directory is available in your corporate network, you can configure the SAP system to use this feature. For example, a correctly configured SAP system can read information from the directory and store information there.

Note

The SAP system can interact with the Active Directory using the LDAP protocol, which defines:

- The communication protocol between the SAP system and the directory
- How data in the directory is structured, accessed, or modified

If a directory other than the Active Directory also supports the LDAP protocol, the SAP system can take advantage of the information stored there. For example, if there is an LDAP directory on a UNIX or Windows server, you can configure the SAP system to use the information available there. In the following text, directories other than the Active Directory that implement the LDAP protocol are called generic LDAP directories.

Caution

This section does not provide information about the use of LDAP directories with the LDAP Connector. For more information about using and configuring the LDAP Connector for an ABAP system, see the SAP Library [page 12]:

- Function-Oriented View
- Security
- Identity Management
- Identity Management of the Application Server ABAP
- Configuration of Identity Management
- Directory Services
- LDAP Connector

Prerequisites

You can only configure the SAP system for Active Directory services or other LDAP directories if these are already available on the network. As of Windows 2000 or higher, the Active Directory
is automatically available on all domain controllers. A generic LDAP directory is an additional component that you must install separately on a UNIX or Windows server.

**Features**

In the SAP environment, you can exploit the information stored in an Active Directory or generic LDAP directory by using:

- SAP Logon
- The SAP Microsoft Management Console (SAP MMC)

For more information about the automatic registration of SAP components in LDAP directories and the benefits of using it in SAP Logon and SAP MMC, see the documentation *SAP System Information in Directory Services* on SAP Service Marketplace at:


**SAP Logon**

Instead of using a fixed list of systems and message servers, you can configure SAP Logon in the **sapmsg.ini** configuration file to find SAP systems and their message servers from the directory. If you configure SAP logon to use the LDAP directory, it queries the directory each time Server or Group selection is chosen to fetch up-to-date information on available SAP systems.

To use LDAP operation mode, make sure that the **sapmsg.ini** file contains the following:

```
[Address]
Mode=LDAPdirectory
LDAPserver=
LDAPnode=
LDAPoptions=
```

Distinguish the following cases:

- If you use an Active Directory, you must set `LDAPoptions=“DirType=NT5ADS”`. For more information, see the SAP system profile parameter `ldap/options`.
- You must specify the directory servers (for example, `LDAPserver=pcint16 p24709`) if either of the following is true:
  - The client is not located in the same domain forest as the Active Directory
  - The operating system does not have a directory service client (Windows NT and Windows 9X without installed `dclient`).

For more information, see the SAP system profile parameter `ldap/servers`.

- For other directory services, you can use `LDAPNode` to specify the distinguished name of the SAP root node. For more information, see the SAP system profile parameter `ldap/saproot`.

**SAP MMC**

The SAP MMC is a graphical user interface (GUI) for administering and monitoring SAP systems from a central location. It is automatically set up when you install an SAP system on Windows. If the SAP
system has been prepared correctly, the SAP MMC presents and analyzes system information that it gathers from various sources, including the Active Directory. Integrating the Active Directory as a source of information has advantages for the SAP MMC. It can read system information straight from the directory that automatically registers changes to the system landscape. As a result, up-to-date information about all SAP application servers, their status, and parameter settings is always available in the SAP MMC.

If you need to administer distributed systems, we especially recommend that you use the SAP MMC together with Active Directory services. You can keep track of significant events in all of the systems from a single SAP MMC interface. You do not need to manually register changes in the system configuration. Instead, such changes are automatically updated in the directory and subsequently reflected in the SAP MMC.

If your SAP system is part of a heterogeneous SAP system landscape that comprises systems or instances both on Unix and Windows operating systems, you can also use the SAP MMC for operating and monitoring the instances running on Unix.

Note
You can also use the SAP Management Console (SAP MC) for administering and monitoring SAP systems from a central location. For more information about the SAP MC and about how to configure it to access LDAP directories, see the SAP Library [page 12]:
- Administrator's Guide
- Technical Operations for SAP NetWeaver
- Administration of SAP NetWeaver Systems
- AS Java (Application Server Java)
- Administration
- Administration Tools
- SAP Management Console

Configuration Tasks for LDAP Directories
This section describes the configuration tasks you have to perform for the Active Directory or other (generic) LDAP directories.

Configuration Tasks for Active Directory
To enable an SAP system to use the features offered by the Active Directory, you must configure the Active Directory so that it can store SAP system data.

To prepare the directory, you use SAPinst to automatically:

- Extend the Active Directory schema to include the SAP-specific data types
- Create the domain accounts required to enable the SAP system to access and modify the Active Directory. These are the group SAP_LDAP and the user sap1dap.
- Create the root container where information related to SAP is stored
- Control access to the container for SAP data by giving members of the SAP_LDAP group permission to read and write to the directory

You do this by running SAPinst [page 68] and choosing:  
- <SAP System>  
- Software Life-Cycle Options  
- LDAP Registration  
- Active Directory Configuration
You have to perform the directory server configuration only **once**. Then all SAP systems that need to register in this directory server can use this setup.

**Configuration Tasks for Generic LDAP Directories**

To configure other LDAP directories, refer to the documentation of your directory vendor. The **SAPinst** Installation Master DVD contains schema extensions for directory servers Netscape/iPlanet (1drgns4.txt) and OpenLDAP slapd (1drgs1apd.schema). Both files are located in the directory \DATA_UNITS\IM_<platform>\COMMON\ADS. After you have applied the schema extension, you need to create a root container to store the SAP-related information and create a directory user that the SAP application server can use to write information to the directory.

For more information about how to set up a Netscape/iPlanet directory server, see the documentation **SAP System Information in Directory Services** on SAP Service Marketplace at:


**Enabling the SAP System LDAP Registration**

Once you have correctly configured your directory server, you can enable the LDAP registration of the SAP system by setting some profile parameters in the default profile.

To do this, run **SAPinst** [page 68] **once** for your system and choose:

[Software Life-Cycle Options] [LDAP Registration] [LDAP Support]

If you use a directory server other than Microsoft Active Directory and/or non-Windows application servers, you have to store the directory user and password information by using `ldappasswd pf=<any_instance_profile>`. The information is encrypted for storage in DIR_GLOBAL and is therefore valid for all application servers. After restarting all application servers and start services, the system is registered in your directory server. The registration protocols of the components are `dev_ldap*`. The registration is updated every time a component starts.

### 2.7 Installation of Multiple Components in One Database

You can install **multiple** SAP systems in a **single** database. This is called Multiple Components in One Database (MCOD).

MCOD is available with all SAP components. This technology is available on all the major databases for the SAP system, in line with our commitment to deliver platform-independent solutions.

Using this technology is as easy as installing a separate component. No extra effort is required because the MCOD installation is fully integrated into the standard installation procedure. MCOD is not an additional installation option. Instead, it is an option of the database instance installation.

There are two MCOD scenarios:

- The installation of an SAP system in a new database
- The installation of an additional SAP system in an existing database
Prerequisites

- For about MCOD and its availability on different platforms, see http://service.sap.com/mcod.
- Since SAP does not support mixed solutions with MCOD, your SAP system must contain Unicode SAP instances only.
- Improved sizing required
  
  In general, you calculate the CPU usage for an MCOD database by adding up the CPU usage for each individual SAP system. You can do the same for memory resources and disk space. You can size multiple components in one database by sizing each individual component using the SAP Quick Sizer and then adding the requirements together. For about the SAP Quick Sizer, see http://service.sap.com/sizing.

Features

- Reduced administration effort
- Consistent system landscape for backup, system copy, administration, and recovery
- Increased security and reduced database failure for multiple SAP systems due to monitoring and administration of only one database
- Independent upgrade
  
  In an MCOD landscape, you can upgrade a single component independently from the other components running in the same database, assuming that the upgraded component runs on the same database version. However, if you need to restore a backup, be aware that all other components are also affected.

Note

Special MCOD considerations and differences from the standard procedure are listed where relevant in the installation documentation.

Constraints

- We strongly recommend that you test MCOD in a test or development system. We recommend that you run MCOD systems in the same context. We do not recommend that you mix test, development, and production systems in the same MCOD.
- In the event of database failure, all SAP systems running on the single database are affected.
- Automated support in an MCOD landscape for the following administrative tasks depends on your operating system and database:
  - Copying a single component from an MCOD landscape to another database at database level.
  - De-installing a single component from an MCOD landscape requires some additional steps. You can use a remote connection to SAP support to request help with these tasks. For more information, see http://service.sap.com/remoteconnection.
- You cannot install a Unicode SAP system with a non-Unicode SAP system in one database.
2. Planning
2.7 Installation of Multiple Components in One Database

Only valid for: HA (MSCS)

- **MSCS only**: You **cannot** install multiple components in one database with Microsoft Cluster Service (MSCS). For about MSCS, see *Microsoft Cluster Installation*.

For the first SAP system, the database system ID can be different from the SAP system ID.
- For the second SAP system, you must use the same **DBSID** as for the first SAP system.
- If you decide to turn off database logging during the database load phase of the installation, you need to plan downtime for all MCOD systems sharing the database.
3 Preparation

This section includes the preparation steps that you have to perform for the:

- Standard, distributed, or high-availability system
- Additional application server instance
- Standalone host agent

**Standard, Distributed, or High-Availability System**

**Note**
In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. You identify basic SAP system parameters [page 32].
2. You check the hardware and software requirements [page 39] on each host.
3. You check the Windows file system [page 55] on each host.
4. You check that all installation hosts belong to the correct Windows domain [page 55].
5. You reduce the size of the file cache [page 56] on each host.

**Note**
This step is not required if you use Windows Server 2008.

6. You check that you have the required user authorization for the installation [page 57].
7. If required, you perform a domain installation without being a domain administrator [page 58].
8. If required, you prepare the SAP system transport host [page 61] for your SAP system.
9. You make sure that the required installation media [page 63] are available on each host.

| Only valid for: HA (MSCS) |

10. For the installation of a high-availability system with Microsoft Cluster Service (MSCS), you also have to perform MSCS-specific preparation tasks [page 134].

| End of: HA (MSCS) |

11. You can now continue with Installation [page 67].

**Additional Application Server Instance**

You have to perform the following preparations on the host where you install the additional application server instance(s):
1. **You check the hardware and software requirements** [page 39].
2. **You check the Windows file system** [page 55].
3. **You check that your host belongs to the correct Windows domain** [page 55].
4. **You reduce the size of the file cache** [page 56].

   **Note**
   This step is not required if you use Windows Server 2008.

5. **You check that you have the required user authorization for the installation** [page 57].
6. If required, **you perform a domain installation without being a domain administrator** [page 58].
7. **You make sure that the required installation media** [page 63] are available.
8. **You can now continue with Installation** [page 67].

**Standalone Host Agent**
You have to perform the following preparations on the host where you install the host agent separately:

1. **You identify basic SAP system parameters** [page 32].
2. **You check the hardware and software requirements** [page 39].
3. **You check the Windows file system** [page 55].
4. **You reduce the size of the file cache** [page 56].

   **Note**
   This step is not required if you use Windows Server 2008.

5. **You check that you have the required user authorization for the installation** [page 57].
6. If required, **you perform a domain installation without being a domain administrator** [page 58].
7. **You make sure that the required installation media** [page 63] are available.
8. **You can now continue with Installation** [page 67].

### 3.1 Basic SAP System Parameters

SAPinst asks whether you want to run the installation in *Typical* or *Custom* mode.
If you choose *Typical*, SAPinst provides automatic default settings and you only have to respond to a minimum number of prompts. However, you can still change any of the default settings on the parameter summary screen.
The tables below list the basic system parameters that you always need to specify before installing your SAP system, both in typical and in custom mode.
For all other SAP system parameters, use the **F1** help in the SAPinst dialogs.
## SAP System ID and Database ID

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP System ID &lt;SAPSID&gt;</td>
<td>The SAP system ID &lt;SAPSID&gt; identifies the entire SAP system. SAPinst prompts you for the &lt;SAPSID&gt; when you execute the first installation option to install a new SAP system. If there are further installation options to be executed, SAPinst prompts you for the profile directory. For more information, see the description of the parameter SAP System Profile Directory.</td>
</tr>
<tr>
<td><strong>Example</strong></td>
<td>This prompt appears when you install the central services instance, which is the first instance to be installed in a distributed system.</td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>Choose your SAP system ID carefully. Renaming is difficult and requires you to reinstall the SAP system. Make sure that your SAP system ID:</td>
</tr>
</tbody>
</table>
|                    |  - Is unique throughout your organization  
  - Consists of exactly three alphanumeric characters  
  - Contains only uppercase letters  
  - Has a letter for the first character  
  - Does not include any of the following, which are reserved IDs: ADD ALL AND ANY ASC AUX COM CON DBA END EPS FOR GID IBM INT KEY LOG LPT MON NIX NOT NUL OFF OMS PRN RAW ROW SAP SET SGA SHG SID SQL SYS TMP UID USR VAR |
| Database ID <DBSID> | The <DBSID> identifies the database instance. SAPinst prompts you for the <DBSID> when you are installing the database instance. The <DBSID> can be the same as the <SAPSID>.                                                                                                                                 |
| **Caution**        | Choose your database ID carefully. Renaming is difficult and requires you to reinstall the SAP system. If you want to install a new database:                                                                                                                                        |
|                    | Make sure that your database ID:  
  - Is unique throughout your organization  
  - Consists of exactly three alphanumeric characters  
  - Contains only uppercase letters  
  - Has a letter for the first character  
  - Does not include any of the following, which are reserved IDs: ADD ALL AND ANY ASC AUX COM CON DBA END EPS FOR GID IBM INT KEY LOG LPT MON NIX NOT NUL OFF OMS PRN RAW ROW SAP SET SGA SHG SID SQL SYS TMP UID USR VAR |
|                    | If you want to use an existing database system:                                                                                                                                                                                                                                     |
### Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System ID <code>&lt;SMDSID&gt;</code> of SAP Solution Manager Diagnostics Agent</td>
<td>Enter exactly the database ID of the existing database to which you want to add the system.</td>
</tr>
<tr>
<td>SAP System Profile Directory</td>
<td>SAPInst sets <code>&lt;SMDSID&gt;</code> to DAA by default. If DAA is already used by another SAP system that is not a Diagnostics Agent instance, <code>&lt;SMDSID&gt;</code> is set to DA&lt;x&gt;, where &lt;x&gt; can be any letter from A to Z, and DA stands for “DiagnosticsAgent”). If required, you can change <code>&lt;SMDSID&gt;</code> to a value of your choice on the Parameter Summary screen. If you do so, the same naming conventions as for <code>&lt;SAPSID&gt;</code> apply. For more information, see entry “SAP System ID <code>&lt;SAPSID&gt;</code>” in this table above.</td>
</tr>
</tbody>
</table>

#### SAP System Profile Directory

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>\&lt;SAPGLOBALHOST&gt;\sapmnt\&lt;SAPSID&gt;\SYS\profile</code></td>
<td>The installation retrieves the parameters entered earlier from the SAP system profile directory. SAPInst prompts you to enter the location of the profile directory when the installation option that you execute is not the first one belonging to your SAP system installation. See also the description of the parameters <code>SAP System ID</code> and <code>Database ID</code>.</td>
</tr>
</tbody>
</table>

**Note**

If you install an additional application server instance in an existing SAP system, SAPInst also prompts you for the profile directory of the existing SAP system.

---

### SAP System Instances, Hosts, and Ports

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
</table>
| Instance Number of the SAP system | **Instance Number:** Technical identifier that is required for every instance of an SAP system, consisting of a two-digit number from 00 to 97. The instance number must be unique on a host. That is, if more than one SAP instance is running on the same host, these instances must be assigned different numbers. The instance number is used to specify the names of the SAP system instance directories which are created automatically by SAPInst during the installation:  
  - The directory of the central services instance is called `S<Instance_Number>`.  
  - The directory of the primary application server instance and of an additional application server instance is called `<Instance_Number>`.  
For more information, see SAP Directories [page 106]. |

**Caution**

Do **not** use 43, and 89 for the instance number because:  
- 43 is used by MSCS
<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>89 is used by Windows Terminal Server</td>
<td></td>
</tr>
<tr>
<td>Instance Number for the Diagnostics Agent</td>
<td>Technical identifier for internal processes for the Diagnostics Agent, consisting of a two-digit number from 00 to 98. The instance number is set automatically to the next free and valid instance number that has not yet been assigned to the SAP system. The instance number is used to specify the name of the Diagnostics Agent instance directory which are created automatically by SAPinst during the installation: The directory of the Diagnostics Agent instance is called J&lt;Instance_Number&gt;. For more information, see SAP Directories [page 106]. The same restrictions apply as in “Instance Number of the SAP system” (see above).</td>
</tr>
<tr>
<td>Virtual Host Name</td>
<td>You can use one or more virtual TCP/IP host names for SAP servers within an SAP server landscape to order to conceal their physical network identities from each other. This may be useful when moving SAP servers or complete server landscapes to other new hardware within a short time frame without having to carry out a reinstallation or complicated reconfiguration. If you want to use virtual host names for the installation, you have to specify the virtual host name before you start SAPinst [page 68]. Virtual host names are also required for a high-availability (HA) system. You need to specify the virtual host name, which is used by the (A)SCS instance. For more information about the use of virtual TCP/IP host names, see SAP Note 962955. The host name must not exceed 12 characters. For more information about the allowed host name length and characters, see SAP Note 611361.</td>
</tr>
<tr>
<td>Message Server Port</td>
<td>Caution The message server port number must be unique for the SAP system on all hosts. If there are several message port numbers on one host, all must be unique. <strong>Port Number of the SAP Message Server:</strong> If you do not specify a value, the default port number is used. The SCS instance profile contains the configuration for the Java message server. The Java message server port uses the parameter rdisp/msserv_internal with default value 39&lt;nn&gt;, where &lt;nn&gt; is the instance number of the SCS message server instance. For more information about the parameters used for message server ports, see SAP Note 821875.</td>
</tr>
</tbody>
</table>
3.1 Basic SAP System Parameters

Parameters for SAP System Drives

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination drive</td>
<td>Base directory for the SAP system.</td>
</tr>
</tbody>
</table>

Note

If you install a subsequent SAP system, the saploc share already exists and you cannot select the installation drive. SAPinst uses the installation drive where the saploc share points to.

Master Password

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Password</td>
<td>This password is used for all new user accounts SAPinst creates and for the secure store key phrase. The length has to be 8 to 14 characters. Depending on your installation scenario there might be more restrictions.</td>
</tr>
</tbody>
</table>

Caution

If you do not create the operating system users manually, SAPinst creates them with the common master password. For more information, see the description of the parameter Operating System Users. In this case, make sure that the master password meets the requirements of your operating system and of your database.

Operating System Users of the SAP System

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of Operating System Users</td>
<td>SAPinst processes the passwords of operating system users as follows:</td>
</tr>
<tr>
<td></td>
<td>If the operating system users do not exist, SAP creates the following users:</td>
</tr>
<tr>
<td></td>
<td>&lt;sapsid&gt;adm</td>
</tr>
<tr>
<td></td>
<td>This user is the SAP system administrator user and is a member of the</td>
</tr>
<tr>
<td></td>
<td>local Administrators group.</td>
</tr>
<tr>
<td></td>
<td>SAPService&lt;SAPSID&gt;</td>
</tr>
<tr>
<td></td>
<td>This user is the Windows account to run the SAP system. It is not a</td>
</tr>
<tr>
<td></td>
<td>member of the local Administrators group.</td>
</tr>
<tr>
<td></td>
<td>sapadm</td>
</tr>
<tr>
<td></td>
<td>The host agent user sapadm is used for central monitoring services and</td>
</tr>
<tr>
<td></td>
<td>is a member of the local Administrators group.</td>
</tr>
<tr>
<td></td>
<td>SAPinst sets the master password for these users by default. You can overwrite</td>
</tr>
<tr>
<td></td>
<td>and change the passwords either by using the parameter mode Custom or by</td>
</tr>
<tr>
<td></td>
<td>changing them on the parameter summary screen.</td>
</tr>
<tr>
<td></td>
<td>If the operating system users already exist, SAPinst prompts you for the</td>
</tr>
<tr>
<td></td>
<td>existing password, except the password of these users is the same as the</td>
</tr>
<tr>
<td></td>
<td>master password.</td>
</tr>
</tbody>
</table>
### User Management Engine (UME)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UME Configuration</td>
<td>SAPinst prompts you for how to configure the UME during the input phase of the installation. You can choose between the following options:</td>
</tr>
<tr>
<td></td>
<td>- Use Java database (default).</td>
</tr>
<tr>
<td></td>
<td>If you choose this option, administrators can manage users and groups with the UME Web admin tool and SAP NetWeaver Administrator only.</td>
</tr>
<tr>
<td></td>
<td>- Use an external ABAP system.</td>
</tr>
<tr>
<td></td>
<td>If you choose this option, administrators can manage users with the transaction SU01 on the external ABAP system, and, depending on the</td>
</tr>
<tr>
<td></td>
<td>permissions of the communication user, also with the UME Web admin tool and SAP NetWeaver Administrator.</td>
</tr>
<tr>
<td></td>
<td>You must have created the required users manually on the external ABAP system.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Preparing User Management for an External ABAP System [page 52].</td>
</tr>
<tr>
<td></td>
<td>For more information about supported UME data sources and change options, see SAP Note 718383.</td>
</tr>
</tbody>
</table>

**Using the Java Database:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Administrator User</td>
<td>SAPinst sets the user name Administrator and the master password by default. If required, you can choose another user name and password according to your requirements.</td>
</tr>
<tr>
<td>Java Guest User</td>
<td>SAPinst sets the user name Guest and the master password by default. The Guest user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group Authenticated Users and have read access only.</td>
</tr>
</tbody>
</table>

**Using an External ABAP System – Parameters for the ABAP Connection:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Server Instance Number</td>
<td>This is the instance number on the application server of the central ABAP system to which you want to connect the Application Server Java. To find out the number on the host of the primary application server instance, look under the SAP directory usr/sap/&lt;SAPSID&gt;/DVEBMGS&lt;nn&gt;. The value &lt;nn&gt; is the number assigned to the SAP system.</td>
</tr>
<tr>
<td>Application Server Host</td>
<td>This is the host name of the relevant application server instance. To find out the host name, enter <strong>hostname</strong> at the command prompt of the host running the primary application server instance.</td>
</tr>
</tbody>
</table>
### 3.1 Basic SAP System Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication User</td>
<td>This is the name and password of the existing ABAP communication user. You must have created this user manually on the external ABAP system.</td>
</tr>
</tbody>
</table>

**Using an External ABAP System – Parameters for the Application Server Java Connection:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator User</td>
<td>This is the name and password of the administrator user that you created on the external ABAP system.</td>
</tr>
<tr>
<td>Administrator Role</td>
<td>The role SAP_J2EE_ADMIN must exist on the external ABAP system.</td>
</tr>
<tr>
<td>Guest User</td>
<td>This is the name and password of the guest user that you created on the external ABAP system. The guest user is for employees who do not belong to a company or who have registered as company users with pending approval. Guest users belong to the default group Authenticated Users and have read access only.</td>
</tr>
<tr>
<td>Guest Role</td>
<td>The role SAP_J2EE_GUEST must exist on the external ABAP system.</td>
</tr>
</tbody>
</table>

**Key Phrase for Secure Store Settings**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Phrase for Secure Store Settings</td>
<td>This is a random word or phrase that is used to encrypt the secure store. The Java EE engine uses this phrase to generate the key that is used to encrypt the data. The uniqueness of the phrase you use contributes to the uniqueness of the resulting key.</td>
</tr>
</tbody>
</table>

⚠️ **Recommendation**

Use a long key phrase that cannot be guessed easily. Use both uppercase and lowercase letters in the phrase and include special characters.

**Internet Communication Manager (ICM) User Management**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of webadm</td>
<td>The administration user <code>webadm</code> is created to use the web administration interface for Internet Communication Manager (ICM) and Web Dispatcher. SAPInst sets the master password by default. If required, you can choose another password. The length of the password must be between 5 and 128 characters.</td>
</tr>
</tbody>
</table>

**Host Agent**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password of sapadm</td>
<td>The administration user <code>sapadm</code> is created to use central monitoring services. If this user does not already exist, SAPInst automatically creates it. SAPInst prompts you to enter either the password of the existing user or a new password for the user to be created.</td>
</tr>
</tbody>
</table>
Solution Manager Key

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Solution Manager key</td>
<td>To install your SAP system, you need to generate an SAP Solution Manager key [page 62], which the installation requires to continue. For more information, see SAP Note 805390.</td>
</tr>
</tbody>
</table>

Parameters Relevant for the Database

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database ID</td>
<td>Identifier for the database [page 33]</td>
</tr>
<tr>
<td>Database schema</td>
<td>SAP&lt;SAPSID&gt;DB</td>
</tr>
<tr>
<td>Database file systems</td>
<td><img src="image" alt="List of database file systems" /></td>
</tr>
<tr>
<td></td>
<td>- Drive for instance-independent programs</td>
</tr>
<tr>
<td></td>
<td>- Drive for instance-independent data</td>
</tr>
<tr>
<td></td>
<td>- Drive for instance-dependent software</td>
</tr>
<tr>
<td></td>
<td>- Drives for SAP data and log volumes</td>
</tr>
</tbody>
</table>

### 3.2 Hardware and Software Requirements

You check that your hosts meet the hardware and software requirements for your operating system and the SAP instances.

⚠️ **Caution**

If your hosts do not fully meet the requirements, you might experience problems when working with the SAP system.

**Prerequisites**

**Contact your OS vendor for the latest OS patches.**

**Make sure that the host name meets the requirements listed in SAP Note 611361.**

**Process Flow**

1. Check the *Product Availability Matrix* at [http://service.sap.com/pam](http://service.sap.com/pam) for supported operating system releases.

2. Check the hardware and software requirements using:

   **The Prerequisite Checker:**
   - Standalone (optional) before the installation process
     - For more information, see *Running the Prerequisite Checker Standalone* [page 40].
   - Integrated in the installation tool (mandatory) as part of the installation process
     - For more information, see *Running SAPinst* [page 68].
Note
For the most recent updates to the Prerequisite Checker, always check SAP Note 855498.

- The hardware and software requirements checklists for:
  - Standard system [page 41]
  - Distributed system [page 43]
    [Only valid for: HA (MSCS)]
  - High availability system with MSCS [page 46]
    [End of: HA (MSCS)]
  - Additional application server instance [page 50]
  - Application Sharing Server as an Optional Standalone Unit
    If you want to install the Application Sharing Server as a standalone unit, you must meet the same requirements as for a Java standard system [page 41].
  - Standalone host agent [page 50]

3. If you are installing a production system, the values provided by the Prerequisite Checker and the hardware and software requirements checklists are not sufficient. In addition, do the following:
     For more information about the SAP Quick Sizer and available sizing guides, see the Master Guide — SAP NetWeaver 7.0 at http://service.sap.com/installnw70 Planning.
   - You contact your hardware vendor, who can analyze the load and calculate suitable hardware sizing depending on:
     - The set of applications to be deployed
     - How intensively the applications are to be used
     - The number of users

3.2.1 Running the Prerequisite Checker in Standalone Mode (Optional)

Before installing your SAP system, you can run the Prerequisite Checker in standalone mode to check the hardware and software requirements for your operating system (OS) and the SAP instances.

Recommendation
We recommend that you use both the Prerequisite Checker and the requirements tables for reference.

Note
When installing your SAP system, SAPinst automatically starts the Prerequisite Checker and checks the hardware and software requirements in the background.
Prerequisites

- You have prepared the Installation Master DVD on the required installation host [page 63].

Procedure

1. You start SAPinst [page 68].
2. On the Welcome screen, choose ▶ <SAP System> ▶ Software Life-Cycle Options ▶ Additional Preparation Tasks ▶ Prerequisites Check ▶.
3. Follow the instructions in the SAPinst dialogs and enter the required parameters.

   Note

   For more information about each parameter, position the cursor on the parameter field and choose [F1] in SAPinst.

   When you have finished, the Parameter Summary screen appears summarizing all parameters you have entered. If you want to make a change, select the relevant parameters and choose Revise.
4. To start the Prerequisite Checker, choose Start.

Result

The Prerequisite Check Results screen displays the results found. If required, you can also check the results in file prerequisite_checker_results.html, which you can find in the installation directory.

3.2.2 Requirements for a Standard System

If you want to install a standard system, where all instances reside on one host, this host must meet the following hardware and software requirements:

   Note

   The listed values only apply for development systems or quality assurance systems.

Hardware Requirements for a Standard System

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space</td>
<td>- Database Software: Version 7.6: 500 MB</td>
<td>To check disk space: 1. Choose ▶ Start ▶ All Programs ▶ Administrative Tools ▶ Computer Management ▶ Disk Management. 4</td>
</tr>
<tr>
<td></td>
<td>- Version 7.7: 700 MB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- SAP system files (not including paging file): 5 GB (x64)</td>
<td>2. Right-click the drive and choose Properties.</td>
</tr>
<tr>
<td></td>
<td>- 8 GB (IA64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- SAP database files (not including paging file), see the following file:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 3.2 Hardware and Software Requirements

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><code>&lt;Export_DVD&gt;\DATA_UNITS\EXPORT_1\DB\ADA\DBSIZE.XML</code></td>
<td>The XML table in this file contains a field called <code>fDevSize</code>, which contains the size in MB of the element indicated in the previous field, <code>fDevName</code>. This shows you the size of the data (DBDATADEV) and the log (DBLOGDEV) volumes.</td>
</tr>
<tr>
<td></td>
<td>Note:</td>
<td>The values listed in <code>DBSIZE.XML</code> are only for guidance.</td>
</tr>
<tr>
<td></td>
<td>Distribute the space for the data across at least three physically separate disks.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Up to 2 GB for each usage type or software unit you want to install.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4.3 GB of temporary disk space for every required installation DVD that you have to copy to a local hard disk</td>
<td></td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>2 GB</td>
<td>To check RAM:</td>
</tr>
<tr>
<td></td>
<td>In the Windows Explorer, choose <code>Help</code> <code>About Windows</code>.</td>
<td></td>
</tr>
<tr>
<td>Paging file size</td>
<td>1 times RAM plus 14 GB</td>
<td>To check paging file size:</td>
</tr>
<tr>
<td></td>
<td>4. If required, in section <code>Virtual memory</code>, choose <code>Change</code>.</td>
<td>4. If required, in section <code>Virtual memory</code>, choose <code>Change</code>.</td>
</tr>
<tr>
<td>Suitable backup system</td>
<td></td>
<td>—</td>
</tr>
</tbody>
</table>
Software Requirements for a Standard System

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows operating system</td>
<td><strong>English international 64-bit version</strong> of one of the following Windows Server Editions:</td>
<td>To check your Windows version:</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2003 Standard Edition</td>
<td>2. Enter the command <strong>winver</strong>.</td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2003 Enterprise Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2003 Datacenter Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2008</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2008 Standard Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2008 Enterprise Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2008 Datacenter Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Windows Server 2008 for Itanium-Based Systems Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>When this guide was published, Windows Server 2008 had not yet been released for your SAP system.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For up-to-date information on the released operating system versions for your SAP product and database, see the <strong>Product Availability Matrix (PAM)</strong> at <a href="http://service.sap.com/pam">http://service.sap.com/pam</a>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>For any version of Windows Server, you need the latest supported service pack.</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>A suitable Windows Resource Kit is strongly recommended.</strong></td>
<td></td>
</tr>
</tbody>
</table>

### 3.2.3 Requirements for a Distributed System

This section provide information about the hardware and software requirements in a distributed system, where the SAP instances can reside on different hosts.

The tables show the requirements for the:

- Central services instance
- Database instance
- Primary application server instance
- Additional application server instance (optional)
### Note

- The listed values only apply for **development systems** or **quality assurance systems**.
- If you install several SAP instances on one host, you need to add up the requirements.

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
</table>
| Minimum disk space   | **Database Software:**  
                       | Version 7.6: 500 MB  
                       | Version 7.7: 700 MB  
                       | **Central services instance (SCS)** (not including paging file):  
                       | 5 GB (x64)  
                       | 8 GB (IA64)  
                       | **SAP database files** (not including paging file), see the following file:  
                       | `<Export_DVD>\DATA_UNITS\EXPORT_1\DB\ADA\DBSIZE.XML`  
                       | The XML table in this file contains a field called `fDevSize`, which contains the size in MB of the element indicated in the previous field, `fDevName`. This shows you the size of the data (`DBDATADEV`) and the log (`DBLOGDEV`) volumes.  
                       | **Note**  
                       | The values listed in `DBSIZE.XML` are only for guidance.  
                       | Distribute the space for the data across at least three physically separate disks.  
                       | **Primary application server instance** (not including paging file):  
                       | 5 GB (x64)  
                       | 8 GB (IA64)  
                       | In addition you require 4 GB (x64), or 8 GB (IA64) per additional platform.  
                       | Up to 2 GB per each usage type or software unit you want to install.  
                       | **Additional application server instance** (optional) (not including paging file):  
                       | 2.5 GB (x64)  
                       | 5 GB (IA64)  
                       | Temporary disk space for every required installation DVD that you have to copy to a local hard disk:  
                       | 4.3 GB  
                       | To check disk space:  
                       | 1. Choose **Start** > **All Programs** > **Administrative Tools** > **Computer Management** > **Disk Management**  
                       | 2. Right-click the drive and choose Properties |
### Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum RAM</td>
<td>1 GB</td>
<td>To check RAM: In the Windows Explorer, choose Help &gt; About Windows.</td>
</tr>
<tr>
<td>Paging file size</td>
<td></td>
<td>To check paging file size:</td>
</tr>
<tr>
<td>Central services instance (SCS):</td>
<td>1 times RAM plus 1 GB</td>
<td>1. Choose Start &gt; Control Panel &gt; System.</td>
</tr>
<tr>
<td>Database instance:</td>
<td>1.5 times RAM</td>
<td>2. Choose Advanced (Windows Server 2003) or Advanced system settings</td>
</tr>
<tr>
<td>Primary application server instance:</td>
<td>1 times RAM plus 14 GB</td>
<td>(Windows Server 2008).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. If required, in section Virtual memory, choose Change.</td>
</tr>
<tr>
<td>Suitable backup system</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Software Requirements for a Distributed System

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows operating system</td>
<td><strong>English international 64-bit version</strong> of one of the following Windows Server Editions:</td>
<td>To check your Windows version:</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2008</td>
<td>2. Enter the command <code>winver</code>.</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2008 Standard Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows Server 2008 Enterprise Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows Server 2008 Datacenter Edition</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows Server 2008 for Itanium-Based Systems Edition</td>
<td></td>
</tr>
</tbody>
</table>

*Caution*

When this guide was published, Windows Server 2008 had not yet been released for your SAP system. For up-to-date information on the released operating system versions for your SAP product and database, see the Product Availability Matrix (PAM) at...
3.2.4 Requirements for a High-Availability System

This section provide information about the hardware and software requirements in a high-availability system.

**Note**

1. **Windows Server 2003 only:**
   You must check that your cluster hardware is certified.
   AddOn Technology Center for SAP (Add On TCS) certifies hardware platforms for SAP on Microsoft Windows. The cluster must be included in the Microsoft list of certified clusters and its components. You can access the lists as follows:
   - [www.microsoft.com/wdcd/hcl/default.mspx](http://www.microsoft.com/wdcd/hcl/default.mspx)
   - [www.saponwin.com](http://www.saponwin.com)

2. **Windows Server 2008 only:**
   a) Check that your cluster hardware is certified for Windows Server 2008 and has the Windows Server 2008 logo.
   b) You must validate your failover cluster configuration by running the **Validate a Configuration Wizard**, which is included in the **Failover Cluster Management** snap-in. The **Failover Cluster Validation Report** must not show any warnings and errors.

3. The MSCS nodes of the cluster must be connected by a private and public network:
   - The public network enables communication from the MSCS nodes of the cluster to other resources in the local area network (LAN).
The private network enables internal communication between the MSCS nodes. In particular, it enables the Cluster Service running on all MSCS nodes to regularly exchange messages on the state of the MSCS nodes so that the failure of resources is quickly detected.

4. Each of the MSCS nodes in the cluster must have its own local disks and have access to shared disks that can be reached by the MSCS nodes via a shared bus. All software – except the Windows operating system, the SAP MaxDB system database, and the MSCS software – is stored on the shared disks. One of the shared disks must be used exclusively by the quorum (if a single quorum device cluster is used) that stores the cluster registry and records information about the state of the cluster. You require at least six shared disks. For more information about the distribution of components to local and shared disk, see Distribution of SAP System Components to Disks for MSCS [page 123].

Caution

- All disk controllers must be able to support hardware-based RAID.
- You cannot use a host with a domain controller as an MSCS cluster node.

The following tables show the hardware and software requirements for the:

- Central services instance (SCS)
- Database instance
- Enqueue Replication Server instance (ERS)
- Primary application server instance
- Additional application server instance

Note

- The listed values are sufficient for development systems or quality assurance systems but not for production systems.
- If you install several SAP instances on one host, you need to add up the requirements.

### Hardware Requirements for a High-Availability System

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space</td>
<td>- <strong>Database Software:</strong>&lt;br&gt;Version 7.6: 500 MB&lt;br&gt;Version 7.7: 700 MB&lt;br&gt;- <strong>Central services instance (SCS)</strong> <em>(not including paging file):</em>&lt;br&gt;5 GB <em>(x64)</em>&lt;br&gt;8 GB <em>(IA64)</em>&lt;br&gt;- SAP database files <em>(not including paging file)</em>, see the following file:&lt;br&gt;&lt;Export_DVD&gt;\DATA_UNITS\EXPORT_1\</td>
<td>To check disk space:&lt;br&gt;1. Choose <strong>Start</strong> ➤ <strong>All Programs</strong> ➤ <strong>Administrative Tools</strong> ➤ <strong>Computer Management</strong> ➤ <strong>Disk Management</strong>. 2. Right-click the drive and choose <strong>Properties</strong>.</td>
</tr>
</tbody>
</table>
### 3.2 Hardware and Software Requirements

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>DB\ADA\DBSIZE.XML</strong>&lt;br&gt;The XML table in this file contains a field called <code>fDevSize</code>, which contains the size in MB of the element indicated in the previous field, <code>fDevName</code>. This shows you the size of the data (DBDATADEV) and the log (DBLOGDEV) volumes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="https://example.com/note.png" alt="Note" /> &lt;br&gt;The values listed in DBSIZE.XML are only for guidance.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Distribute the space for the data across at least three physically separate disks.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Enqueue replication server instance (ERS)</strong> (not including paging file):&lt;br&gt;5 GB (x64)&lt;br&gt;8 GB (IA64)</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Primary application server instance</strong>&lt;br&gt;(not including paging file):&lt;br&gt;2.5 GB (x64)&lt;br&gt;5 GB (IA64)&lt;br&gt;  - In addition you require 4 GB (x64), or 8 GB (IA64) per additional platform.&lt;br&gt;  - Up to 2 GB for each usage type or software unit you want to install.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Additional application server instance</strong> (not including paging file):&lt;br&gt;2.5 GB (x64)&lt;br&gt;5 GB (IA64)&lt;br&gt;  - Temporary disk space for every required installation DVD that you have to copy to a local hard disk: 4.3 GB</td>
<td></td>
</tr>
<tr>
<td>Minimum RAM</td>
<td>1 GB</td>
<td>To check RAM:&lt;br&gt;In the Windows Explorer, choose <img src="https://example.com/help.png" alt="Help" /> <img src="https://example.com/about.png" alt="About Windows" />.</td>
</tr>
</tbody>
</table>
### Hardware Requirements

<table>
<thead>
<tr>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paging file size</td>
<td>To check paging file size:</td>
</tr>
<tr>
<td>• Central services instance (SCS):</td>
<td>1. Choose <code>Start</code> <code>Control Panel</code> <code>System</code> →.</td>
</tr>
<tr>
<td>1 times RAM plus 1 GB</td>
<td>2. Choose <em>Advanced</em> (Windows Server 2003) or <em>Advanced system settings</em> (Windows Server 2008).</td>
</tr>
<tr>
<td>• Database instance:</td>
<td>3. Select <code>Performance Settings</code> → <em>Advanced</em> →.</td>
</tr>
<tr>
<td>1.5 times RAM</td>
<td>4. If required, in section <em>Virtual memory</em>, choose <em>Change</em>.</td>
</tr>
<tr>
<td>• Enqueue replication server instance (ERS):</td>
<td></td>
</tr>
<tr>
<td>1 times RAM plus 1 GB</td>
<td></td>
</tr>
<tr>
<td>• Primary application server instance:</td>
<td></td>
</tr>
<tr>
<td>1 times RAM plus 14 GB</td>
<td></td>
</tr>
<tr>
<td>• Additional application server instance:</td>
<td></td>
</tr>
<tr>
<td>1 times RAM plus 14 GB</td>
<td></td>
</tr>
</tbody>
</table>

Suitable backup system

---

### Software Requirements for a High-Availability System

<table>
<thead>
<tr>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows operating system</td>
<td>To check your Windows version:</td>
</tr>
<tr>
<td>• English international 64-bit version of one</td>
<td>1. Choose <code>Start</code> <code>All Programs</code> <code>Accessories</code> <code>Command Prompt</code> →.</td>
</tr>
<tr>
<td>of the following Windows Server Editions:</td>
<td>2. Enter the command <code>winver</code>.</td>
</tr>
<tr>
<td>• Windows Server 2003</td>
<td></td>
</tr>
<tr>
<td>◆ Windows Server 2003 Enterprise Edition</td>
<td></td>
</tr>
<tr>
<td>◆ Windows Server 2003 Datacenter Edition</td>
<td></td>
</tr>
<tr>
<td>• Windows Server 2008</td>
<td></td>
</tr>
<tr>
<td>◆ Windows Server 2008 Enterprise Edition</td>
<td></td>
</tr>
<tr>
<td>◆ Windows Server 2008 Datacenter Edition</td>
<td></td>
</tr>
<tr>
<td>◆ Windows Server 2008 for Itanium-Based</td>
<td></td>
</tr>
<tr>
<td>Systems Edition</td>
<td></td>
</tr>
</tbody>
</table>

**Caution**

When this guide was published, Windows Server 2008 had not yet been released for your SAP system. For up-to-date information on the released operating system

---

**Note**

You must adjust the size of the paging file on all MSCS nodes.

---

**Windows Server 2003 only:**

You must set up the MSCS Cluster Service as described in the Microsoft documentation. During this setup you are asked for a Windows Domain Account to run the Cluster Service. We strongly recommend creating an account different from the `<sapsid>adm` user, for example `ClusterServiceuser=sapprdcladm`, where `Clustername=sapprdcl`.

**Windows Server 2008 only:**

You must add the operating system feature *Failover Clustering* on
### 3.2.5 Requirements for the Additional Application Server Instance

For more information about the requirements for the additional application server instance(s), see one of the following sections:

- Requirements for a Distributed System [page 43]
- Requirements for a High-Availability System [page 46]

### 3.2.6 Requirements for the Host Agent as a Separate Installation

If you want to install the host agent separately, the installation host has to meet the following requirements:

**Software Requirement** | Requirement | How to Check |
--- | --- | --- |
| versions for your SAP product and database, see the Product Availability Matrix (PAM) at [http://service.sap.com/pam](http://service.sap.com/pam) | all MSCS nodes. |
| For any version of Windows Server, you need the latest supported service pack. | |
| A suitable Windows Resource Kit is strongly recommended. | |
### Hardware Requirements for the Host Agent

<table>
<thead>
<tr>
<th>Hardware Requirement</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum disk space:</td>
<td>Host agent: 80 MB</td>
</tr>
<tr>
<td></td>
<td>Temporary disk space for every required installation DVD that you have to copy to a local hard disk: 4.3 GB</td>
</tr>
<tr>
<td>Minimum RAM:</td>
<td>40 MB</td>
</tr>
<tr>
<td>Paging file size:</td>
<td>500 MB</td>
</tr>
<tr>
<td>Suitable backup system</td>
<td>—</td>
</tr>
</tbody>
</table>

**How to Check**

- To check disk space:
  1. Choose **Start → All Programs → Administrative Tools → Computer Management → Disk Management**.
  2. Right-click the drive and choose Properties.

- To check RAM:
  1. In the Windows Explorer choose **Help → About Windows**.

- To check paging file size:
  1. Choose **Start → Control Panel → System**.
  3. Select **Performance Settings** → Advanced.
  4. If required, in section **Virtual memory**, choose **Change**.

### Software Requirements for the Host Agent

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows operating system:</td>
<td><strong>English international 64-bit version</strong> of one of the following Windows Server Editions:</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2003</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2003 Enterprise Edition</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2003 Datacenter Edition</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2008</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2008 Enterprise Edition</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2008 Datacenter Edition</td>
</tr>
<tr>
<td></td>
<td>Windows Server 2008 for Itanium-Based Systems Edition</td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong> When this guide was published, Windows Server 2008 had not yet</td>
</tr>
</tbody>
</table>

**How to Check**

- To check your Windows version:
  1. Choose **Start → All Programs → Accessories → Command Prompt**.
  2. Enter the command **winver**.
### Software Requirement

<table>
<thead>
<tr>
<th>Software Requirement</th>
<th>Requirement</th>
<th>How to Check</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>been released for your SAP system. For up-to-date information on the released operating system versions for your SAP product and database, see the Product Availability Matrix (PAM) at <a href="http://service.sap.com/pam">http://service.sap.com/pam</a>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- For any version of Windows Server, you need the latest supported service pack.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- A suitable Windows Resource Kit is strongly recommended.</td>
<td></td>
</tr>
</tbody>
</table>

### Database software:

- -

---

## 3.3 Preparing User Management for an External ABAP System

For a Java system, you can also deploy user management for an external ABAP system. In this case, you configure the User Management Engine (UME) of Application Server Java (AS Java) for the user management of a separate ABAP system.

If you want to connect more than one Java system to the same ABAP system, you need to work out a concept for the communication, administrator, and guest users for each system. You can take one of the following approaches:

<table>
<thead>
<tr>
<th>Approach</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each Java system uses different users</td>
<td>No interdependencies between the connected engines</td>
<td>Initially more administration to create the users in the ABAP system</td>
</tr>
</tbody>
</table>
| All Java systems use the same configuration | You create the users only once and enter the same information for every Java system that you install. | Interdependencies between the connected engines:
  - If you change the password of any of the users on the ABAP system, this change affects **all** connected engines.
  - If you change the administrator user’s password, you must also change the password in secure storage on **all** of the connected Java systems |
For security reasons, we recommend the first approach.

The procedures below assume that you are using the first approach.

**Prerequisites**

- The ABAP system is based on at least SAP Web AS ABAP release 6.20 SP25.
- In transaction PFCC, check that the roles `SAP_BC_JSF_COMMUNICATION` and `SAP_BC_JSF_COMMUNICATION_RO` exist and make sure that their profiles are generated.
- In transaction PFCC, check that the roles `SAP_J2EE_ADMIN`, `SAP_J2EE_GUEST` and `SAP_BC_FP_ICF` exist. Neither role contains any ABAP permissions, so you do not need to generate any profiles.
- For more information, see the *SAP Library* [page 12]:
  - Function-Oriented View ➤ Security ➤ Identity Management ➤ Identity Management of the Application Server Java
  - User Management Engine ➤

**Note**

For more information about role maintenance, see the *SAP Library* [page 12] at
- Function-Oriented View ➤ Security ➤ Identity Management ➤ Identity Management of the Application Server ABAP ➤ AS ABAP Authorization Concept ➤

**Administration of the ABAP system**

Perform the following administration steps in the ABAP system:

1. In transaction SU01, create a new communication user and assign it to the role `SAP_BC_JSF_COMMUNICATION_RO`.

**Recommendation**

We recommend that you assign this user the role `SAP_BC_JSF_COMMUNICATION_RO` for read-only (display) access to user data with Java tools. If you intend to maintain user data (that is, to change, create, or delete users) with Java tools, you need to assign the role `SAP_BC_JSF_COMMUNICATION` instead.

We recommend that you name the user `SAPJSF_<SAPSID_Java_System>`.

You can use any password.

In addition, to make sure that this user can only be used for communication connections between systems and not as a dialog user, assign it the type *Communications* under *Logon data*.

2. In transaction SU01, create a new dialog user and assign it to role `SAP_J2EE_ADMIN`. This is your administrator user in AS Java.
3. Preparation

3.3 Preparing User Management for an External ABAP System

Recommendation

We recommend that you name the user J2EE_ADM_<SAPSID_Java_System>. You can use any password.

Caution

Log on to the SAP system once with this user to change its initial password. Since the installer of AS Java verifies this password, the installation fails if this password is initial.

3. In transaction SU01, create a new dialog user and assign it to role SAP_J2EE_GUEST. This is your guest user in AS Java.

Recommendation

We recommend that you name the user J2EE_GST_<SAPSID_Java_System>. You can use any password.

Since this user is only used for anonymous access to the system, we recommend you to deactivate the password and, if required, lock it after installation to prevent anyone from using it for explicit named logons.

4. In transaction SU01, create the following dialog users:

Caution

You must have changed the initial passwords of these users before you start the installation of the Java system.

- Users for Adobe Document Services (ADS) (optional):
  - ADSUSER:
    - In transaction PFCG, assign the role ADSCallers to this user.
  - ADS_AGENT:
    - In transaction PFCG, assign the role SAP_BC_FP_ICF to this user.

- SLD Data supplier user (optional):
  - You only have to create this user if you want to install System Landscape Directory (SLD).
  - The SLD data supplier user name that you enter later on during the Java system installation must be identical to this user.

Recommendation

We recommend that you name this user SLDDSUSER.

- SLD ABAP API user (optional):
  - You only have to create this user if you want to install System Landscape Directory (SLD). The SLD ABAP API user name that you enter later on during the Java system installation must be identical to this user.
3.4 Checking the Windows File System

You need to check that you are using the Windows file system NTFS on hosts where you want to install the SAP system and database. NTFS supports full Windows security and long file names.

**Note**
You must use NTFS for an SAP system installation. Do not install the SAP directories on a FAT partition.

**Procedure**

1. Open the Windows Explorer.
2. Select the relevant disk
   The system displays the type of file system in use.
4. Check that the file system is NTFS.

3.5 Checking the Windows Domain Structure

**Note**
You do not need this step for a local installation.

In Windows, you can implement either of the following domain models for the SAP system:
3.6 Reducing the Size of the File Cache

**Note**

This step is not required if you use Windows Server 2008.

The Windows file cache competes directly with SAP programs for memory. Therefore, you need to adjust the file cache as described below.

**Procedure**

1. Choose Start > Control Panel > Network Connections > Local Area Connections.
2. In the Local Area Connection Status dialog box, choose Properties.
3. In the Local Area Connection Properties dialog box, double-click File and Printer Sharing for Microsoft Networks.
4. Select Maximize data throughput for network applications.

⚠️ Caution
If you cannot select File and Printer Sharing for Microsoft Networks, this option has not yet been installed. To install it, you need the Windows Server CDs.

5. To confirm your entries, choose OK.

### 3.7 Required User Authorization for the Installation

Although SAPInst automatically grants the rights required for the installation to the user account used for the installation, you have to check whether this account has the required authorization to perform the installation. The authorization required depends on whether you intend to perform a **domain** or **local** installation. If necessary, you have to ask the system administrator to grant the account the necessary authorization **before** you start the installation. If you attempt the installation with an account that does not have the required authorization, the installation aborts.

This section informs you about the authorization required for a domain and a local installation.

⚠️ Caution
Do **not** use the user `<sapsid>adm` for the installation of the SAP system.

#### Domain Installation

For a domain installation the account used for the installation needs to be a member of the local **Administrators** and the domain **Admins** group of the relevant domain. All machines in the system must belong to the same domain. In a domain installation, the user information is stored centrally on the domain controller and is accessible to all hosts in the system.

If the SAP system is to be distributed across **more than one** machine, SAP strongly recommends you to perform a domain installation to avoid authorization problems.

⚠️ Caution

- If you install a distributed system as a local installation, this can lead to authorization problems for the operating system users `<sapsid>adm` and `SAPService<SAPSID>`. It can also lead to problems with the transport directory, which is usually shared by several SAP systems. Therefore, we do not support a local installation for a distributed system. We recommend you to install a distributed system as a domain installation.
- If you still want to perform a local installation for a distributed system, make sure that:
  - You use the same password for the `<sapsid>adm` or the `SAPService<SAPSID>` user on all hosts.
The password for the <sapsid>adm and SAPService<sapsid> user can differ.
- You use the same master password on all hosts.
- All hosts belong to the same Windows work group.

[Only valid for: HA (MSCS)]

- In an MSCS configuration, you always have to perform a domain installation.

[End of: HA (MSCS)]

- For performance and security reasons, SAP does not support an SAP system installation on a domain controller.
- If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. However, the domain administrator has to prepare the system appropriately for you.
  For more information, see Performing a Domain Installation without being a Domain Administrator [page 58].

For a domain installation, you need to:

1. Check that the account used for the installation is a member of the domain Admins group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the domain Admins group.

Local Installation

For a local installation the account used for the installation needs to be a member of the local Administrators group of the machine involved. In a local installation, all Windows account information is stored locally on one host and is not visible to any other hosts in the system.

If the SAP system is to run on a single machine, you can perform a local installation.

For a local installation, you need to:

1. Check that the account used for the installation is a member of the local Administrators group.
2. If required, obtain these rights by asking the system administrator to enter the account as a member of the local Administrators group.

3.8 Performing a Domain Installation Without Being a Domain Administrator

You normally perform a domain installation of the SAP system with a user who is a member of the domain Admins group, as described in Required User Authorization for the Installation [page 57]. If for any reason, the account used for the installation is not a member of the domain Admins group, you can perform the installation with a domain user who is a member of the local Administrators group. In this case, the domain administrator has to prepare the system appropriately for you. The domain administrator can perform the following steps either using SAPInst or manually:
1. Create the new global group SAP_<SAPSID>_GlobalAdmin.
2. Create the two new SAP system users <sapid>adm and SAPService<SAPSID>.
3. Add the users <sapid>adm and SAPService<SAPSID> to the newly created group SAP_<SAPSID>_GlobalAdmin.

**Prerequisites**

- You must be domain administrator to perform the required steps.

**Windows Server 2008 only:**

You must have installed the feature Remote Server Administration Tools as follows:
2. In the Server Manager windows, select Features.

**Creating the Required Uses and Groups Using SAPinst**

On the host where the SAP system is to be installed, the domain administrator runs SAPinst and chooses Software Life-Cycle Options > Additional Preparation Options > Operating System and Users to have the group and users created automatically.

**Creating the Required Uses and Groups Manually**

Creating the New Global Group SAP_<SAPSID>_GlobalAdmin

1. Log on as domain administrator.
2. To start the Active Directory Users and Computers Console, choose:

   ![Note]

   **Windows Server 2003 only:** If you cannot find Active Directory Users and Computers, start it as follows:
   a) Choose Start > Run and enter mmc.
   b) Choose Console > Add/Remove Snap-in… > Add.
   c) Select Active Directory Users and Computers.
   d) Choose Add.
   e) Choose Close > OK.

4. Enter the following:
   - **Group name:** SAP_<SAPSID>_GlobalAdmin
Note
Enter the SAP_<SAPSID>_GlobalAdmin group exactly as specified in the correct uppercase and lowercase.

5. Select the following:
   a) Group scope: Global
   b) Group type: Security

6. Choose OK.

Creating the New SAP System Users <sapsid>adm and SAPService<SAPSID>

1. In Active Directory Users and Computers Console, right-click Users in Tree and choose:
   - New User
2. Enter the following:
   - Username: <sapsid>adm
   - Password: <password>
   - Confirm password: <password>
   - First name: None
   - Last name: None
   - Full name: None
   - User logon name: None

3. Choose Next and enter the following:
   - Password: <password>
   - Confirm password: <password>
4. Select Password never expires

   Note
   Make sure that no other options are selected.

5. Choose Next and Finish.

Adding the <sapsid>adm User to the SAP_<SAPSID>_GlobalAdmin Group

1. In the Users folder, double-click the newly created user account <sapsid>adm in the list on the right.
2. Choose Member Add.
3. Select the new SAP_<SAPSID>_GlobalAdmin group and choose Add to add it to the list.
3.9 Preparing the SAP System Transport Host

Note
By default, the user is also a member of the Domain Users group.

4. Choose OK twice.

Adding the SAPService<SAPSID> User to the SAP_<SAPSID>._GlobalAdmin Group

1. In the Users folder, double-click the newly created user account SAPService<SAPSID> in the list on the right.
2. Choose [Member] Add #.
3. Select the new SAP_<SAPSID>._GlobalAdmin group.
4. Choose Add to add it to the list, and then OK.
5. Choose OK to close SAPService<SAPSID> Properties.

3.9 Preparing the SAP System Transport Host

The transport host has a directory structure that is used by the SAP transport system to store transport data and metadata.

When you install an SAP system, SAPinst by default creates the transport directory on the primary application server instance host in \usr\sap\trans.

Only valid for: HA (MCS)

Note
In an MCS configuration, SAPinst by default creates the transport directory on the (ABAP) central services instance host in \usr\sap\trans.

End of: HA (MCS)

If you do not intend to use the directory structure of the system you are going to install, but want to use another new transport directory or an already existing transport directory, you need to prepare that transport host:

■ If the directory structure already exists, you must set up its security to allow the new system to write to it.
■ If it does not yet exist, you must create the core directory structure and a share to export it for other computers as well as set the security on it.

Procedure
1. If the transport directory does not yet exist, do the following:
   a) Create the directory \usr\sap\trans on the host to be used as the transport host.
b) Share the \usr\sap directory on the transport host as SAPMNT and put the security settings for
Everyone to Full Control for this share.
This enables SAPinst to address the transport directory in the standard way as
\SAPTRANSHOST\SAPMNT\trans.

2. Grant Everyone the permission Full Control for the transport directory.

警告

Remove the Full Control to Everyone permission after you have finished the installation with SAPinst
and only grant Full Control on this directory to the SAP_<SAPSID>_GlobalAdmin groups of all the
systems that are part of your transport infrastructure. SAPinst assigns the appropriate rights with the
help of an additional SAP_LocalAdmin group. For more information, see Automatic Creation of
Accounts and Groups [page 113].

注意

If, during the installation with SAPinst, you select the checkbox SAP System will be under NWDI control
on the SAPinst screen SAP System NWDI Landscape, SAPinst copies all SCAs belonging to the usage
types or software units that you installed to the global transport directory. For more information,
see SAP Library [page 12] at:

Administrator’s Guide ➝ Technical Operations for SAP NetWeaver ➝ General Administrations Task ➝ Software
Life-Cycle Management ➝ Software Logistics ➝ SAP NetWeaver Development Infrastructure ➝ Maintenance of an
NWDI-Driven System Landscape ➝

### 3.10 Generating the SAP Solution Manager Key

You need to generate the Solution Manager key because the installation tool prompts for it during
the installation. Without this key, the installation process cannot continue.

For more information, see SAP Note 805390.

**Procedure**

1. If SAP Solution Manager is not yet available in your system landscape, proceed as follows:
   a) Order SAP Solution Manager as described in SAP Note 628901.
   b) Install SAP Solution Manager as described in the documentation Installation Guide – SAP Solution
      Manager <release> on <OS>: <Database> which is available at:

      [http://service.sap.com/solutionmanager ➝ SAP Solution Manager ➝ Installation Guides ➝ Release
      4.0 ➝](http://service.sap.com/solutionmanager)

2. Generate the SAP Solution Manager key as described in SAP Note 811923.
3.11 Preparing the Installation DVDs

This section describes how to prepare the installation DVDs, which are available as follows:

- You normally obtain the installation DVDs as part of the installation package.
- You can also download the installation DVDs from SAP Service Marketplace, as described at the end of this section.

1. Identify the required DVDs for your installation [page 15] as listed below.
   Keep them separate from the remaining DVDs as this helps you to avoid mixing up DVDs during the installation.

<table>
<thead>
<tr>
<th>SAP Instance Installation</th>
<th>Required DVDs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central services instance (SCS)</td>
<td>Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>NetWeaver Java DVD</td>
</tr>
<tr>
<td></td>
<td>Kernel DVD</td>
</tr>
<tr>
<td>Database instance</td>
<td>Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>Kernel DVD</td>
</tr>
<tr>
<td></td>
<td>RDBMS DVD</td>
</tr>
<tr>
<td></td>
<td>Export DVD</td>
</tr>
<tr>
<td><strong>HA only:</strong> Enqueue Replication Server</td>
<td>Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>Kernel DVD</td>
</tr>
<tr>
<td>Primary application server instance</td>
<td>Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>NetWeaver Java DVD</td>
</tr>
<tr>
<td></td>
<td>Kernel DVD</td>
</tr>
<tr>
<td></td>
<td>RDBMS Client DVD</td>
</tr>
<tr>
<td>Additional application server instance</td>
<td>Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>NetWeaver Java DVD</td>
</tr>
<tr>
<td></td>
<td>Kernel DVD</td>
</tr>
<tr>
<td></td>
<td>RDBMS Client DVD</td>
</tr>
<tr>
<td>Host Agent (Standalone)</td>
<td>Installation Master DVD</td>
</tr>
<tr>
<td></td>
<td>Kernel DVD</td>
</tr>
</tbody>
</table>

Note:
- The media names listed in the following table are **abbreviated**.
- You can find the Software Component Archives (SCAs) for the installation of SAP NetWeaver usage types on the NetWeaver Java DVD.
2. Make the required installation media available on each installation host.

Note
Depending on your installation type, one or more instances can reside on the same host. You need to keep this in mind when you make the required installation media available on each installation host.
For a standard system, you need to make all required installation media available on the single installation host.

Use one of the following methods to make DVDs available:
- **Before** the installation, copy DVDs manually to local hard disks.
- **During** the installation, use the SAPInst Media Browser dialog and copy the entire DVDs to the path you entered in the *Copy To* column.

Caution
- If you copy the DVDs to disk, make sure that the paths to the destination location of the copied DVDs do not contain any blanks.
- If you perform a domain installation and do not want to copy the DVDs but use network drives for mapping the installation DVDs, make sure that the <sapid>adm user has access to the UNC paths of the network drives.

**Downloading Installation DVDs from SAP Service Marketplace (Optional)**
You normally obtain the installation DVDs as part of the installation package from SAP. However, you can also download installation DVDs from SAP Service Marketplace at:

http://service.sap.com/swdc ▶ Download ▶ Installations and Upgrades ▶ Entry by Application Group ▶ <SAP solution> ▶ <SAP product> ▶ <SAP release> ▶ Installation and Upgrade ▶ <operating system> ▶ <database> ▶

Note
If you download installation DVDs, note that the DVDs might be split into several files. In this case, you have to reassemble the required files after the download.

Caution
To extract the downloaded SAR files make sure that you use the latest SAPCAR version, which you can find on SAP Service Marketplace at http://service.sap.com/swdc. You need at least SAPCAR 700 or SAPCAR 640 with patch level 4 or higher because older versions of SAPCAR can no longer unpack current SAR files. For more information, see SAP Note 212876.

1. Create a download directory on the host where you want to run SAPinst.
2. Identify all download objects that belong to one installation DVD according to one or both of the following:

3. Preparation
3.11 Preparing the Installation DVDs
### Material number

All download objects that are part of an installation DVD have the same material number and an individual sequence number:

\(<\text{material\_number}>._<\text{sequence\_number}>\)

<table>
<thead>
<tr>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>51031387_1</td>
</tr>
<tr>
<td>51031387_2</td>
</tr>
<tr>
<td>...</td>
</tr>
</tbody>
</table>

### Title

All objects that are part of an installation DVD have the same title, such as

\(<\text{solution}>_<\text{DVD\_name}>_<\text{OS}> \) or \(<\text{database}>_<\text{RDBMS}>_<\text{OS}>\) for RDBMS DVDs.

3. Download the objects to the download directory.

4. Extract the individual download objects using SAPCAR, starting with the lowest sequence number – for example 51031387_1, then 51031387_2, and so on.

During the download SAPCAR sets up the structure of the installation DVD.

---

**Note**

SAPCAR asks if you want to replace existing files, for example `LABELIDX.ASC`. Always accept with **Yes**.
This page is intentionally left blank.
4 Installation

This section includes the installation steps that you have to perform for the:

- Standard system
- Distributed system
  
Only valid for: HA (MSCS)

- High-availability system
  
End of: HA (MSCS)

- Additional application server instance
- Standalone host agent

**Standard System**

1. You install the SAP system with SAPinst [page 68].

   ![Note]
   
   In a standard system all mandatory instances are installed on one host in one installation run.

2. You continue with Post-Installation [page 81].

**Distributed System**

1. On the host where the primary application server instance is to run, you run SAPinst [page 68] to install the central services instance.
2. On the database instance host, you run SAPinst [page 68] to install the database instance.
3. On the primary application server instance host, you run SAPinst [page 68] to install the primary application server instance.
4. If required, on the additional application server instance host(s), you install the additional application server instance(s) (see below).
5. You continue with Post-Installation [page 81].

Only valid for: HA (MSCS)

**High-Availability System**

If you want to perform a Microsoft Cluster Service (MSCS) installation, see Installation [page 137] in High Availability with Microsoft Cluster Service.

1. You perform the MSCS-specific installation steps [page 137].
2. You continue with Post-Installation [page 81].

**End of: HA (MSCS)**

**Additional Application Server Instance(s)**
You perform the following steps on each host where you install the additional application server instance(s).

1. You run SAPinst [page 68] to install the additional application server instance(s).

   *Caution*
   In a high-availability system, you must install at least one additional application server instance.

   *End of: HA (MSCS)*

2. You continue with Post-Installation [page 81].

**Installation Steps for Additional Components and Tools for SAP NetWeaver CE (Optional)**

- You install additional components [page 76] for SAP NetWeaver Composition Environment, such as
  - Composition Tools
  - Adobe Document Services
  - Composite Voice
  - IDE Update Site

**Standalone Host Agent**

1. You run SAPinst [page 68] to install the Host Agent.
2. You continue with Post-Installation [page 81].

### 4.1 Running SAPinst

This procedure tells you how to install an SAP system with SAPinst. SAPinst includes a SAPinst GUI and a GUI server, which both use Java.

**Note the following information about SAPinst:**

- SAPinst normally creates the installation directory sapinst_instdir, where it keeps its log files, and which is located directly in the Program Files directory. If SAPinst is not able to create sapinst_instdir there, it tries to create sapinst_instdir in the directory defined by the environment variable TEMP.
4.1 Running SAPinst

**Recommendation**

We recommend that you keep all installation directories until the system is completely and correctly installed.

- SAPinst creates a subdirectory for each installation option called `<sapinst_instdir>\<installation_option_directory>`, which is located in `%ProgramFiles%\`
- The SAPinst Self-Extractor extracts the executables to a temporary directory (TEMP, TMP, TMPDIR, or SystemRoot). These executables are deleted after SAPinst has stopped running. Directories called sapinst.exe.xxxxxx.xxxx sometimes remain in the temporary directory. You can safely delete them.
  The temporary directory also contains the SAPinst Self-Extractor log file dev_selfex.out, which might be useful if an error occurs.

**Caution**

If SAPinst cannot find a temporary directory, the installation terminates with the error FCO-00058.

- During the installation, the default ports 21200, 21212, and 4239 are used for communication between SAPinst, GUI server, SAPinst GUI, and HTTP server. SAPinst uses port 21200 to communicate with the GUI server. The GUI server uses port 21212 to communicate with SAPinst GUI. 4239 is the port of the HTTP server, which is part of the GUI server. You get an error message if one of these ports is already in use by another service.
  In this case, open a command prompt and change to the required directory as follows:
```bash
cd <DVD drive>:\DATA_UNITS\IM_WINDOWS_<platform>.
Enter the following command in a single line:
sapinst.exe SAPINST_DIALOG_PORT=<free_port_number_sapinst_to_gui_server>
GUISERVER_DIALOG_PORT=<free_port_number_gui_server_to_sapinst_gui>
GUISERVER_HTTP_PORT=<free_port_number_http_server>
```
- To get a list of all available SAPinst properties, go to the directory (%TEMP%\sapinst.exe.xxxxxx.xxxx), after you have started SAPinst, and enter the following command:
```bash
sapinst.exe -p
```
- If you want to terminate SAPinst and the SAPinst Self-Extractor, choose one of the following options:
  - Right-click the icon for the SAPinst output window located in the Windows tray and choose Exit.
  - Click the icon for the SAPinst output window located in the Windows tray and choose File > Exit.

**Using SAPinst GUI**

The following table shows the most important functions that are available in SAPinst GUI:
4.1 Running SAPinst

SAPinst GUI Functions

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function key</td>
<td>F1</td>
<td>Displays detailed information about each input parameter</td>
</tr>
<tr>
<td>Menu option</td>
<td><img src="File" alt="File" /> <img src="Exit" alt="Exit" /></td>
<td>Stops the SAPinst GUI, but SAPinst and the GUI server continue running</td>
</tr>
</tbody>
</table>
| Menu option       | ![SAPinst](SAPinst) ![Log Browser](Log Browser) | Displays the Log Viewer dialog  
This dialog enables you to access the following log files directly:  
- Installation log (sapinst_dev.log)  
- Log files from the SAPinst GUI server |
| Menu option       | ![SAPinst](SAPinst) ![Cancel](Cancel) | Cancels the installation with the following options:  
- Stop  
  Stops the installation (SAPinst GUI, SAPinst and the GUI server) without further changing the installation files.  
  You can restart and continue the installation later from this point.  
- Continue  
  Continues the installation |
| Message button    | Retry                     | Performs the installation step again (if an error has occurred)                                                                            |
| Message button    | Stop                      | Stops the installation without further changing the installation files  
You can continue the installation later from this point.                                                                                     |
| Message button    | Continue                  | Continues with the option you have chosen before                                                                                           |

Prerequisites

- You use an account with the required user authorization to install the SAP system with the SAPinst tool [page 57].
- You need at least 300 MB of free space in the installation directory for each installation option. In addition, you need 60-200 MB free space for the SAPinst executables.
- Make sure that you have defined the most important SAP system parameters as described in Basic SAP System Parameters [page 32] before you start the installation.
- Check that your installation host(s) meets the requirements for the installation option(s) that you want to install. For more information, see Running the Prerequisite Checker [page 40].
- If you are installing a second or subsequent SAP system in an existing database, make sure that the database is up and running before starting the installation.
  For more information, see Installation of Multiple Components in One Database [page 28].
**Procedure**

1. Insert the *SAP Installation Master DVD* into your DVD drive or mount it locally.

2. Start SAPInst from the SAP Installation Master DVD by double-clicking `sapinst.exe` from the following path:
   `<DVD drive>:\DATA_UNITS\IM_WINDOWS<platform>.<DB>`

   SAPInst GUI starts automatically by displaying the *Welcome* screen.

   However, if there is only one component to install, SAPInst directly displays the first input dialog without presenting the *Welcome* screen.

   ![Note]

   If you want to use a virtual host name, start SAPInst as follows:

   `sapinst.exe SAPINST_USE_HOSTNAME=<virtual host name>`

3. In the *Welcome* screen, choose the required SAPInst installation option from the tree structure.

   For more information, see *SAPInst Installation Options* [page 72].

   ![Note]

   If you want to use the following installation options listed under *Software Life-Cycle Options*, you must start them **before** you start the installation of the SAP system:

   - **Operating System Users and Groups**
     Choose this option, if the operating system users do not yet exist and you do not want to create them manually.

   ![Note]

   Make sure that you have the *required user authorization* [page 57] for these accounts before you start the installation.

4. If SAPInst prompts you to log off from your system, log off and log on again.

   SAPInst restarts automatically.

5. Follow the instructions in the SAPInst dialogs and enter the required parameters.

   ![Note]

   For more information about the input parameters, position the cursor on the required parameter and press **F1**.

6. To start the installation, choose **Start**.

   SAPInst starts the installation and displays the progress of the installation. When the installation has successfully completed, SAPInst shows the dialog *Execution of <Option_Name> has been completed successfully.*
7. If you want to install an additional application server instance for a standard (central) or distributed system, choose the installation option  
   <SAP System>  
   Software Life-Cycle Options  
   Additional Application Server Instances  
   Additional application server instance.  

8. We recommend deleting all files in the directory %userprofile%\sdtgui.  

More Information  

- Interrupted Installation with SAPinst [external document]  
- Entries in the Services File Created by SAPinst [external document]  
- How to Avoid Automatic Logoff by SAPinst [external document]  
- Troubleshooting with SAPinst [external document]  

4.2 SAPinst Installation Options  

This section provides information about the following in SAPinst:  

- Installation Options  
- Software Life-Cycle Options  

Note  

- Choose the required installation options from the tree structure exactly in the order they appear for each system variant.  
- If required, install an additional application server instance for a standard system (all instances on one host) or distributed system by choosing  
   <SAP System>  
   Software Life-Cycle Options  
   Additional Application Server Instance  
   Additional Application Server Instance.  
- If required, install additional CE components by choosing  
   <SAP System>  
   Software Life-Cycle Options  
   Additional CE Components  
   Additional CE components.  
- If required, install SAP Memory Analyzer by choosing  
   <SAP System>  
   Software Life-Cycle Options  
   SAP Memory Analyzer  
   SAP Memory Analyzer.  

Installation Options  

You choose SAP Systems with <your database> to install a SAP system with usage types or software units.  
You can install the following system variants:  

- Standard System
Installation Options for a Standard System

<table>
<thead>
<tr>
<th>Installation Option</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard System</strong></td>
<td>Installs a complete SAP system including the following instances on one host:</td>
</tr>
<tr>
<td></td>
<td>● Central services instance (SCS)</td>
</tr>
<tr>
<td></td>
<td>● Database instance</td>
</tr>
<tr>
<td></td>
<td>● Primary application server instance</td>
</tr>
<tr>
<td></td>
<td>You can install a standard system in the following modes:</td>
</tr>
<tr>
<td></td>
<td>● Typical Mode</td>
</tr>
<tr>
<td></td>
<td>If you choose Typical, the installation automatically uses default settings. You only have to respond to a small selection of prompts. However, you can change any of the default settings on the parameter summary screen.</td>
</tr>
<tr>
<td></td>
<td>● Custom Mode</td>
</tr>
<tr>
<td></td>
<td>If you choose Custom, the installation prompts you for all parameters. At the end, you can change any parameter on the parameter summary screen.</td>
</tr>
</tbody>
</table>

Note
You require at least usage type AS Java or AS ABAP. You can choose the usage types or software units on the next screen.

Distributed System

Installation Options for a Distributed System

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Services Instance (SCS)</td>
<td>Installs a central services instance (SCS) and prepares the SAP global host Mandatory step in installing a distributed SAP system with usage types or software units based on AS Java</td>
</tr>
<tr>
<td>Database Instance</td>
<td>Installs a database instance Mandatory step in installing a distributed SAP system You must have finished the Central Services Instance (SCS) installation before you can choose this installation option.</td>
</tr>
<tr>
<td>Primary Application Server Instance</td>
<td>Installs a primary application server instance and enables additional software units Mandatory step in installing a distributed SAP system on several hosts You must have finished the database instance installation.</td>
</tr>
</tbody>
</table>

Only valid for: HA (MScS), HA (UNIX), HA (z/OS)

High-Availability System
## Installation Options for a High Availability System

<table>
<thead>
<tr>
<th>Installation Options</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Central Services Instance (SCS)</td>
<td>Installs a central services instance (SCS)</td>
</tr>
<tr>
<td>First MSCS Node</td>
<td>Performs the following steps on the first Microsoft Cluster Service (MSCS) node:</td>
</tr>
<tr>
<td></td>
<td>- Creates the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>- Adds the ASCS and SCS instances to the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>- Adds the ASCS instance to the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>- Adds the ASCS instance to the SAP cluster group</td>
</tr>
<tr>
<td>Database Instance</td>
<td>Installs a database instance</td>
</tr>
<tr>
<td>Host Agent</td>
<td>Installs the host agent</td>
</tr>
<tr>
<td></td>
<td>Only valid for: HA (MSCS)</td>
</tr>
<tr>
<td></td>
<td>You must perform this step on the additional MSCS node.</td>
</tr>
<tr>
<td></td>
<td>End of: HA (MSCS)</td>
</tr>
<tr>
<td>Additional MSCS Node</td>
<td>Configures an additional Microsoft Cluster Service (MSCS) node to run the SAP cluster group</td>
</tr>
<tr>
<td></td>
<td>You must have completed the configuration of the first MSCS node and the database instance installation.</td>
</tr>
<tr>
<td>Enqueue Replication Server Instance</td>
<td>Installs an enqueue replication server, which contains a replica of the lock table (replication server)</td>
</tr>
<tr>
<td>Primary Application Server Instance</td>
<td>Installs a primary application server instance and enables additional usage types or software units</td>
</tr>
<tr>
<td>Additional Application Server Instance</td>
<td>Installs an additional application server instance</td>
</tr>
<tr>
<td></td>
<td>Note</td>
</tr>
<tr>
<td></td>
<td>You require at least one additional application server instance in a high-availability system configured with MSCS.</td>
</tr>
</tbody>
</table>

End of: HA (MSCS); HA (UNIX); HA (z/OS)

## Software Life-Cycle Options
You use the options located in this folder to perform the following tasks or to install the following components:
### Installation Option: Additional Preparations
- **Host Agent**
  - Choose `Additional Preparations` `Host Agent` to install the host agent with the profiles `SAPSystem=99` and `SAPSystemName=SAP`. The host agent contains all of the required elements for centrally monitoring any host.
  - Normally you do not need to install a standalone host agent, because it is automatically installed during the installation of all SAP NetWeaver components, except TREX.
  - You only need to install a standalone host agent when:
    - You want to centrally monitor a host that does not have an SAP component.
    - You want to perform an upgrade to SAP NetWeaver.
  - For more information, see `Standalone Host Agent` [page 19].
- **Operating system users and groups**
  - Creates all operating system users for your SAP system if they do not yet exist.

**Caution**
- Perform this SAPinst option **before** you start the installation of your SAP system.
- Make sure that you have the required user authorization [page 57] for these accounts before you start the installation.

### Installation Option: Additional Application Server Instances
Choose `Additional Application Server Instances` `Additional Application Server Instance` to install one or more additional application server instance(s) in an already installed SAP system, if required.

### Installation Option: Additional CE Components
Choose this option to install additional CE components, such as:
- Composition Tools
- Adobe Document Services (if available for your platform)
- Composite Voice
- IDE Update Site

### Installation Option: SAP Memory Analyzer
Choose this option to install SAP Memory Analyzer. SAP Memory Analyzer helps you to analyze Java heap dumps, easily find big chunks of memory or complex memory aggregation patterns in your data structures and identify who is keeping this memory alive.
4.3 Installing Additional Components (Optional)

You can install the following additional components:

- Composition Tools
- Adobe Document Services (if available for your platform)
- Composite Voice
- IDE Update Site

Prerequisites

You need to fulfill the same hardware and software requirements as for your already installed production system plus an additional 2 GB RAM.

The Composition Tools and Composite Voice component make use of the Visual Composer. Visual Composer is a Web browser based tool to model user interfaces. To run Visual Composer, the following programs must be installed on the client computer from which you access Visual Composer:

- Microsoft Internet Explorer 6.0 SP1 or higher
- Adobe SVG Viewer 3.0
- Microsoft XML Parser 4.0 or higher

Note

- Before installing additional components, you need to stop all application servers manually.
- Before installing additional components and in the case that you made changes to the default template settings, see SAP Note 953763.

Prerequisites for SAP MaxDB

- Make sure that the Application Server Java and its corresponding database is running.
  
  You can stop and start the system using the shortcuts under Start > All Programs > SAP NetWeaver Composition Environment 7.1 > Application Server Jxx<SAPSID>.

- During the installation of additional components, entries are written into the log area of the database. To avoid that the log is running full during the installation, make sure that your backup strategy is already active and an initial data backup was successful.
When you want to establish your backup strategy after installing additional components, you can turn on the special log mode AutoOverwrite using the Database Manager GUI. This interrupts the existing backup history. You have to run a complete backup to start the history again.

**Procedure**

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPinst [page 68].
3. In the Welcome screen, choose SAP NetWeaver CE Productive System > Software Life-Cycle Options > Additional CE Components > Install Additional Components.
4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.

   **Note**
   If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode.
   After the installation, you can access the offline documentation by choosing Start > All Programs > SAP NetWeaver Composition Environment > <SID>.

5. Follow the screens and enter the required parameters.

   **Note**
   For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press [F1].

   After you have entered all requested input parameters, SAPinst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPinst set by default. If required, you can revise the parameters before starting the installation.
6. To start the installation, choose Start. SAPinst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPinst shows the dialog Execution of 'Option_Name' has been completed successfully.
4.4 Installing SAP Memory Analyzer (Optional)

SAP Memory Analyzer helps you to analyze Java heap dumps, easily find big chunks of memory or complex memory aggregation patterns in your data structures and identify who is keeping this memory alive. New and innovative analysis techniques support the user with a fast and powerful feature set.

The tool (Eclipse RCP application) was developed to analyze real productive heap dumps, which tend to get enormous in size with hundreds of millions of objects. Performance, low resource consumption and especially the newly developed innovative analysis techniques make it a helpful tool, even to small application heap dumps.

You can install SAP Memory Analyzer as an additional tool.

Procedure

Note
When installing from a network share make sure that everyone has read access to this share. The installation routine creates users such as <sid>adm (for example, ce1adm). During the installation SAPinst performs a user switch to this user. If the newly created user does not have permissions to the network share where the installation is running from, the installation will fail.

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Run SAPinst [page 68].
3. In the Welcome screen, choose SAP NetWeaver CE Productive System > Software Life-Cycle Options > SAP Memory Analyzer > Install SAP Memory Analyzer.
4. Choose whether you want to run the installation in Typical mode or in Custom mode.
   - If you select Typical, the installation wizard provides automatic default settings and you only have to respond to a small selection of prompts. The rest is set by default. If you select Custom, you have to respond to all prompts.

Note
If you want to install the offline documentation for SAP NetWeaver CE, you need to choose Custom mode.
   - After the installation, you can access the offline documentation by choosing Start > All Programs > SAP NetWeaver Composition Environment > <SAPSID>.
5. Follow the screens and enter the required parameters.

Note

For more information about the input parameters and information about restrictions for passwords, position the cursor on the required parameter and press [F1].

After you have entered all requested input parameters, SAPinst displays the Parameter Summary screen. This screen shows both the parameters that you entered and those that SAPinst set by default. If required, you can revise the parameters before starting the installation.

6. To start the installation, choose Start. SAPinst starts the installation and displays the progress of the installation. When the installation has successfully been completed, SAPinst shows the dialog Execution of '<Option_Name>' has been completed successfully.
This page is intentionally left blank.
5 Post-Installation

This section includes the post-installation steps that you have to perform for the:

- Standard, distributed or high-availability system
- Additional application server instance
- Standalone host agent

**Standard, Distributed, or High-Availability System**

**Note**
In a standard system, all mandatory instances are installed on one host. Therefore, if you are installing a standard system, you can ignore references to other hosts.

1. If required, you perform a full system backup [page 102] immediately after the installation has finished.
2. You configure the Windows Server 2008 Firewall [page 82].
3. You check whether you can log on to the SAP system [page 83].

**Note**
In a distributed or high-availability system you check whether your can log on to every instance of the SAP system that you installed.

4. You ensure user security [page 84].
5. You install the SAP license [page 87].
6. **Windows Server 2008 only**: If required, you set up symbolic links for application servers [page 87].
7. You configure the remote connection to SAP support [page 89].
8. If required, you install MaxDB administration tools [page 90].
9. If required, you install Secure Sockets Layer (SSL) for MaxDB [page 92].
10. You back up the MaxDB database [page 96].
11. You update the database software to the current release [page 97].
12. On the primary application server instance host, you apply the latest kernel and Support Packages [page 89].
13. You check the Java manuals [page 97] for information that is relevant for running your Java system.
15. You perform a full system backup [page 102].
16. If you want or need to implement the E2E Root Cause Analysis scenario, you have to perform post-installation steps for the Diagnostics Agent [page 102] on your central instance and/or dialog instance(s).
### Additional Application Server Instance

1. You check whether you can log on to the additional application server instance [page 83].
2. You perform a full system backup [page 102].
3. If you want or need to implement the E2E Root Cause Analysis scenario, you have to perform post-installation steps for the Diagnostics Agent [page 102] on your central instance and/or dialog instance(s).

### Standalone Host Agent

You perform the post-installation steps for the Host Agent [page 97].

### 5.1 Configuring the Windows Server 2008 Firewall

As of Windows Server 2008, the Windows Firewall is turned on by default. It is configured to allow only a small set of Windows-specific inbound IP connections. Outbound connections by default are not limited to rules and are therefore not restricted by the firewall.

**Note**

- The default firewall settings are valid for the out-of-the-box installation of Windows Server 2008 and apply to local policies. For domain policies that override local policies, other rules might apply.
- To disable the Windows firewall temporarily, proceed as follows:
  2. Right-click Windows Firewall with Advanced Security and choose Properties.
  3. To turn off the firewall, choose the relevant profile (in most cases Domain Profile) and set the Firewall state to Off.
  4. To turn on the firewall again, set the Firewall state to On.

For the SAP system to operate, you might have to configure the Windows firewall and define a set of Inbound Rules for the TCP/IP port numbers that are used by your system.

For more information about the port numbers used, see the documentation TCP/IP Ports Used by SAP Applications at:


Ports listed with the default value *Not active* in this document are not configured.

**Procedure**

This procedure describes how to set Inbound Rules for the ports of an installed ABAP server that was installed with instance number 00.

5.2 Logging On to the Application Server

The New Inbound Rule Wizard starts.

3. For Rule Type, select Port and choose Next.
4. For Protocol and Ports, select port type TCP or UDP depending on the port type used.
   Select Specific local ports, and enter the port numbers for which you want to apply the new rule.
   Choose Next.
5. For Action, select Allow the connection, and choose Next.
6. For Profile, keep Domain, Private and Public selected, and choose Next.
   For more information, see the link Learn more about profiles on this screen.
7. Enter the Name, for example SAP ABAP Server 00, and Description for the new rule.
8. Choose Next.
9. Choose Finish to save the rule.
   The new inbound rule appears in the Inbound Rules list. To modify the settings, right-click on
   the rule and choose Properties.

Note
If you want to use, for example, a different IP scope for port 50013, which is used by the connection
SAP Start Service – SAP Management Console, you can restrict the IP access to a small number of
SAP Administrators. Then delete this port from the SAP ABAP Server 00 rule and create a new
rule for port 50013 with a more restrictive scope.

5.2 Logging On to the Application Server

You need to check that you can log on to the application server using the following standard users:

Java Standalone Users

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>User Name Storage: External ABAP System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>Administrator</td>
<td>You create this user manually during the installation process.</td>
</tr>
</tbody>
</table>

Prerequisites

- The SAP system is up and running.
Logging On to the Java Application Server

You access AS Java with a URL using a Web browser from your client machines. To log on to the Java application server, proceed as follows:

1. Start a Web browser and enter the following URL:

   \[\text{http://<hostname_of_Java EE_Engine_Server>:5<Instance_Number>00}\]

   \[\text{Note}\]

   You must always enter a two-digit number for \(<\text{Instance\_Number}>\). For example, do not enter 1 but instead enter 01.

   \[\text{Example}\]

   If you installed the SAP NetWeaver Application Server Java on host \text{saphost06} and the instance number of your SAP NetWeaver Application Server Java is 04, enter the following URL:

   \[\text{http://saphost06:50400}\]

   The start page of the SAP NetWeaver Application Server Java appears in the Web browser.

2. Log on by pressing the icon of any of the provided applications, for example the \text{SAP NetWeaver Administrator}.

5.3 Ensuring User Security

You need to ensure the security of the users that \text{SAPInst} creates during the installation. For security reasons, you also need to copy the installation directory to a separate, secure location — such as a DVD — and then delete the installation directory.

\[\text{Recommendation}\]

In all cases, the user ID and password are only encoded when transported across the network. Therefore, we recommend using encryption at the network layer, either by using the Secure Sockets Layer (SSL) protocol for HTTP connections, or Secure Network Communications (SNC) for the SAP protocols dialog and RFC.

For more information, see the \text{SAP Library [page 12]}:

\[\text{Function-Oriented View} \rightarrow \text{Security} \rightarrow \text{Network and Transport Layer Security} \rightarrow \]

\[\text{Caution}\]

Make sure that you perform this procedure \text{before} the newly installed SAP system goes into production.
Prerequisites
If you change user passwords, be aware that SAP system users might exist in multiple SAP system clients (for example, if a user was copied as part of the client copy). Therefore, you need to change the passwords in all the relevant SAP system clients.

Procedure
For the users listed below, take the precautions described in the relevant SAP security guide, which you can find on SAP Service Marketplace at [http://service.sap.com/securityguide](http://service.sap.com/securityguide):

Operating System and Database Users

<table>
<thead>
<tr>
<th>User Type</th>
<th>User</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sqd&lt;dbsid&gt;</td>
<td>SAP MaxDB database administrator (that is, the owner of the database files)</td>
</tr>
<tr>
<td>SAP MaxDB database users</td>
<td>SAP&lt;SAPSID&gt;DB</td>
<td>SAP MaxDB database owner (that is, the owner of the database tables)</td>
</tr>
<tr>
<td></td>
<td>CONTROL</td>
<td>SAP MaxDB database studio operator</td>
</tr>
<tr>
<td></td>
<td>SUPERDBA</td>
<td>SAP MaxDB database system administrator</td>
</tr>
</tbody>
</table>

Host Agent User

<table>
<thead>
<tr>
<th>User</th>
<th>User Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system user</td>
<td>sapadm</td>
<td>SAP system administrator You do not need to change the password of this user after the installation. This user is for administration purposes only.</td>
</tr>
</tbody>
</table>

Note
You can set up Java standalone users with the SAP User Management Engine (UME) in one of the following ways:

- With the users stored in an external ABAP system – see the first table below
- With the users stored in the database – see the second table below

The next two tables show these ways of managing the users.
### SAP System Users Stored in an External ABAP System

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: External ABAP System</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>This user’s password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the AS Java Config Tool. For more information, see Checking the SAP Java Documentation [page 97].</td>
</tr>
<tr>
<td>Guest</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>Lock this user for interactive logon.</td>
</tr>
<tr>
<td>Communication user for Application Server Java</td>
<td>You create this user manually in the external ABAP system during the installation process.</td>
<td>Specify this user as a Communications user and not as a dialog user. This user exists at least in the SAP system client that you specified during the installation.</td>
</tr>
</tbody>
</table>

### SAP System Users Stored in the Database

<table>
<thead>
<tr>
<th>User</th>
<th>User Name Storage: Database</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>The name that you gave this user during the installation or the default name Administrator</td>
<td>This user’s password is stored in secure storage. Therefore, whenever you change the administrator’s password, you must also change the password in secure storage with the AS Java Config Tool. For more information, see Checking the SAP Java Documentation [page 97].</td>
</tr>
<tr>
<td>Guest</td>
<td>The name that you gave this user during the installation or the default name Guest</td>
<td>Lock this user for interactive logon.</td>
</tr>
</tbody>
</table>
5.4 Installing the SAP License

You must install a permanent SAP license. When you install your SAP system, a temporary license is automatically installed. This temporary license allows you to use the system for only four weeks from the date of installation.

⚠️ Caution

Before the temporary license expires, you must apply for a permanent license key from SAP. We recommend that you apply for a permanent license key as soon as possible after installing your system.

Procedure

For information about the installation procedure for the SAP license, see the SAP library [page 12]:

- SAP NetWeaver Process Integration Library
- Administrator’s Guide
- Technical Operations Manual for SAP NetWeaver (TOM)
- General Administration Tasks
- License Administration

Only valid for: HA (MSCS)

Note

The license key is bound to the hardware key of the host where the message server is running. In a high-availability system with MSCS, the message server is part of the (A)SCS instance that can run on different MSCS node. Therefore you must install the SAP license on both nodes.

You have to do failover from the first MSCS node where the (A)SCS instance is installed to the second MSCS node. Use the hardware key of the second MSCS node for the installation of the second SAP license.

End of: HA (MSCS)

More Information

For more information about SAP license keys and how to obtain them, see SAP Service Marketplace at http://service.sap.com/licensekey.

5.5 Creating Symbolic Links on Windows Server 2008 for Application Servers

With Windows Server 2008 you can create symbolic links for additional application server instances to simplify their administration.
5.6 Configuring the Transport Management System

You have to perform some steps to be able to use the Transport Management System.

Procedure

1. Perform post-installation steps for the transport organizer:
   a) Call transaction SE06.
   b) Select Standard Installation.
   c) Choose Perform Post-Installation Actions.
2. Call transaction STMS in your SAP Solution Manager system to configure the domain controller in the Transport Management System (TMS).

Only valid for: HA (MSCS)

3. In a high-availability system with MSCS, you must configure all systems in the TMS landscape. To do this implement SAP Note 943334.

End of: HA (MSCS)

Result
You can now perform Java transports in the TMS of your SAP Solution Manager system.

More Information
For more information, see the SAP Library [page 12]:
Function-Oriented View Application Server ABAP Administration Tools for ABAP Change and Transport System

5.7 Configuring the Remote Connection to SAP Support

SAP offers its customers access to support and a number of remote services such as the EarlyWatch Service or the GoingLive Service. Therefore, you have to set up a remote network connection to SAP. For more information, see SAP Service Marketplace at http://service.sap.com/remotecnnection.

5.8 Applying the Latest Kernel and Support Packages

You have to apply the latest kernel and Support Packages for your SAP system from SAP Service Marketplace.

Caution
Before you apply support packages, make sure that you read the release notes for your SAP system.
You can find these at http://service.sap.com/releasenotes. The release notes might include information about steps you have to perform after you have applied the support packages.

You can use Java Support Package Manager (JSPM) to apply both the latest ABAP+Java or Java kernel and Java support packages.
JSPM is a Java standalone tool that you can use with SAP NetWeaver 7.1. JSPM uses the Software Deployment Manager (SDM) to apply support packages and patches and to deploy software components.
For more information about JSPM and how to use this tool, see the SAP Library [page 12]: Administrator's Guide Technical Operations for SAP NetWeaver General Administration Tasks Software Life-Cycle Management
Procedure

1. Apply the latest kernel.
   We recommend that you replace the installed kernel with the latest kernel from SAP Service Marketplace. In particular, you should replace the installed kernel if:
   - You installed the kernel executables locally on every host.
   - Your primary application server instance host runs on a different operating system than your additional application server instance host.

   For more information about how to download a kernel, see SAP Note 19466.
   To exchange the ABAP+Java kernel, you can use Java Support Package Manager (JSPM).

2. Apply Support Packages.
   a) Alternatively, you can download Support Packages from:
      http://service.sap.com/patches
   b) Apply the Java Support Packages to your SAP system with the help of the Java Support Package Manager (JSPM).

   For more information about the availability of Support Packages, see:
   http://service.sap.com/ocs-schedules
   For more information about how to update your CE system, see the documenta-
   tion SAP NetWeaver Composition Environment 7.1 — Update Guide SP<xx>, available at

5.9 Installing or Upgrading Database Studio for SAP MaxDB

This section describes how to install or upgrade Database Studio for SAP MaxDB and SAP liveCache on Windows front ends. Database Studio is the database administration tool for SAP MaxDB.

For more information about Database Studio, see:
https://www.sdn.sap.com/irj/sdn/maxdb

Note
Database Studio replaces Database Manager and SQL Studio, which were available in previous releases. For more information about how to install Database Studio, see SAP Note 109731.
Prerequisites

You can install Database Studio on Linux or Windows (32-bit or 64-bit) in your network, even if your database runs on a different operating system. You can then remotely administer the database on a different host.

The instructions below refer to the Windows version.

Your PC must meet the following minimum operating system requirements:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2000</td>
<td>Any</td>
</tr>
<tr>
<td>Windows 2003</td>
<td>Any</td>
</tr>
</tbody>
</table>

Your PC must meet the following minimum hardware requirements:

- Pentium II
- 64 MB RAM
- 100 MB disk space

You can get the required files from one of the following:

- The MaxDB RDBMS or SAP liveCache DVD
- By downloading from:
  - [http://service.sap.com/patches](http://service.sap.com/patches) Entry by Application Group Additional Components MaxDB MaxDB GUI COMPONENTS/TOOLS MAXDB DATABASE STUDIO 7.7

Caution

If SAP MaxDB or liveCache is installed on the PC, you must **not** install Database Studio in the same directory.

You need Java Runtime Environment (JRE) version 5 (also known as 1.5) or higher.

To check your Java version, enter the following command:

```
java -version
```


To uninstall the database manager GUI, which is the tool replaced by Database Studio, choose

- Start
- Settings
- Control Panel
- Add/Remove Programs

Procedure

1. Start the installation or upgrade as follows:
   - If you are using the MaxDB RDBMS DVD:
     ```
     <DVD>:\\MaxDB_Windows_<Processor>\SETUP\SDBSETUP.EXE
     ```
If you are using the liveCache DVD:

\texttt{<DVD>}:/\texttt{LC_Windows_<Processor>}\texttt{\|SETUP\|SDBSETUP\|EXE}

If you are using the downloaded files, simply execute the downloaded SDBSETUP\|EXE file.

The Installation Manager starts.

2. Choose Start Installation/Upgrade.

An installation shield guides you through the installation.

\begin{itemize}
  \item \textbf{Note}
  \begin{itemize}
    \item If you already have an older version installed on the PC, the installation shield offers to upgrade it for you.
  \end{itemize}
\end{itemize}

3. If you are prompted to restart the PC after the installation, make sure that you first bring down any databases that are running.

\section*{5.10 Secure Sockets Layer Protocol for Database Server Communication}

The SAP MaxDB database server supports the Secure Sockets Layer (SSL) protocol. You can use this protocol to communicate between the database server and its client, here the Application Server (AS). SSL guarantees encrypted data transfer between the SAP MaxDB database server and its client applications. In addition, the server authenticates itself to the client.

\begin{itemize}
  \item \textbf{Caution}
  \begin{itemize}
    \item There is a performance cost for SSL since the data has to be encrypted, which requires time and processing power.
  \end{itemize}
\end{itemize}

To use SSL you need to:

1. \textit{Install the SAP cryptographic library} [page 92] on the client host and on the server host machines
2. \textit{Generate the Personal Security Environment} [page 94] (PSE) on the server (SSL Server PSE) and on the client (SSL Client PSE).

\subsection*{5.10.1 Installing the SAP Cryptographic Library}

The SAP Cryptographic Library supplies the cryptographic functions required to build a database server-client connection using Secure Sockets Layer (SSL). Therefore, you need to install the SAP Cryptographic Library on the host machine of the SAP MaxDB database server and the SAP Application Server (AS).

The installation package \texttt{sapcrypto\|car} consists of the following:
SAP Cryptographic Library: sapcrypto.dll
License ticket: ticket
Configuration tool: sapgenpse.exe

You use the configuration tool to generate key pairs and PSEs.

**Caution**
The SAP Cryptographic Library is subject to German export regulations and might not be available to some customers. In addition, the library might be subject to the local regulations of your country. These regulations might further restrict import, use, and export or re-export of cryptographic software.
For more information, contact your local SAP representative.

**Prerequisites**
Download the appropriate SAP Cryptographic Library installation package for your operating system from [http://service.sap.com/swcenter](http://service.sap.com/swcenter).

**Procedure**

1. Unpack the installation package for the SAP Cryptographic Library using sapcar.exe, which you can find for example on your Installation Master DVD, using the following command:
   ```
car -xvf SAPCRYPTO.CAR
   ```

   **Note**
The remainder of the procedure (as described below) does not apply to client applications such as SQL Studio, which do not recognize an “independent” directory. In this case, you must copy the SAPCRYPTO installation package to the installation directory of the application. In this directory you need to create a directory sec, into which you copy the ticket file.

2. Copy the sapcrypto library to the lib subdirectory of the “independent program” directory.
   You can find the value of the independent program directory by entering the following command:
   ```
dbmcli dbm_getpath IndepProgPath
   ```

   **Example**
The independent program directory might be called the following:
   `<drive>:\sapdb\programs\lib`

3. Copy the configuration tool sapgenpse.exe to the directory `<independent program>\lib`.
4. Create a subdirectory called sec under the “independent data” directory and copy the ticket file into it.
5. Make sure that only the local system account is allowed to possess access rights to the sec directory and the files it contains – including the ticket file and the SSL Server PSE – and that access is restricted to read\write. Only members of the administrator group can own the files.

**Result**
The system copies the SAP Cryptographic Library to the application server and correctly configures the environment so that the server can find the library at runtime.

### 5.10.2 Generating the Personal Security Environment

The information required by the database server or client application to communicate using Secure Sockets Layer are stored in the Personal Security Environment (PSE). The required information differs according to whether SSL PSE is for the server or client:

- **SSL Server PSE**
  This PSE contains the security information from the database server, for example, the public-private cryptographic key pair and certificate chain. To install the SSL Server PSE, you need to generate the PSE. You can either do this for a single database server or system-wide. The SSL Server PSE is called SDBSSLS.exe.

- **SSL Client PSE**
  The client requires an anonymous certificate called SDBSSLA.exe, which contains the list of the public keys of trustworthy database servers.

**Procedure**
To generate the SSL Server PSE, proceed as follows:

---

**Note**
You need to know the naming convention for the distinguished name of the database server. The syntax of the distinguished name, which you enter in the procedure below, depends on the Certification Authority (CA) that you are using.

1. Change to the <independent programs>\1ib directory.
2. Set up the following environment variable:
   ```
   SECU_DIR=<independent data>\sec
   ```
3. Create an SSL Server PSE, SDBSSLS.pse, and generate a certificate request file, certreq, in the directory defined by SECU_DIR (see previous step):
sapgenpse gen_pse -v -r <SECUDIR>\certreq -p SDBSSLS.pse "<your distinguished name>"

For each database server that uses a server-specific PSE, you must set up a unique certificate request. If you are using a valid system-wide SSL Server PSE, you only need to set up a single certificate request for all servers.

4. Send the certificate request to the CA for signing. You can either send it to the SAP CA or to another CA.
   
   You must make sure that the CA offers a certificate corresponding to the PKCS#7 certificate chain format. Thawte CA at [www.thawte.com](http://www.thawte.com) offers a suitable certificate, either SSL Chained CA Cert or PKCS#7 certificate chain format.
   
   The CA validates the information contained in the certificate request, according to its own guidelines, and sends a reply containing the public key certificate.

5. After you have received the reply from the CA, make sure that the contents of the certificate request have not been destroyed during download.
   
   For example, if you requested the certificate on a UNIX system and stored it on a Windows front end, the formatting (that is, line indents and line breaks) is affected.
   
   To check the contents, open the certificate request with a text editor (such as Notepad) and repair the line indents and the line breaks.

   ![Example]

   This is an example of a certificate request:
   
   -----BEGIN CERTIFICATE-----
   REQUEST-----MIIBpzbCboqQIBADAAMigfMA0GCSqGSIb3DQEBAQUAA4GNADCBiQKBgQC/3021Y+
   wp1gnSw7U9FwNeyWz3Wi110S18aFCYKRo08wCpD8UwcaC4dds4uGT6h12W1J0/F0tUg+EQxonZbaRrk9sTallkn1mqx3YAT
   -----END CERTIFICATE REQUEST-----

6. Import the reply to the SSL Server PSE:
   
   a) Copy the text to a temporary file called srcert.
   b) Enter the following command:

   ```bash
   sapgenpse import_own_cert -c srcert -p SDBSSLS.pse
   ```

   You have generated the SSL Server PSE. You can now start the XServer as usual (if it is already running, you must stop and restart it).

7. To check whether the SSL functionality is working correctly, view the trace file nsiserver_<local computer name>.trace in the <independent data>\wrk directory.

To generate the SSL Client PSE, proceed as follows:

1. Change to the <independent programs>\lib directory.
2. Set up the following environment variable:

   ```bash
   SECUDIR=<independent data>\sec
   ```
3. Create an anonymous client SSL Client PSE, SDBSSLA.pse in the directory defined by SECUDIR (see previous step):

   ```bash
   sapgenpse gen_pse -v -noreq -p SDBSSLA.pse
   ```
You can leave the distinguished name empty. Before you can establish an SSL connection to a database server, the server certificate must be entered in the PK list of the anonymous client certificate.

4. To see the database server certificate, enter the following command:

```
x_ping -n <servermode> -c[apture]
```

You can check whether to trust the database server certificate. The client certificate is not affected by this.

5. Start the import with this command:

```
x_ping -n <servermode> -i[import]
```

6. To administer the PSE, use the configuration tool sapgenpse. For more information, enter the following command:

```
sapgenpse -h
```

Note

For applications such as SQL Studio replace the independent data or independent program in the above description with the installation directory.

**5.11 Backing Up the SAP MaxDB Database**

You need to define backup media and back up the SAP MaxDB database using Database Studio.

**Prerequisites**

- You have finished client maintenance.
- You have installed Database Studio [page 90].
- You can find more information on backing up the database at:
  
  - [https://www.sdn.sap.com/irj/sdn/maxdb](https://www.sdn.sap.com/irj/sdn/maxdb) - SAP MaxDB Knowledge Center - The Complete SAP MaxDB Documentation Set - Open the SAP MaxDB 7.7 Library - Tools - Database Studio - Backup Database: Overview

**Procedure**

1. Define the backup template as described in Defining a Backup Template in the above documentation.
2. Back up the database as described in Backing Up Data and Backing Up Log Entries in the above documentation.
5.12 Updating the Database Software to the Current Release

After the installation and before you start production operation, we strongly recommend you to update the database software.

Procedure

1. Download the latest MaxDB patches as follows:
   - [http://service.sap.com/swdc](http://service.sap.com/swdc) → Download → Database Patches → MaxDB
   - For more information about upgrading to a MaxDB Support Package, see SAP Note 735598.

5.13 Post-Installation Steps for the Host Agent

You have to perform the following steps on each host where the host agent is installed. This applies whether the host agent is installed on a host within the SAP system or standalone on another host.

Procedure

1. You check whether the installed services are available as follows:
   a) Log on as user sapadm.
   b) Check whether the following services are available:
      ■ The control program saphostexec
      ■ The operating system collector saposcol
      ■ The SAP NetWeaver Management agent SAPHostControl (sapstartsrv in host mode)

   ![Note]

   When the host is booted, the services SAPHostControl and SAPHostExec automatically start the installed programs

2. You configure the host agent according to your requirements.

More Information

For more information, see the SAP Library [page 12]:
- Function-Oriented View → Application Server ABAP → Administration Tools for AS ABAP → Monitoring in the CCMS → Infrastructure of the SAP NetWeaver Management Agents

5.14 Checking the SAP Java Documentation

Here you can find information in the SAP Library about the configuration of Application Server Java (AS Java) and about SAP Java technology.
Procedure

1. Choose the following in the SAP library [page 12]:
   - Function-Oriented View ➤ Application Server Java ➤ AS Java (Application Server Java)

2. Check the following documentation for information relevant to running your Java system:

<table>
<thead>
<tr>
<th>Manual</th>
<th>Contents</th>
</tr>
</thead>
</table>
| ➤ Application Server Infrastructure ➤ Architecture of the SAP NetWeaver Application Server ➤ Architecture of AS Java | This documentation provides an overview of the architecture of the Application Server Java (AS Java). It contains information on:  
  - Java cluster architecture  
  - Application Server Java (AS Java) system architecture  
  - Zero Administration (technical configuration within AS Java) |
| ➤ Application Server Java ➤ Administration | This documentation describes how to administer the SAP system, focusing on AS Java. It contains information on:  
  - Administration Tools  
    - SAP Management Console  
      The SAP Management Console (SAP MC) provides a common framework for centralized system management. It lets you monitor and perform basic administration tasks on the SAP system centrally, thus simplifying system administration.  
    - SAP NetWeaver Administrator  
      SAP NetWeaver Administrator is a Web-based tool for administration and monitoring that offers a single entry point to configure, administer, and monitor your SAP NetWeaver system, its components, and the applications running on it.  
    - Config Tool  
      The Config Tool provides offline configuration of the SAP NetWeaver Application Server Java (AS Java) instances. It lets you modify the properties of all services, managers, and applications. In addition, it enables you to manage log configurations offline, add filters, and edit the JVM parameters.  
    - Administration Using Telnet  
    - SAP Java Virtual Machine (SAP JVM)  
    - The Startup Framework for AS Java  
    - Administration Functions for Information Lifecycle Management |
| ➤ Application Server Java ➤ Identity Management of the Application Server Java | Identity Management of the SAP NetWeaver Application Server (AS) Java enables you to manage users and roles for access to applications of the AS Java and the data, which the applications require. The user management engine (UME) provides identity management as a service of the AS Java. This documentation contains information on:  
  - User Management Engine  
  - Authorization Concept of the AS Java  
  - Configuring Identity Management  
  - Administration of Users and Roles |
5.15 CE-Specific Post-Installation Activities

This section describes the steps that you have to perform after the installation has finished successfully.

**Running the Configuration Wizard (Optional)**

> Note

You can run the configuration wizard **only once** and only **directly after installing and patching** your SAP system.

After SAPinst has finished, run the configuration wizard to apply automated configuration tasks to your system.

For SAP NetWeaver CE, you need to run the following configuration tasks, depending on the installed components:

- **Configuration of Services Registry Webservice Destinations**
- **Configuration and Mirroring of local NWDS Update Site**
- **Initial setup ADS in CE (if ADS is available on your platform)**
- **Change Management Service (CMS): Create an Application Skeleton**
- **Change Management Service (CMS): Modify a Software Component**

For more information about how to start the configuration wizard, see the configuration documentation in the SAP Solution Manager.

**Enabling Adobe Document Services**

If you have installed SAP NetWeaver Composition Environment with the Adobe Document Services add-on a Windows platform, you must complete the following post-installation steps to enable the add-on. In case you have installed an AS Java cluster, apply the procedure to the central host, as well as to all hosts where additional application server instances are running.

1. Using the SAP Management Console, stop the AS Java system.

2. From the Start menu, open Control Panel ▶ Administrative Tools ▶ Computer Management ▶ Services and Applications ▶ Services .

3. Select SAP<SID>_<Instance_Number> (for example, SAPCE1_00) and open Properties from the context menu.

4. On the Log On tab page, enable the Local System account indicator.

5. Repeat the above steps for the second SAP<SID>_<Instance_Number> service that you see in the list.

6. Start the AS Java system.

Adobe LiveCycle Designer

For more information about how to install and configure the Adobe LiveCycle Designer see SAP Note 962763.

Enabling Services Registry

You must apply additional configuration steps to enable Services Registry after you have installed an SAP NetWeaver Composition Environment system containing the following components:

- Java Application Server and Composition Platform
- Java Application Server and Adobe Document Services

To enable Services Registry, you must apply the following configuration template to your system:

CE_Complete_System_production_full

Note

For more information about what configuration templates are available, see Configuration Templates [page 105].

For more information about applying configuration templates, see SAP NetWeaver Composition Environment Library ▶ Administrator’s Guide ▶ Configuration of SAP NetWeaver CE ▶ Initial System Configuration ▶ AS Java Configuration ▶ Activating a Configuration Template .

See also


Configuring the Portal in SAP NetWeaver CE

After installing the portal in SAP NetWeaver CE, a number of deactivated or irrelevant tools are displayed in the UI. To display the correct portals tools for CE, proceed as follows:

1. Open a browser and log on to your portal as an administrator.

2. In the same browser session, enter the following URL:

where \(<\text{host}\>\) is the host name of your server and \(<\text{httpport}\>\) is the port number of your server.

3. In the Portal Mode Configuration Tool, choose Activate Development Mode to restore the portal tools and content that are assigned to the development mode.

4. Restart or refresh your browser.

5. In the SAP Management Console, restart the server.

You may then continue with the mandatory and optional configuration steps as described in

\[\text{http://help.sap.com/nwce} \gg \text{SAP NetWeaver Composition Environment Library} \gg \text{Administrator's Guide} \gg \text{Configuration of SAP NetWeaver Composition Environment} \gg \text{Configuration for CE Additional Components} \gg \text{Configuring the Portal}\].

### Changing the Password for the Internet Communication Manager (ICM)

You can monitor and manage the Internet Communication Manager (ICM) from the command line program.

After the installation of your SAP NetWeaver CE system has successfully finished, you need to change the ICM password manually. To do so, proceed as follows:

1. Log on at operating system level to the computer where the ICM is running.
2. Start the program `icom` with `icom -a profile=<instance_profile>` to maintain the authentication file (default: `authfile.txt`).
3. Choose `a` to add a user.
4. Choose `c` to change the password of the existing user.
5. Choose `s` to save your settings.

### Further Configuration Steps

After installing your SAP NetWeaver CE system and performing the post-installation steps to get the system up & running, you may need to perform further configuration steps.

Refer to the following documentation to proceed with your tasks:

- If you are a **system administrator**, refer to \[\text{http://help.sap.com/nwce} \gg \text{Administrator's Guide}\]. It contains information about how to configure and administer your system.
- If you are a **developer**, refer to \[\text{http://help.sap.com/nwce} \gg \text{Developer's Guide}\]. It provides guidelines for developing applications using the SAP NetWeaver CE.

**Note**

The SAP NetWeaver CE documentation is also available offline as a part of your installation. To access it, choose \[\text{Start} \gg \text{All Programs} \gg \text{SAP NetWeaver} \gg \text{Composition Environment 1.0} \gg \text{Documentation}\].
5.16 Performing a Full System Backup

You must perform a full system backup after the configuration of your SAP system. If required, you can also perform a full system backup after the installation (recommended). In addition, we recommend you to regularly back up your database.

Prerequisites
- You are logged on as user <sapsid>adm.
- You have shut down the SAP system and database.

Procedure
Back up your system including the operating system disk, system state, and all other disks.

5.17 Post-Installation Steps for the Diagnostics Agent

To implement the E2E Root Cause Analysis scenario, you have to configure the Diagnostics Agent.

Prerequisites
You have installed an AS Java central instance or dialog instance.

Procedure
Plan the implementation of the SAP Solution Manager Diagnostics Agent as described in the Root Cause Analysis Installation and Upgrade Guide, which you can find at http://service.sap.com/diagnostics.
6 Additional Information

Here you can find additional information about the installation of your SAP system. There is also information about how to delete an SAP system.

- SAP Directories [page 106].
- Additional Information about SAPinst [page ]
- Starting and Stopping the SAP System [page 110].
- SAP System Security on Windows [page 111]
- Automatic Creation of Accounts and Groups [page 113]
- Deleting an SAP System [page 115]

6.1 Transporting Self-Developed Software Component Archives (SCA) into the System

Prerequisites
You have developed your own Software Component Archives (SCA) and want to transport them into your SAP NetWeaver CE system.

Procedure
To transport your SCAs to the SAP NetWeaver CE system, proceed as follows:

2. From an empty directory, run the update tool update<ID>.exe.

Note
If the tool displays descriptions such as Applying Support Packages, you can ignore them.

3. In the dialog screens, specify the directory where your SCAs are located.
4. Follow the on-screen instructions.
6.2 Troubleshooting – Repairing an Inconsistent SAP MaxDB Installation

Prerequisites
During the preinstallation phase, the installation tool checks the Microsoft Windows registry for already installed SAP MaxDB software. If the registry key is found but there is no software on the hard drive, you receive the following message:

The existing MaxDB software is not consistent. Check the file system and registry.

The most common reason for this inconsistency is the manual deletion of the software from the file system without using the specified tools.

Procedure
To repair this inconsistency, proceed as follows:

2. Make sure the services SAPDBWWW, SAPDB: *, and XServer are stopped.
3. Choose ▶ Start ▶ Run and run the command regedit.
4. Go to ▶ My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\SAP\SAP DBTech ▶ Key IndepPrograms.
   - The key contains a path to a folder.
     a) Check if this folder exists on the file system.
     b) Note down the value of Key IndepPrograms for later usage (see step 7).
      - If the path does not exist in the file system, delete the key SAP_DBTech.
5. Delete the following keys:
   - My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SAP_DBTech:*
   - My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\SAPDBWWW
   - My Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\XServer
7. Delete the following paths from the variable:
   - <IndepPrograms>/bin
   - <IndepPrograms>/pgm
8. Reboot your computer.

6.3 Restarting the SAP MaxDB Server Manually

If, after a reboot, the database server is not running automatically, you need to restart the SAP MaxDB server manually.

Production Systems
To restart the SAP MaxDB server manually, proceed as follows:
1. Open a command prompt and enter the following command: `net start sapdbwww`
   OR
   Choose Start All Programs Administrative Tools Services. Double-click on SAP DB WWW and choose Start.
2. Open the SAP Management Console and choose SAP Systems <SAPSID> <machine name>.
3. Enter the master password and choose Logon.
4. Choose Online. When the database server is online, you can restart the engine.

**Development Systems**
To restart the SAP MaxDB server manually, choose Start All Programs SAP NetWeaver Composition Environment CE Application Server <SAPSID> Start Application Server.

### 6.4 Configuration Templates

Configuration templates contain the predefined instance configuration for specific scenarios. They are automatically applied according to the installation option you have selected. The templates are designed to optimize system performance by applying certain configuration to the Java Virtual Machine and the application server, as well as by applying startup filters to AS Java services and applications to start only those relevant for the selected installation options.

The following table provides information about the available templates with SAP NetWeaver Composition Environment. In the template name, replace the `<system_mode>` parameter by development (for the templates relevant to systems installed in development mode) or production (for the templates relevant to systems installed in productive mode).

<table>
<thead>
<tr>
<th>Configuration Template</th>
<th>Selected Installation Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE_Java_EE_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation</td>
</tr>
<tr>
<td>CE_Composition_Environment_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation</td>
</tr>
<tr>
<td>CE_Adobe_Document_Service_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Adobe Document Services Add-on Installation</td>
</tr>
<tr>
<td>CE_Composite_Voice_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Voice Add-on Installation</td>
</tr>
<tr>
<td>CE_Complete_Stack_&lt;system_mode&gt;_full</td>
<td>Java Application Server Installation + Composition Platform Installation + Adobe Document Services Add-on Installation + Voice Add-on Installation</td>
</tr>
</tbody>
</table>

If your selection cannot be mapped to one of the combinations in the above table, the template `CE_Complete_Stack_<system_mode>_full` is applied. It starts all applications and services needed to run the complete stack.
You can manually apply a different configuration template if you want to switch to another installation option. For example, by changing from template CE_Complete_Stack_<system_mode>_full to CE_Java_EE_<system_mode>_full, you achieve shorter startup times and less memory consumption, but also less functionality since not all applications and services are running. For more information about applying configuration templates, see [http://help.sap.com/nwce](http://help.sap.com/nwce) Administrator’s Guide | Configuration of SAP NetWeaver CE | Initial System Configuration | AS Java Configuration | Activating a Configuration Template.

Note
Make sure that you do not apply a development template to a productive system or vice versa.

### 6.5 Uninstalling SAP NetWeaver Composition Environment

You have to uninstall all components of the SAP NetWeaver Composition Environment separately. You can uninstall your SAP NetWeaver CE system in different ways.

**Uninstalling SAP NetWeaver CE**

Choose [Start | Control Panel | Add / Remove programs | SAP System <SAPSID>].

**Uninstalling SAP NetWeaver CE Using SAPinst**

1. Insert the SAP Installation Master DVD into your DVD drive or mount it locally.
2. Start SAPinst from the SAP Installation Master DVD as described in the section Installing SAP NetWeaver Composition Environment.
3. In the Welcome screen, choose Uninstall SAP System or Single Instances from the tree structure.
4. Follow the on-screen instructions.

**Uninstalling the SAP Management Console**

Since all SAP systems use the SAP Management Console, there is no uninstallation option for the SAP Management Console with SAPinst. If you are sure that you do not need the SAP Management Console any more, you can remove it using [Start | Control Panel | Add / Remove programs].

### 6.6 SAP Directories

This section describes the SAP directories that SAPinst creates during the installation.

**Only valid for: HA (MSCS)**

If you want to install an MSCS system, see also: **Directories in an MSCS Configuration** [page 127].

**End of: HA (MSCS)**
SAPInst automatically creates the following directories during the installation:

- **\usr\sap**
  
  This directory is created on the:
  
  - **Global** host and **shared** with the network share sapmnt

  [Only valid for: non-HA]
  
  The global host is the host where the SCS and primary application server instance is installed.

  [End of: non-HA]

  [Only valid for: HA (MSCS)]
  
  The global host is the host where the SCS instance is installed.

  [End of: HA (MSCS)]

  On global hosts, the **\usr\sap** directory contains general SAP software, global and local (instance-specific) data.
  
  For this, SAPInst creates the global directory **\usr\sap\<SAPSID>\SYS**, which physically exists only once for each SAP system. It consists of the following subdirectories:
  
  - **global** — contains globally shared data
  - **profile** — contains the profiles for all instances
  - **exe** — contains executable replication directory for all instances and platforms

  - **Local** host and **shared** with the name **saploc**.

  [Only valid for: HA (MSCS)]

  In a high availability system this directory is located on a local disk. You have at least two disk drives with a **\usr\sap** directory structure.

  [End of: HA (MSCS)]

  On local hosts, the **\usr\sap\<SAPSID>\<instance_name>** directory contains copies of the SAP software and local (instance-specific) data.

  [Note]
  
  Since SAP traces for the instance are created in **\usr\sap**, make sure there is sufficient space available in this directory. Changes in SAP profiles can also affect the disk space.

  [Note]
  
  The executables on the local host are replicated from those on the global host every time the local instance is started. The SAP copy program **sapcpe** compares the binaries in the **<platform>** directory on the global host and the binaries in the **exe** directory on the application server. If the binaries in the **exe** directory are elder than those in the **<platform>** directory, **sapcpe** replaces them with the newer version of the global host.

  Other application servers access the global data using the Universal Naming Convention (UNC) path **\<SAPGLOBALHOST>\sapmnt**. The SAP programs access their instance-specific data with the
UNC path `\\<SAPLOCALHOST>\saploc`. If the UNC path points to a local directory, the local path (and not the UNC path) is used to access the directory.

The parameters `SAPGLOBALHOST` and `SAPLOCALHOST` have the **same** values on the global host.

---

### Note

**Windows Server 2008 only:**

In a high-availability system, file shares pointing to directories on shared disks are only visible or accessible with the virtual host name of the cluster group the shared disks belong to.

---

### Directory Structure

The following figures show how the physical directory `\usr\sap` is shared on the global host in a standard and in a distributed system. In both cases, the UNC paths are used as follows:

- `\\<SAPGLOBALHOST>\sapmnt` to access global directories
- `\\<SAPLOCALHOST>\saploc` to access local instance-specific data

---

### Note

There are the following instance names available in an SAP system:

- Central services instance: `SCS<No>`
- Primary application server instance: `J<Instance_Number>`
Additional application server instance: J<Instance_Number>.

**Figure 7:** Directory Structure on the Global Host in a Standard (Central) Java System

![Diagram of directory structure on the Global Host in a Standard (Central) Java System]

- Key:
  - Replication by sapcpe
  - uc = Unicode

**Figure 8:** Directory Structure for a Distributed Java System

![Diagram of directory structure for a Distributed Java System]

- Key:
  - Replication by sapcpe
  - uc: Unicode
  - On global host: SAPGLOBALHOST = SAPLOCALHOST
6.7 Starting and Stopping the SAP System

You use this procedure to check that you can start and stop the SAP system after the installation with the SAP Microsoft Management Console (SAP MMC).

With a newly installed SAP MMC you can start or stop installed SAP instances locally on the host that you are logged on to. If the SAP MMC is configured for central system administration, you can start or stop the entire system from a single host.

**Note**

For more information, see the SAP Library [page 12]: Function-Oriented View ➔ Application Server ABAP ➔ Administration Tools for AS ABAP ➔ Monitoring in the CCMS ➔ SAP Microsoft Management Console: Windows ➔

**Prerequisites**

- You have logged on to the SAP system host as user `<sapsid>adm`.
- You have checked the settings for VM parameters as described in SAP Note 723909.
Procedure

1. Start the SAP MMC on the SAP system host by choosing Start All Programs SAP Management Console.
2. Right-click the SAP system node and choose Start or Stop.
   All instances listed under the system node start or stop in the correct order.
3. If the SAP system is installed on multiple hosts (distributed system), you have the following options to start or stop your system:
   You have the following options to start or stop your system:
   - You start or stop the SAP instances using the SAP MMC on each host.
   - You add the remote instances to the SAP MMC configuration to start or stop all instances from a single SAP MMC.
   To do so, you configure the SAP MMC manually. For more information, see Changing the Configuration of the SAP MMC in the SAP MMC documentation.

Note
You can also start and stop a UNIX system with the SAP MMC.

6.8 SAP System Security on Windows

In a standard SAP system installation, SAPinst automatically performs all steps relevant for security. Although SAPinst makes sure that the system is protected against unauthorized access, you must still check that no security breaches can occur.

For central and straightforward administration of the SAP system, you have to install distributed SAP systems with multiple application servers in a Windows domain. This section describes the user accounts and groups that SAPinst creates during a domain installation and shows how these are related to the SAP directories.

User Accounts

SAPinst creates the following accounts for SAP system administration:

- <sapsid>adm
  This is the SAP system administrator account that enables interactive administration of the system.
- SAPService<SAPSID>
  This is the user account that is required to start the SAP system. It has the local user right to log on as a service.
  The advantage of the additional SAPService<SAPSID> account is that it does not allow an interactive logon, which prevents abuse of the account. Therefore, you do not need to set an expiration date for the password and you do not have to set the option user must change password at next logon.
sapadm
This is the user for the SAP host agent. It is a member of the local Administrators group.
The host agent contains all of the required elements for centrally monitoring any host with the
Alert Monitor or the SAP NetWeaver Administrator.

Groups
SAPInst creates the following groups during a domain installation:

- **SAP_<SAPSID>_GlobalAdmin**
  This global group is a domain-level SAP administration group for organizing SAP system
  administrators. The only function of a global group is to group users at the domain level so that
  they can be placed in the appropriate local groups.

- **SAP_<SAPSID>_LocalAdmin**
  Only local groups are created and maintained on an application server. A local group can only be
  given permissions and rights to the system where it is located. The system is part of a particular
  domain, and the local group can contain users and global groups from this domain.

- **SAP_LocalAdmin**
  This group is created on all hosts, but is particularly important for the transport host. Members of
  the group have full control over the transport directory (`\usr\sap\trans`) that allows transports to
  take place between systems.

  The **SAP_<SAPSID>_GlobalAdmin** groups of all the SAP systems that are part of the transport
  infrastructure are added to the **SAP_LocalAdmin** group. As a consequence, the users `<sapid>adm` and
  **SAPService<SAPSID>** of all systems in the transport infrastructure are members of the
  **SAP_LocalAdmin** group and have the required authorizations necessary to initiate and execute
  transports.

**SAP Directories**
SAPInst protects the SAP directories under `\usr\sap\<SAPSID>` by only granting the group
**SAP_<SAPSID>_LocalAdmin** full control over these directories.
The following graphic illustrates the user accounts and groups created by SAPInst in a system
infrastructure consisting of two SAP systems.
Figure 10: User Groups and Accounts

Note
An access control list (ACL) controls access to SAP system objects. For maximum security in the SAP system, only the following are members of all SAP system object ACLs:

- Local group SAP_<SAPSID>_LocalAdmin
- Group Administrators
- Account SYSTEM

6.9 Automatic Creation of Accounts and Groups

SAPinst automatically creates the accounts and groups required for the secure operation of the SAP system with Windows [page 111] during the installation.

Features
The following figures show the steps that SAPinst performs to create the users and groups and assign the required rights to SAP directories.
### Figure 11: Creating Users and Groups

<table>
<thead>
<tr>
<th>Creation of Accounts</th>
<th>Creation of SAP user accounts</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Administrator</td>
<td>SAP Service Account</td>
</tr>
<tr>
<td>&lt;sapsid&gt;adm</td>
<td>&lt;SAPSID&gt;Service</td>
</tr>
<tr>
<td></td>
<td>&lt;SAPSID&gt;Host Agent Account</td>
</tr>
<tr>
<td>sapadm</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Creation and Modification of Global Group in the Domain</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation of global group &lt;SAPSID&gt;GlobalAdmin</td>
</tr>
<tr>
<td>Addition of &lt;sapsid&gt;adm and &lt;SAPSID&gt;Service to group &lt;SAPSID&gt;GlobalAdmin</td>
</tr>
<tr>
<td>Addition of &lt;sapsid&gt;adm to the local Administrators group</td>
</tr>
<tr>
<td>Addition of &lt;sapsid&gt;adm to the Windows domain user groups</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Creation and Modification of Local Group on Each Application Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creation of the local group &lt;SAPSID&gt;LocalAdmin on the application server</td>
</tr>
<tr>
<td>Addition of the global &lt;SAPSID&gt;GlobalAdmin to the local group &lt;SAPSID&gt;LocalAdmin on the application server</td>
</tr>
<tr>
<td>Creation of the local group &lt;SAPSID&gt;LocalAdmin on the transport host</td>
</tr>
<tr>
<td>Addition of the global &lt;SAPSID&gt;GlobalAdmin to the local group &lt;SAPSID&gt;LocalAdmin on the transport host</td>
</tr>
</tbody>
</table>

### Figure 12: Assigning Rights to SAP Directories

For Administrators and SAP_LocalAdmin groups:

Assignment of Full Control over:

```
usr
usr\sap
usr\sap\trans
usr\sap\prfelog
```

For Administrators and SAP_<SAPSID>_LocalAdmin groups:

Assignment of Full Control over:

```
usr\sap\<SAPSID>
```
6.10 Deleting an SAP System

This section describes how to delete a single instance, a standalone engine or a complete SAP system with the *Uninstall* option of SAPinst.

**Caution**

- You cannot delete an SAP system remotely.
- If you delete network-wide users, groups or service entries in an environment with Network Information System (NIS), other SAP installations might also be affected. Make sure that the users, groups, and service entries to be deleted are no longer required.

**Prerequisites**

- This description assumes that you have installed your SAP system with standard SAP tools according to the installation documentation.
- You are logged on with a user account that has the required authorization to run the SAPinst tool and the SAP system. For more information, see *Required User Authorization for the Installation* [page 57].

**Procedure**

1. Start SAPinst [page 68] and on the *Welcome* screen, choose:
2. Follow the instructions in the SAPinst input dialogs.

**Note**

For more information about the input parameters, place the cursor on the relevant field and press F1 in SAPinst.

SAPinst first asks you which SAP instances you want to delete. Make sure that you delete the SAP instances in the order as described hereinafter.

- If you want to delete a **standard** system (all instances reside on the same host), you can do this in one SAPinst run.
- If you want to delete a **distributed** system, you have to run SAPinst to delete the required instances **locally** on each of the hosts belonging to the SAP system in the following sequence:
  a) Additional application server instance(s), if there are any
  b) Database instance

**Caution**

SAPinst only stops **local** instances automatically. Before you delete the database instance of a distributed system make sure that you stop all remaining instances. You must stop the instance with the message server only after having entered all SAPinst parameters for the deletion of the database instance.
Choose whether you want to drop the entire database or only one or more database schemas. If you drop the entire database, SAPinst also asks whether you want to remove the database software.

c) Primary application server instance

[Note]
If SAPinst stops responding while trying to delete the primary application server instance, close SAPinst with Cancel and Exit. Log off and log on again. To complete the uninstall process of the primary application server instance, restart SAPinst.

d) Central services instance

3. If required, you can delete the directory `\usr\sap\trans` and its contents manually. SAPinst does not delete `\usr\sap\trans` because it might be shared.
7 High Availability with Microsoft Cluster Service

Note

As of Windows Server 2008 there are the following terminology changes for a cluster configuration:

- The cluster feature is now called Failover Clustering. For practical reasons we also use the previous terminology Microsoft Cluster Service and abbreviation MSCS in this guide.
- Cluster groups are now called services and applications.
  - In some sections that are also valid for Windows Server 2008 on MSCS we are continuing to use only the old term. In this case, “cluster group” also means “service and application”.
- The Cluster Administrator is now called Failover Cluster Management.

You can install a high-availability SAP system with MSCS. For this type of installation, you have to set up the system and configure it so that it can take advantage of the MSCS software. The MSCS software improves the availability of the system and safeguards it against failure and unplanned downtime, enabling 24-hour operation, 365 days a year. With high availability you enable critical system components, known as “Single Points of Failure (SPOFs)”, to be automatically switched from one machine to the other, if hardware or software problems arise on one machine. With the help of this switchover – or failover – the system can continue functioning so that unplanned system downtime is avoided. Apart from enabling failover when hardware problems occur, you can also use MSCS to avoid downtime when you perform essential system maintenance. If you need to maintain one host (MSCS node), you can deliberately switch the cluster resources to the other host (MSCS node) and temporarily operate it there while maintenance is in progress. When maintenance work is finished you can easily move the resources back to their original node and continue operating them there. You have the following options to install a high-availability system with MSCS to safeguard it against failure and unplanned downtime:

- You install one SAP system in one MSCS cluster.
- You install one SAP system in two MSCS clusters.

For all MSCS configurations the following restrictions apply:

- The (A)SCS instance must be installed and configured to run on two MSCS nodes in one MSCS cluster.
If your database supports the installation on several MSCS nodes, you can install the database instance on more than two MSCS nodes in one MSCS cluster.

Note
If you have one of these MSCS configurations and you use SAPinst to install such an MSCS system, you get SAP support with the installation, configuration, and operation.

Note
Make sure that you read SAP Note 965569, which contains the most recent information as well as corrections for MSCS. For more information, see the SAP installation notes [page 10] before you begin the installation.

In this documentation the hosts in an MSCS cluster are referred to as first MSCS node and additional MSCS node(s).

The first MSCS node is the MSCS node where you perform the general installation of an SAP system, for example where the database or (A)SCS instance is to be installed.

The additional MSCS node is the node where you configure the already installed SAP instances to run in MSCS.

To install a new SAP system with MSCS, you combine general installation steps, described earlier in this documentation, with cluster-specific steps described here:

- Since the cluster hardware has at least two nodes that have access to all local and shared storage devices, you have to install some components on all MSCS nodes and observe special rules for distributing components to local or shared disks.
- Since the correct configuration of network addresses is absolutely essential to enable the cluster to function properly, you have to perform a number of additional steps that are necessary to set up and check addressing.

Note
If you have an existing SAP system and plan to migrate to a cluster with new hardware, you install the SAP system using a system copy.
For more information about the system copy, see the System Copy Guide for your SAP system on SAP Service Marketplace at [http://service.sap.com/instguides] [Release] [Installation 4].
The documentation for system copy does not include the cluster-specific information, which is described here.

7.1 Planning

You have to complete the following planning activities for your SAP system using Microsoft Cluster Service (MSCS):
1. You check the general planning activities [page 15] listed in Chapter 2 of this guide.
2. You decide how to set up your SAP system components in an MSCS configuration [page 119].
3. You decide how to distribute SAP system components to disks for MSCS [page 123].
4. You read Directories in an MSCS Configuration [page 127].
5. You read IP Addresses in an MSCS Configuration [page 128].
6. You obtain IP addresses for MSCS [page 131].

Note
Windows Server 2008 only:
This step is not required if you use DHCP-based IP addresses.

7.1.1 System Configuration in MSCS

The following chapters provide information about the configuration of your SAP system configuration in MSCS. It describes the components you have to install for an SAP system running in a cluster, and how to distribute them on the specific host. For more information, see:

- SAP System Components in an MSCS Configuration [page 119]
- Enqueue Replication Server in MSCS [page 122]

7.1.1.1 SAP System Components in an MSCS Configuration

In an MSCS configuration you have the following mandatory components for your SAP system:

<table>
<thead>
<tr>
<th>Component</th>
<th>Number of Components per SAP System</th>
<th>Single Point of Failure</th>
</tr>
</thead>
<tbody>
<tr>
<td>SCS instance (message services and enqueue services)</td>
<td>1</td>
<td>yes</td>
</tr>
<tr>
<td>Database instance</td>
<td>1</td>
<td>yes</td>
</tr>
<tr>
<td>Application server instance</td>
<td>1-n</td>
<td>no</td>
</tr>
<tr>
<td>(primary application server, additional application server)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To protect the SPOFs ((A)SCS instance and database instance) you have to use MSCS. If a hardware or software problem occurs on the first MSCS node, the clustered (A)SCS instance and the clustered database automatically fail over to another node.
If you need to maintain the MSCS node where the (A)SCS instance and database are running you can switch these instances to another node. When maintenance work is finished you move the (A)SCS and database instance back to the original node.

To protect system components that are non-SPOFs, for example application servers, you have to install them as multiple components. In this case you must install at least two application servers (the primary application server instance and one additional application server instance) on two different hosts. You have the following options:

- You install the primary application server and the additional application server instance on the MSCS nodes of an MSCS cluster. You install them on a local disk. Any additional application server instances are installed on hosts outside of the MSCS cluster.

If you have to maintain an MSCS node, you have to stop the primary application server or the additional application server instance on that node. When you have finished maintenance, you restart the instance(s).

Note

If you install the central instance and the dialog instance on the MSCS cluster nodes, you must perform the hardware sizing for the MSCS host, as in this case the application server is always running on this host. This increases system load and might impact performance. Note that, as usual in an MSCS setup, the (A)SCS and database instances also switch to run on the MSCS host in the event of failover, which temporarily also increases system load.

- You install the primary application server and all additional application server instances on hosts, which are not part of an MS cluster.

The following figures show examples for the installation of SPOFs and non-SPOFs of an SAP system in an MSCS cluster with two nodes.

The first figure shows an MSCS configuration where the non-SPOFs components (primary application server instance, additional application server instance) are installed locally on the MSCS nodes. Any additional application server instance(s) are installed outside the MSCS cluster on separate hosts.
The following figure shows an MSCS configuration, where the non-SPOFs components (primary application server instance, additional application server instance) are installed on separate hosts that are not part of the MS cluster.

**Figure 13**: Java System

**Figure 14**: Java System
**SAP System Components in Two MSCS Clusters**

Besides installing your SAP system in one MSCS cluster, you can also set up two MSCS clusters and distribute the SPOF system components on these clusters to protect them against system failure. The following figure shows an example where the database instance for the SAP system is installed in one MSCS cluster, and the (A)SCS instance is installed on the second MSCS cluster. The application servers (primary application server instance, additional application server instance) can either be installed on a local disk on the MSCS nodes or on separate hosts that are not part of the MS cluster.

**Figure 15:** Java System

---

**7.1.1.2 Enqueue Replication Server in an MSCS Configuration**

The enqueue replication server contains a replica of the lock table (replication table) and is an essential component in a high-availability setup. It is required for a Java system, but also strongly recommended for an ABAP system.

You have to install the enqueue replication server on the two MSCS nodes where the (A)SCS instance is installed and configured to run, even if you have more than two MSCS nodes.

In normal operation the replication enqueue server is always active on the host where the (A)SCS instance is not running.

If an enqueue server in an MSCS cluster with two nodes fails on the first MSCS node, the enqueue server on the additional MSCS node is started. It retrieves the data from the replication table on that node and writes it in its lock table. The enqueue replication server on the second MSCS node...
then becomes inactive. If the first MSCS node is available again, the enqueue replication server on the second MSCS node becomes active again.

The following figure shows the enqueue replication server mechanism in an MSCS configuration with two nodes:

**Figure 16:** Enqueue Replication Server Mechanism in One MSCS Cluster with Two Nodes

![Diagram showing enqueue replication server mechanism in an MSCS configuration with two nodes.](image)

**SCS = Central Services Instance**
**ERS = Enqueue Replication Server Instance**

### 7.1.2 Distribution of SAP System Components to Disks for MSCS

When planning the MSCS installation, keep in mind that the cluster hardware has two different sets of disks:

- Local disks that are connected directly to the MSCS node(s)
- Shared disks that can be accessed by all MSCS nodes via a shared interconnect

**Note**

Shared disk is a synonym for the MSCS resource of *Resource type Physical disk.*

You need to install the SAP system components in both the following ways:

- Separately on all MSCS nodes to use the local storage on each node
- On the shared storage used in common by all MSCS nodes
You install the following on different shared disks:
- Database instance files
- (A)SCS instance
- SAP system executables
- Single quorum device, if used

⚠️ **Caution**

You **must not** install any SAP or database components on the quorum disk.

The following figure shows a cluster configuration, where the (A)SCS and DB instance are installed in the same cluster. It illustrates how to distribute the database data files, the SAP system executables, and the quorum resource (if used) to different disks. Only with this distribution of files to distinct disks is it possible to move the SAP system and database as separate entities in a failover situation.

**Figure 17:**

The following software on the local disks must have the same drive letter and path on both nodes:
- Instance-independent program software
- Instance-dependent software
Quorum Configurations on Windows

On Windows there are several quorum configurations available. The configuration to use mainly depends on the cluster setup, such as the number of cluster nodes, the storage type (single or distributed), and the number of data centers. For more information, see the Windows documentation. The default quorum configurations used on Windows are:

- Single Quorum Device Cluster – default quorum configuration on Windows Server 2003

**Note**

On Windows Server 2008, this quorum configuration is called “No Majority: Disk Only”. However, we do not recommend you to use this.

In this cluster model, the quorum resource maintains the cluster configuration data on a single shared disk. The quorum resource is unique in this cluster configuration and is always owned by one of the nodes. The quorum disk is a single resource so that if it becomes unavailable, the cluster does not work.

The quorum resource has the following main functions in the cluster:

- It logs changes to the cluster configuration that are entered in the Registry.
- It arbitrates between competing nodes when the communication between nodes breaks down.
  
  This means that cluster resources are forced to fail over to the node that owns the quorum resource.

- Node and Disk Majority – default quorum configuration on Windows Server 2008

With this quorum configuration, each node and the witness disk maintain its own copy of the cluster configuration data. This ensures that the cluster configuration is kept running even if the witness disk fails or is offline.

Note that the disk layout of the “Node and Disk Majority” and the “Single Quorum Device Cluster” is identical.

**Caution**

If you do not use the default quorum configuration for your operating system, contact your hardware partner, who can help you to analyze your needs and set up your cluster model. SAP supports these configurations if they are part of a cluster solution offered by your Original Equipment Manufacturer (OEM), or Independent Hardware Vendor (IHV).

Locally Dispersed Cluster

The standard MSCS configuration consists of two cluster nodes and a shared disk storage with all technical components located in the same data center. In a geographically dispersed cluster, also known as a geospan cluster, the cluster nodes are distributed across at least two data centers to avoid the full outage of a data center in the event of disaster.

A locally dispersed MSCS configuration requires a more sophisticated disk storage architecture since a shared disk storage can be only located in one data center and might be therefore a single point of
failure (SPOF). To prevent the disk storage becoming a SPOF, you have to configure the storage system in each data center and to replicate its content to the storage system of the other data center.
Replication can either be synchronous or asynchronous, which depends on the:

- Functionality of the disk storage subsystem
- Acceptable amount of data loss during a failover
- Physical layout of the disk storage area network
  This includes the distance between the storage systems, signal latency, capacity and speed of the network connection.
- Customer budget
- Functionality supported by the database vendor

Often, the database components in geospan configurations are no longer part of the MSCS and the database is replicated by pure database techniques, such as shadow database, log shipping, and mirrored database.

⚠️ Caution

- Currently you can configure locally dispersed clusters only in the same subnet since you cannot (Windows Server 2003) or must not (Windows Server 2008) change a virtual IP address during failover.
- The numerous variants with locally dispersed cluster configurations and the complex technical requirements are the reasons why the installation and configuration of such high-availability (HA) systems is not directly supported by SAP. Instead, the hardware vendors of this cluster configuration are responsible for the installation, configuration, and operation of the HA components running in locally dispersed clusters. SAP only supports the standard operation and function of the SAP components running in such MSCS configurations.

All functions to set up locally dispersed clusters are already integrated in Windows Server 2008.
If you use Windows Server 2003, refer to the following information to set up locally dispersed clusters:

- White paper Server Clusters: Majority Node Set Quorum at:
- Information about the “file share witness” feature, at:
  [http://support.microsoft.com/kb/921181](http://support.microsoft.com/kb/921181)

**Distribution of Database Files in a RAID Configuration**

⚠️ Caution

Microsoft does not support a host-based RAID configuration (Dynamic Disks) on shared disks.

The following figure shows a secure method to distribute the database directories to different RAID volumes.
7 High Availability with Microsoft Cluster Service
7.1 Planning

Figure 18:

Database RAID Volumes

Database Mirroring          Hardware Mirroring

RAID 5                      RAID 5
Data                         Data

RAID 0                      RAID 1
Logs                        Logs

RAID 0                      
Mirrored logs

More Information
Directories in an MSCS Configuration [page 127]

7.1.3 Directories in an MSCS Configuration

The following tables show the directories where the main software components for the SAP cluster installation are stored:

Directories on Local Disks on MSCS Nodes

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>A supported operating system [page 46]</td>
<td>%windir%</td>
</tr>
<tr>
<td>MSCS software</td>
<td>%windir%\Cluster</td>
</tr>
<tr>
<td>SAP cluster files</td>
<td>%windir%\SAPCluster</td>
</tr>
<tr>
<td>Application server (if installed locally)</td>
<td>&lt;local_drive&gt;:\usr\sap&lt;SAPSID&gt;&lt;Instance&gt;</td>
</tr>
<tr>
<td>SAP MaxDB instance-independent programs</td>
<td>&lt;drive&gt;:\sapdb\program</td>
</tr>
<tr>
<td>SAP MaxDB instance-dependent software</td>
<td>&lt;drive&gt;:\sapdb&lt;DBSID&gt;\db</td>
</tr>
</tbody>
</table>

05/16/2008 PUBLIC 127/158
**Directories on Shared Disks**

<table>
<thead>
<tr>
<th>Component</th>
<th>Default Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster quorum resource (if used)</td>
<td>&lt;drive&gt;\MSCS (Windows Server 2003)</td>
</tr>
<tr>
<td></td>
<td>&lt;drive&gt;\Cluster (Windows Server 2008)</td>
</tr>
<tr>
<td>SAP global and instance directories</td>
<td>&lt;drive&gt;\usr\sap ...</td>
</tr>
<tr>
<td>SAP MaxDB data volumes</td>
<td>&lt;drive&gt;\sapdb&lt;SAPSID&gt;\sapdata...</td>
</tr>
<tr>
<td>SAP MaxDB database log volumes</td>
<td>&lt;drive&gt;\sapdb&lt;SAPSID&gt;\saplog...</td>
</tr>
<tr>
<td>SAP MaxDB mirrored database log volumes</td>
<td>&lt;drive&gt;\sapdb&lt;SAPSID&gt;\saplog...</td>
</tr>
<tr>
<td>SAP MaxDB instance-independent data</td>
<td>&lt;drive&gt;\sapdb\data</td>
</tr>
</tbody>
</table>

**SapCluster Directory**

In an SAP cluster installation, an additional directory – %WINDIR%\SapCluster – is created under the system directory.

This contains all the SAP files required by all MSCS cluster nodes, independently of the MSCS node the SAP instance is running on. The files are database tools and program files (executables) used by the operating system monitor (SAPOsCol).

The directory is added to the path variable of the user <sapsid>adm.

**7.1.4 IP Addresses in an MSCS Configuration**

A part of the installation process that is unique to MSCS is the configuration of host names and IP addresses in the network. This is a particularly important task because the addressing plays a key role in the switchover procedure. Addressing must be set up correctly so that the system can take advantage of the cluster functionality and switch between nodes when hardware problems arise.

This section explains the different types of IP addresses and their function in the switchover mechanism of one MSCS cluster with two MSCS nodes.

**Note**

**Windows Server 2008 only:**

As of Windows Server 2008, besides static IP addresses, you can also have DHCP-based (dynamic) IP addresses. The DHCP-based IP addresses are currently only supported when all MSCS nodes are located in the same subnet.

If the network adapters are assigned to DHCP-based IP addresses, the virtual IP addresses are also configured automatically as DHCP-based IP addresses.

**Types of IP Addresses**

In a correctly configured cluster with two nodes, there are seven IP addresses and corresponding host names for your SAP system.
You have two IP addresses for each MSCS node, one IP address for the cluster, one address for the SAP cluster group and one for the database cluster group. Some of the addresses are assigned to the network adapters (cards), others are virtual IP addresses that are assigned to the cluster groups.

**Physical IP Addresses Assigned to Network Adapters**

An MSCS configuration has two networks:

- A public network that is used for the communication between the primary application server, additional application servers and the LAN.
- A private network that is used internally for communication between the nodes of the cluster.

**Note**

For more information on network configuration, see also the Microsoft Knowledge Base Article 259267.

The following figure shows an MSCS cluster with two nodes and illustrates the adapters required for the public and private networks, and their corresponding physical IP addresses. A physical IP address, as opposed to a virtual one, is stationary and permanently mapped to the same adapter.

**Figure 19:** Adapters and IP Addresses Required for Public and Private Networks in an MSCS Cluster with Two Nodes
Host Names Assigned to Network Adapters

Each of the physical IP addresses of the network adapters must have a corresponding host name. For example, on the left-hand node in the figure above, you might assign the IP addresses of the public and private network adapters as follows:

<table>
<thead>
<tr>
<th>Network Adapter</th>
<th>IP Address</th>
<th>Host Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adapter 1 (private network)</td>
<td>10.1.1.1</td>
<td>clusA_priv</td>
</tr>
<tr>
<td>Adapter 3 (public network)</td>
<td>129.20.5.1</td>
<td>clusA</td>
</tr>
</tbody>
</table>

⚠️ Caution

- The IP address and host name of the public network adapter is also the IP address and name of the machine. In our example, this means that the machine that is the MSCS node on the left in the figure has the name clus1.
- Do not confuse the host name with the computer name. Each node also has a computer name, which is often the same as the host name.

The computer name is displayed in the node column of the Cluster Administrator (Windows Server 2003) or Failover Cluster Management (Windows Server 2008). However, it is not required for the TCP/IP communication in the cluster. When you configure IP addresses and corresponding names, keep in mind that it is the host names that are important for the cluster, not the computer names.

Virtual IP Addresses Assigned to Cluster Groups

When you have installed the SAP system and fully configured the cluster, the critical system resources are bound together in three different groups. Each of these groups requires a virtual IP address and host name that is permanently mapped to the group and not to a particular node. This has the advantage that, whenever a group is moved between nodes, its IP address and host name move together with it.

An MSCS configuration has the following groups:

- SAP cluster group for each clustered SAP system
- Database cluster group for each clustered SAP system
- Cluster group

⚠️ Note

Windows Server 2008 only:
Although it exists, the cluster group is not visible.

Each group consists of a set of related resources that work together to offer a service to the system. For example, the database cluster group comprises all the resources that enable the database server to fulfill the requests of a client. When the group is moved from one node to the other, due to node
failure, the virtual IP address and host name move with it. Therefore, there is a failover not only of resources, but also of the virtual IP address and host name. As a result, all clients can still reach the database server with the same IP address as before. The following figure illustrates how the virtual IP addresses of the database group and SAP group can move from one node to the other when failover occurs.

**Figure 20:** Failover of Virtual IP Addresses

![Failover of Virtual IP Addresses](image)

### 7.1.5 Obtaining and Determining IP Addresses for MSCS

**Note**

*Windows Server 2008 only:*

As of Windows Server 2008, besides static IP addresses you can use DHCP-based IP addresses. The following information is only relevant if you use **static** IP addresses.

This chapter describes how to obtain and to find out the IP addresses for the network adapters (cards) that are required to install and run your cluster configuration.

You need to correctly configure IP addresses for a cluster system. During the installation procedure you have to assign at least seven IP addresses and host names. You normally obtain these names and addresses from the system administrator.

**Obtaining IP Addresses**

Ask the system administrator to give you the addresses and host names listed in the tables below, which shows an example for a configuration with one MSCS cluster with two nodes. You need to enter the addresses and host names later during the installation process.
The column *Defined During* indicates at which stage of the installation the addresses are defined in the system.

**Caution**

Use the names exactly as specified by the system administrator, carefully observing uppercase and lowercase letters.

**Note**

In the following tables we are only using the terminology *cluster group*, and not the Windows Server 2008 terminology *service and application*.

### Physical IP Addresses

<table>
<thead>
<tr>
<th>Component</th>
<th>Example for Physical IP Address</th>
<th>Example for Physical Host Name</th>
<th>Purpose</th>
<th>Defined During</th>
</tr>
</thead>
<tbody>
<tr>
<td>First MSCS Node: adapter for private network</td>
<td>10.1.1</td>
<td>clusA_priv</td>
<td>Address for internode communication on the private network</td>
<td>Windows installation</td>
</tr>
<tr>
<td>First MSCS Node: adapter for public network</td>
<td>129.20.5.1</td>
<td>clusA</td>
<td>Address of the first MSCS node for communication with application servers and LAN (this is the same as the address of the first MSCS node)</td>
<td>Windows installation</td>
</tr>
<tr>
<td>Additional MSCS Node: adapter for private network</td>
<td>10.1.2</td>
<td>clusB_priv</td>
<td>Address for internode communication on the private network</td>
<td>Windows installation</td>
</tr>
<tr>
<td>Additional MSCS Node: adapter for public network</td>
<td>129.20.5.2</td>
<td>clusB</td>
<td>Address of the additional MSCS node for communication with application servers and LAN (this is the same as the address of the additional MSCS node)</td>
<td>Windows installation</td>
</tr>
</tbody>
</table>
Virtual IP Addresses

<table>
<thead>
<tr>
<th>Component</th>
<th>Example for Virtual IP Address</th>
<th>Example for Host Name</th>
<th>Purpose</th>
<th>Defined During</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster group</td>
<td>129.20.5.3</td>
<td>clusgrp</td>
<td>Virtual address and name of the cluster group. It identifies the cluster and is used for administration purposes.</td>
<td>MSCS software installation</td>
</tr>
<tr>
<td>SAP cluster group</td>
<td>129.20.5.4</td>
<td>sapgrp</td>
<td>Virtual address and name for accessing the group of SAP resources, regardless of the node it is running on</td>
<td>Configuration of SAP system for MSCS with SAPInst on the first node</td>
</tr>
<tr>
<td>Database cluster group</td>
<td>129.20.5.5</td>
<td>dbgrp</td>
<td>Virtual address and name for accessing the group of database resources, regardless of the node it is running on</td>
<td>Execution of MSCS wizard or database-specific cluster scripts</td>
</tr>
</tbody>
</table>

Determining Existing IP Addresses
To find out the existing IP addresses and corresponding host names and addresses, proceed as follows:

1. For **Windows Server 2003** choose \(\text{Start} \rightarrow \text{Control Panel} \rightarrow \text{Network Connections} \).
   For **Windows Server 2008** choose \(\text{Start} \rightarrow \text{Control Panel} \rightarrow \text{Network and Sharing Center} \rightarrow \text{Manage network connections} \).
2. Right-click one of the network cards (default name is *Local Area Connection*) that are displayed and choose *Properties*.
3. Right-click on one of the network cards that are displayed (default name is *Local Area Connection*) and choose *Properties*.
4. Choose \(\text{Internet Protocol (TCP/IP)} \rightarrow \text{Properties} \).
   The *Internet Protocol (TCP/IP) Properties* dialog box appears and shows the IP address of the initially selected network card.
5. To find out the host name that is mapped to the IP address, use the `ping` command:
   ```
   ping -a <IP_Address>
   ```
   The system returns the host name assigned to the IP address.
   Do not forget to ping your local machine as well.
6. Repeat these steps for the other network cards.
For more information about IP addresses in the cluster environment, see IP Addresses in an MSCS Configuration [page 128].

### 7.2 Preparation

For the installation of a high-availability system with Microsoft Cluster Service (MSCS), you have to perform the same general preparations as for a distributed system [page 31]. In addition, you have to perform the following MSCS-specific preparation tasks:

1. On all MSCS nodes, you manually assign drive letters to the shared disks [page 134]. All MSCS nodes must access the shared disks with the same drive letters.
2. You map the IP addresses to host names [page 135] on the Domain Name System (DNS) Server or in the hosts file.

#### Note

**Windows Server 2008 only:**

This step is not required if you use DHCP-based IP addresses.

3. You check the mapping of host names for MSCS [page 136].

#### Note

**Windows Server 2008 only:**

This step is not required if you use DHCP-based IP addresses.

4. Having finished all MSCS-specific preparations, continue with the installation tasks for MSCS [page 137].

#### Note

To make sure that all preparation steps have been correctly performed, check that you can move the disk resources from one MSCS node to another so that they are only accessible from a single node at any time.

### 7.2.1 Assigning Drive Letters for MSCS

We recommend that you assign drive letters to the shared disks. In an MSCS cluster, the shared disks that can be accessed by all MSCS nodes via a common bus must be addressed by all MSCS nodes with the same drive letters.

#### Procedure

2. Select a disk and choose Action → All tasks → Change Drive Letter and Paths...
3. Enter a new drive letter.

### 7.2.2 Mapping Host Names to IP Addresses for MSCS

**Note**

*Windows Server 2008 only:*

This step is not required if you use DHCP-based IP addresses.

To enable correct operation of the failover mechanism, you have to map all IP addresses in the MSCS cluster to host names.

The mapping enables the system to translate host names into IP addresses. Host names are normally used for administrative tasks because they are easier to use than the long, numeric IP addresses. However, the system can only respond to host names if they are translated into IP addresses.

**Prerequisites**

- You have installed the Windows operating system.
- You have the list of IP addresses [page 131].
- You have correctly entered all seven IP addresses required for the MSCS configuration.

**Caution**

Missing or incorrect entries for the IP addresses can cause problems later during the installation.

**Procedure**

To map the host names to the IP addresses, do one of the following:

- Map the host names to IP addresses on a Domain Name System (DNS) server.
- Map the IP addresses in the Windows `hosts` file.
  
  The file is located in the default Windows directory:

  `%SystemRoot%\system32\drivers\etc`

**Recommendation**

We recommend that you perform the mapping on the DNS server because this only requires a single entry.

If you perform the mapping in the `hosts` file, you have to maintain the `hosts` file on all MSCS nodes of the cluster, and on all application servers and front ends. This is necessary because each host in the system has its own `hosts` file.
### 7.2.3 Checking the Mapping of Host Names for MSCS

**Note**

*Windows Server 2008 only:*
This step is not required if you use DHCP-based IP addresses.

You need to check the mapping of host names to IP addresses as otherwise you might have serious
problems later.

**Prerequisites**
You have mapped the host names to the IP addresses [page 13][page 13] on the DNS Server or in the hosts file.

**Procedure**

1. For each IP address enter the following commands:
   a) `ping -a <IP_Address>`
      The system returns the host name that is assigned to the IP address.
   b) `ping hostname`
      The system returns the IP address that is assigned to the host name.

   **Note**
   - When you enter the `ping` command, you only get a reply if the host already exists.
   - If the address you are checking already exists in the system, you also receive a reply from the
     host. For example, after the installation of Windows and the configuration of the network,
     you get a reply when entering the IP addresses of the network adapters.

2. Compare the output with your own record of addresses and host names, and check for the
   following possible errors:
   - Incorrect output of uppercase and lowercase
     Make sure that you correct the error before you proceed with the installation.
   - Error in the network bindings
     If you enter the name of the public network adapter, which is usually also the name of the
     local host, and the system returns the IP address of the private network, there is an error
     in the network bindings.

     To correct the network bindings, do the following on all MSCS nodes:
     a) Choose | Start | Settings | Network and Dial-up Connections |
        The Network and Dial-up Connections window appears.
     b) Choose | Advanced | Advanced Settings | Adapters and Bindings |
        The network cards of the private and public networks are displayed for the current MSCS
        node.
7.3 Installation

The following sections provide information about how to install the SAP system for MSCS.

Note

■ Make sure that you are logged on as domain administrator, unless otherwise specified.
If for any reason, you are not granted domain administrators rights, you can perform the installation as a domain user who is a member of the local administrators group. However, the domain administrator has to prepare the system appropriately for you. Do not use the user <sapsid>adm unless specified.
■ On the first MSCS node, in the Cluster Administrator (Windows Server 2003) or Failover Cluster Management (Windows Server 2008) make sure that all existing cluster groups are online.
■ If you are prompted during the installation process, log off and log on again.
■ When you reboot during the installation process [page 139], resources fail over to the other MSCS node(s). Therefore, pause the other MSCS node(s) before the reboot.

You have to perform the following steps:
1. In the Cluster Administrator (Windows Server 2003) or Failover Cluster Management (Windows Server 2008) you move all disk groups and the cluster group to the first MSCS node [page 138].
2. You install the central services instance (SCS) on the first MSCS node [page 139] of the host where the SCS instance is to run.
3. You configure the first MSCS node [page 141].
4. You install the SAP MaxDB database on the first MSCS node [page 142].
5. You configure the SAP MaxDB database on the additional MSCS node [page 142].
6. You install the database instance on the first MSCS node [page 143] of the host where the database instance is to run.
7. You install the host agent on the additional MSCS node [page 143] of the host where the host agent is to run.
8. You configure the additional MSCS node [page 144].
9. If required, you install an enqueue replication server [page 145] on the host where the (A)SCS instance runs.
10. You install the primary application server instance [page 146] on the host where the primary application server instance host is to run.
11. You install at least one additional application server instance [page 147] on the host where the additional application server instance is to run.
7.3.1 Clustering the SQL Server 2008 Database Server Software

Note
When this guide was published, SQL Server 2008 was not yet released. As soon as we release SQL Server 2008, you can find the clustering procedure (SQL4SAP.doc.pdf) on the SQL Server RDBMS DVD delivered by SAP.

The SQL Server 2008 database server software must be installed on the database host.

7.3.2 Moving MSCS Groups

Note
As of Windows Server 2008 there are the following terminology changes:

- Cluster groups are now called services and applications.
  - We do not always use both names in this section.
- The Cluster Administrator is now called Failover Cluster Management.

During the cluster installation you have to move the database, SAP, or disk cluster groups from one MSCS node to the other before you can continue. You use the Cluster Administrator (Windows Server 2003) or Failover Cluster Management (Windows Server 2008) for this.

Prerequisites

- Windows Server 2003:
  - The groups you want to move are configured and are visible in the Cluster Administrator.

- Windows Server 2008:
  - The services or applications you want to move are configured and are visible in the Failover Cluster Management.

- For more information if you need to reboot during the installation, see Rebooting During the Installation or Conversion for MSCS [page 139].

Windows Server 2003: Moving Groups with the Cluster Administrator

1. Start the Cluster Administrator with Start ➤ All Programs ➤ Administrative Tools ➤ Cluster Administrator ➤.
2. In the Cluster Administrator, select the group you want to move and drag it to the required MSCS node on the left-hand pane.
3. Repeat the previous step for each group that you want to move.
Windows Server 2008: Moving Services and Applications with the Failover Cluster Management

Note
Only move disks that are assigned to services or applications.

2. In the Failover Cluster Management, right click the service and application you want to move.
3. Choose Move this service or application to another node Move to <relevant node>.
4. Repeat the previous step for each service and application that you want to move.

7.3.3 Rebooting During the Installation or Conversion for MSCS

You only need to perform this procedure if you have to reboot during the installation or conversion for MSCS. A reboot means that resources fail over to another MSCS node. To avoid this, pause the additional MSCS node in the Cluster Administrator.

Procedure

1. Before the reboot, pause the additional MSCS node(s) in the Cluster Administrator (Windows Server 2003) or Failover Cluster Management (Windows Server 2008).
2. After the reboot, activate the paused MSCS node(s) in the Cluster Administrator (Windows Server 2003) or Failover Cluster Management (Windows Server 2008).
3. If you forgot to pause the MSCS node(s) before you reboot, perform the following steps:
   a) After the reboot, in the Cluster Administrator (Windows Server 2003) or Failover Cluster Management (Windows Server 2008), move all resources back to the original node.
   b) Restart the Windows Server service.

7.3.4 Installing the Central Services Instance (SCS)

1. Windows Server 2008 only:
   Before you install the central services instance (SCS), you must create the SAP Services and Applications as follows:
   a) Open the Failover Cluster Management Console.
   b) Expand the navigation tree of the cluster.
   c) Right-click Services and Applications.
   d) Choose More Actions... Create Empty Service or Application.
   e) Rename the newly created service and application to SAP <SAPSID>.
f) Right-click the service and application SAP <SAPSID> and choose Add Storage.
g) Select the disk where the SAP instance is to be installed and choose OK.
h) Right-click the service and application SAP <SAPSID>.
i) Choose ▶ Add a resource ▶ Client Access Point ▶.
j) In the wizard Client Access Point, under Name enter the virtual host name for the SCS instance and choose Next and then Finish.

Note
Depending on whether you use DHCP, you might need to enter the IP Address details on the second tab. Confirm your entries with Next and then Finish

k) Right-click the service and application SAP <SAPSID>.
l) Choose ▶ Add a resource ▶ Add File Server ▶.
m) Double-click New File Server.
n) In the New File Server Properties window, change the Resource Name from New File Server to SAP <SAPSID> FileServer.

Caution
If you do not change the name, the clustering steps with SAPinst fail.

o) Go to the Dependencies tab and add the cluster disk resource to the dependencies list.
Add the Name:Virtual Networkname to the dependencies list.
p) Right-click the SAP <SAPSID> FileServer resource and choose Bring this resource online.

2. Run SAPinst [page 68].

Caution
Windows Server 2008 only:
Do not start the SAPinst executable sapinst.exe by double-clicking it in the Windows Explorer. Instead, open a Command Prompt and change to the directory:<InstallationMasterDVD>:\IM_WINDOWS_<platform>. Enter sapinst.exe SAPINST_USE_HOSTNAME=<virtual hostname of SCS instance>

3. Choose ▶ <Your SAP System> ▶ Installation Options ▶ High-Availability System ▶ Based on <technical stack> ▶ Central Services Instance (SCS) ▶ .
4. If you are installing the SCS instance with SAPinst for the first time and SAPinst prompts you to log off, choose OK and log on again.
5. Follow the instructions in the SAPinst dialogs and enter the required parameter values.

Note
For more information about the input parameters, position the cursor on a parameter and press F1 in SAPinst.
7.3.5 Configuring the First MSCS Node

To configure the first MSCS node so that it functions properly in MSCS, you have to run the cluster configuration option offered by the SAPInst tool. When you run this option it:

- Creates the SAP cluster group
- Copies tools to the SAPCluster directory
- Sets the SAPService to manual

Caution
When you reboot during the conversion to MSCS [page 139], resources fail over to another MSCS node. Therefore, after each reboot you have to return the system to the state it had before the reboot.

Prerequisites
- You are logged on to the first MSCS node as domain administrator or as a local user with domain administration rights. For more information, see Performing a Domain Installation without being a Domain Administrator [page 58].
- The SCS installation drive must be online on the first MSCS node.

Procedure
1. Run SAPInst and choose &lt;Your SAP System&gt; &gt; Installation Options &gt; High-Availability System &gt; Based on &lt;technical stack&gt; &gt; First MSCS Node &lt;.

   Note
   If SAPInst prompts you to log off from your system, log off and log on again.

2. Enter the required parameter values.
Note

For more information about the input parameters, position the cursor on the parameter and press [F1] in SAPinst.

Result

SAPinst converts the SAP instances on the first MSCS node for operation in MSCS.

7.3.6 Installing the Database on the First Node

1. Run SAPinst [page 68] and choose <Your SAP System> → SAP Systems → Database → High-Availability System → Based on <technical stack> → MaxDB Database Installation.
2. If you are installing the SAP MaxDB database with SAPinst for the first time and SAPinst prompts you to log off, do the following:
   a) Choose OK and log on again.
   b) Perform step 1 above.
   c) Select Run a new installation and choose OK.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.

Note

For more information about the input parameters, position the cursor on a parameter and press [F1] in SAPinst.

Caution

Make sure that you distribute the SAP MaxDB software and logs correctly to local and shared disks as described in Directories in an MSCS Configuration [page 127].

7.3.7 Configuring the Database on the Additional Node

Prerequisites

- The SAP database group is Online on the first MSCS node.

Procedure

Perform the following steps on the additional MSCS node.

1. On the additional MSCS node, run SAPinst [page 68] and choose <Your SAP System> → SAP Systems → Database → High-Availability System → Based on <technical stack> → MaxDB Database Configuration.
2. Follow the instructions in the SAPinst dialogs and enter the required parameter values.
7.3 Installation

⚠️ Caution
Make sure that you distribute the SAP MaxDB software and logs correctly to local and shared disks as described in Directories in an MSCS Configuration [page 127].

🔍 Note
For more information about the input parameters, position the cursor on a parameter and press the \[F1\] key in SAPinst.

### 7.3.8 Installing the Database Instance

**Prerequisites**
- The SAP cluster group is **Online** on the first MSCS node.

**Procedure**
Perform the following steps on the first MSCS node.

1. On the first MSCS node, run SAPinst [page 68] and choose \[\text{\textbf{<Your SAP System> \textbf{\textgreater}}} \text{\textbf{\textgreater} SAP Systems with <Database> \textbf{\textgreater} Installation Options} \textbf{\textgreater} High-Availability System \textbf{\textgreater} Based on <technical stack> \textbf{\textgreater} Database Instance \textbf{\textgreater}\]
2. Follow the instructions in the SAPinst dialogs and enter the required parameter values.
   a) For the profile directory you have to use the UNC path of the **virtual** (A)SCS host name, for example:
      \[\text{\textbackslash\textbackslash<SAPGLOBALHOST>\sapmnt<\SAPSID>\SYS\profile}\]
   b) When SAPinst prompts you for the database host, make sure that you enter the **virtual** database host.

🔍 Note
For more information about the input parameters, position the cursor on a parameter and press the \[F1\] key in SAPinst.

### 7.3.9 Installing the Host Agent on the Additional MSCS Node

You must install the host agent on the additional MSCS node(s). SAPinst installs the host agent with the instance number **99** and the SAP system ID **SAP**.

**Procedure**

1. Run SAPinst [page 68] on the additional MSCS node and choose \[\text{\textbf{<Your SAP System> \textbf{\textgreater}}} \text{\textbf{\textgreater} Installation Options} \textbf{\textgreater} SAP Systems with <Database> \textbf{\textgreater} High-Availability System \textbf{\textgreater} Based on <technical stack> \textbf{\textgreater} Host Agent \textbf{\textgreater}\]
2. If SAPinst prompts you to log off, choose **OK** and log on again.
3. Follow the instructions in the SAPInst dialogs and enter the required parameter values.

Note
For more information about the input parameters, position the cursor on a parameter and press [F1] in SAPInst.

4. For Destination Drive, select a local drive on the MSCS node.

Note
The screen General SAP System Parameters is not displayed if one of the following cases apply:
- There is only one disk available
- SAPInst then installs the host agent on the local disk.
- The saploc share already exists
  saploc must then point to the correct local disk. If it points to the wrong disk, delete the
  saploc share with the command: net share saploc /DELETE

5. Start the installation.

7.3.10 Configuring the Additional MSCS Node

To configure the additional MSCS node(s) in the cluster, you have to run the MSCS configuration option for each additional MSCS node offered by the SAPInst tool. When you run this option it:
- Creates users and groups
- Sets the system and user environment
- Enters required port numbers in the Windows services file
- Creates the SAPSrvce

Caution
When you reboot during the conversion to MSCS [page 139], resources fail over to another MSCS node. Therefore, after each reboot you have to return the system to the state it was in before the reboot.

Prerequisites
- You are logged on to the additional MSCS node as domain administrator or as a local user with domain administration rights. For more information, see Performing a Domain Installation without being a Domain Administrator [page 58].
- You have already configured the first MSCS node [page 141], which is the primary cluster node.
Procedure

1. Run SAPinst and choose ▶ <Your SAP System> ▶ Installation Options ▶ SAP Systems with <Database> ▶ High-Availability System ▶ Based on <technical stack> ▶ Additional MSCS Node.

   ![Note]
   If SAPinst prompts you to log off from your system, log off and log on again.

2. Enter the required parameter values.

   ![Note]
   For more information about the input parameters, position the cursor on the parameter and press F1 in SAPinst.

   When you have made all required entries, SAPinst begins processing and converts the SAP instances on the other MSCS node for operation in MSCS.

3. When SAPinst has finished, start the SAP <SAPSID> cluster group (Windows Server 2003) or service and application (Windows Server 2008) as follows:

   **Windows Server 2003 only:**
   a) Open the Cluster Administrator with:
      ▶ Start ▶ Control Panel ▶ Administrative Tools ▶ Cluster Administrator
   b) Select the SAP cluster group and bring it online.

   **Windows Server 2008 only:**
   a) Open the Failover Cluster Management with:
      ▶ Start ▶ Control Panel ▶ Administrative Tools ▶ Failover Cluster Management
   b) Right-click the service and application SAP <SAPSID> and bring it online.

### 7.3.11 Installing an Enqueue Replication Server

We strongly recommend to install an enqueue replication server with SAPinst. You have to install the enqueue replication server with SAPinst on each MSCS nodes where an SCS instance is running.

**Prerequisites**

- Your SCS instance is already clustered with MSCS.
- You have to install the enqueue replication server on a local disk.
- You have moved the SAP cluster group to the first MSCS node.

**Procedure**

1. On the first MSCS node, log on as domain user who is a member of the local administrators group.
2. Run SAPinst [page 68] and choose \<Your SAP System> \ Installation Options \ High-Availability System \ Based on \<technical stack> \ Enqueue Replication Server 44.

3. Follow the instructions in the SAPinst dialogs and enter the required parameters. Note the following, when entering the parameters:
   - On the SAPinst screen SAP Instance, enter the:
     - SAP system ID \<SAPSID> of your SAP system
     - Instance number of the (A)SCS instance
     - Virtual instance host name of the (A)SCS instance
   - On the SAPinst screen Enqueue Replication Server Instance, enter a unique instance number that is not in use by another instance on this host.
   - Decide if you want to restart the (A)SCS instance and service cluster resources with SAPinst now, or later with the Cluster Administrator (Windows Server 2003) or Failover Cluster Management (Windows Server 2008).

   ![Note]
   You only need to do this once for all enqueue replication servers that you install on the MSCS nodes.

After you have entered all required input information, SAPinst starts the installation and displays the progress of the installation. During the process phase, the enqueue server instance is started. SAPinst installs the enqueue replication server instance on a local disk in the following directory:

```
\usr\sap\<SAPSID>\ERS<instance_number>\`
```

![Note]
The profile is replicated from the global host to the local instance profile folder. The enqueue replication server instance uses the profile from the local instance profile folder:

```
\usr\sap\<SAPSID>\ERS<instance_number>\profile\`
```

4. On the additional MSCS node, start SAPinst to install the enqueue replication server for the (A)SCS instance as described in step 2 above.

![Note]
There is no need to move the (A)SCS cluster group to another MSCS node.

5. Enter the required parameter values in the SAPinst dialogs as described above.

### 7.3.12 Installing the Primary Application Server Instance

The following describes how to install the primary application server instance for MSCS.

You have the following options to install the primary application server instance:
You install the primary application server instance on an MSCS node.
In this case, bring the SAP cluster group online on this node, and make sure that the primary application server instance number is different from the (A)SCS instance number.

You install the primary application server instance on a host outside of MSCS.
In this case, you have to install the database client software on this host.

**Procedure**

1. Run SAPinst [page 68] and choose [>] <Your SAP System> [>] Installation Options [>] High-Availability System [>] Based on <technical stack> [>] Primary Application Server Instance [<>].
2. If SAPinst prompts you to log off, choose OK and log on again.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.

**Note**

- For more information about the input parameters, position the cursor on a parameter and press **F1** in SAPinst.
- If you install the primary application server instance on an MSCS node, make sure that on the screen General SAP System Parameters for the:
  - **Profile Directory**, you use the UNC path (not the local path) of the virtual (A)SCS host name, for example:
    \<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
  - **Destination Drive**, you select the local disk where you want to install the primary application server instance. Do not enter the shared disk for the (A)SCS instance.

**Note**

If the destination drive is not shown and you cannot select it, the saploc share already exists. Since you already installed the ERS instance on the local drive, and the saploc share points to that local drive, SAPinst automatically takes that drive as destination drive.

4. Check that the primary application server instance is running.

**7.3.13 Installing the Additional Application Server Instance**

You have to install at least one additional application server instance for MSCS.
You have the following options to install the additional application server instance:

- You install the additional application server instance on an MSCS node.
  In this case, bring the SAP cluster group online on this node, and make sure that the additional application server instance number is different from the (A)SCS instance number.
- You install the additional application server instance on a host outside of MSCS.
  In this case, you have to install the database client software on this host.
Procedure

1. Run SAPinst [page 68] and choose ▶ <Your SAP System> ▶ Installation Tasks ▶ SAP Systems with <Database> ▶ High-Availability System ▶ Based on <technical stack> ▶ Additional Application Server Instance ▶.
2. If SAPinst prompts you to log off, choose OK and log on again.
3. Follow the instructions in the SAPinst dialogs and enter the required parameter values.

Note

For more information about the input parameters, position the cursor on a parameter and press F1 in SAPinst.

Caution

- If you install the additional application server instance on an MSCS node, make sure that on the screen General SAP System Parameters for the:
  - Profile Directory, you use the UNC path (not the local path) of the virtual (A)SCS host name, for example:
    \\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.
  - Destination Drive, you choose the local disk where you want to install the additional application server instance. Do not enter the shared disk for the (A)SCS instance.

Caution

Make sure that on the screen General SAP System Parameters for the Profile Directory, you use the UNC path of the virtual (A)SCS host name, for example:
\\<SAPGLOBALHOST>\sapmnt\<SAPSID>\SYS\profile.

7.4 Post-Installation

This section describes how to complete and check the installation of the SAP system for an MSCS configuration:

1. You perform the post-installation checks for the enqueue replication server [page 149].
2. You perform the general post-installation steps [page 81] listed in this guide.
3. If you want to use the DBA Cockpit in your MSCS environment, you must apply SAP Note 978319.
### 7.4.1 Post-Installation Checks for Enqueue Replication Server

#### Note

Make sure that you have restarted the (A)SCS instance and service cluster resources SAP <SAPSID> <(A)SCS_instance_number> Instance and SAP <SAPSID> <(A)SCS_instance_number> Service. You can do this either with SAPinst while performing the installation, or with the Cluster Administrator (Windows Server 2003) or Failover Cluster Management (Windows Server 2008).

The following sections describe the tests you must perform to check whether the installed enqueue replication server works properly. For these tests you use the ENQT and ENSMON command line tools, which allow remote access to the enqueue server statistics. Before you can use these tools you must copy them to the remote host where the Enqueue Replication Server is running and from where you want to start the tests.

You perform the following steps:

1. You copy ENQT.exe and ENSMON.exe from your cluster's binary directory on the sapmnt share \<host>\sapmnt\<SAPSID>\SYS\exe\<codepage>\<platform> to a directory on the remote host from where you run the tests.
2. You check the status of the enqueue replication server with the ENSMON tool [page 149].
3. You check the fill status and ID of the lock table during failover with the ENQT tool [page 150].

#### 7.4.1.1 Checking the Status of the Enqueue Replication Server with ENSMON

You use the ENSMON tool to check if the enqueue replication server and the enqueue server are properly connected.

**Prerequisites**

- You have started the (A)SCS instance of your SAP system.
- You run the ENSMON tool from the host where you installed the Enqueue Replication Server.

**Procedure**

To check the status of the enqueue replication server enter the following command:

```bash
ensmon pf=<ERS_instance_profile> 2
```

where `<ERS_instance_profile>` is the profile created during the installation of the Enqueue Replication Server.

---

The page is from a document discussing high availability with Microsoft Cluster Service (MSCS). It focuses on post-installation checks for the Enqueue Replication Server, specifically using the ENSMON tool to verify the status of replication. The document provides a step-by-step guide on how to check the status of the enqueue replication server, including prerequisites and a procedure for using the ENSMON tool. The note section advises to ensure the SAP instance is restarted after installation to ensure proper operation.
If the enqueue replication server and the enqueue server are properly connected, the output is similar to this:

Try to connect to host <Virtual (A)SCS host> service sapdp01 get replinfo request executed successfully
Replication is enabled in server, repl. server is connected
Replication is active
...

If the enqueue replication server and the enqueue server are not properly connected, the output is similar to this:

Try to connect to host <Virtual (A)SCS host> service sapdp01 get replinfo request executed successfully
Replication is enabled in server, but no repl. server is connected
...

7.4.1.2 Monitoring the Lock Table During Failover with ENQT

With the following tests you monitor and check the fill status and ID of the lock table using the ENQT tool.

Prerequisites

- You have started the (A)SCS instance of your SAP system.
- You run the ENQT tool from the host where you installed the Enqueue Replication Server.

Caution

Only use the ENQT commands stated in this procedure otherwise you might damage the enqueue server’s lock table.

Monitoring the Lock Table Fill Status During Failover with ENQT

1. Use the following command to fill the lock table of the enqueue server with 20 locks:
   
   ```
   enqt pf=<ERS_instance_profile> 11 20
   ```

   where `<ERS_instance_profile>` is the profile created during the installation of the Enqueue Replication Server.

2. Monitor the fill status of the lock table with the following command:
   
   ```
   enqt pf=<ERS_instance_profile> 20 1 1 9999
   ```

   This command continuously reads the content of the enqueue server’s lock table and returns the number of the table entries to the console.

3. Move the (A)SCS cluster group to another MSCS node to simulate an enqueue server failover while running the ENQT command.
The output is similar to this:

Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 0 (enqueue server fails over)
Number of selected entries: 20 (enqueue server is running again)
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 20
Number of selected entries: 20

4. Make sure that the lock count is the same before and after the failover.

**Monitoring the Lock Table ID During Failover with ENQT**

1. Monitor the lock table ID during the failover with the following command:
   ```bash
   for /l %i in (1,1,100000) do enqt pf=<ERS_instance_profile> 97
   ```
   where `<ERS_instance_profile>` is the profile created during the installation of the Enqueue Replication Server.

2. Move the (A)SCS cluster group to another MSCS node to simulate an enqueue server failover while running the ENQT command.
   The output is similar to this:
   ```plaintext
   (Output before failover)
   C:\WORK\HA\ENQU-Tests>enqt pf=BUG_ERS01_PCJ2EEV6 97
   ---REQ----------------------------------------------------------
   EnqId: EnqTabCreaTime/RandomNumber = 25.10.2005 11:15:59 1130231759 / 9288
   ...
   (Output after failover)
   C:\WORK\HA\ENQU-Tests>enqt pf=BUG_ERS01_PCJ2EEV6 97
   ---REQ----------------------------------------------------------
   EnqId: EnqTabCreaTime/RandomNumber = 25.10.2005 11:15:59 1130231759 / 9288
   ...
   ```

3. Make sure that the lock table ID (`ENQID`) is the same before and after the failover.
7.4.2 Starting and Stopping the SAP System in an MSCS Configuration

The following describes how to start or stop the SAP system in an MSCS configuration with:

- **SAP MMC**
  
  With the SAP MMC you can start or stop the complete SAP system or single instances if they are clustered or not.

- **Cluster Administrator (Windows Server 2003) or Failover Cluster Management (Windows Server 2008)**
  
  With the Cluster Administrator or Failover Cluster Management, you can only start or stop clustered instances such as the (A)SCS instance or the database instance. For all other instances, such as primary or additional application server instances, you must use the SAP MMC.

![Note]

You also use the Cluster Administrator or Failover Cluster Management for all other administrative tasks like moving clustered instances from one MSCS node to the other MSCS node.

**Procedure**

- **To start or stop your SAP system with the SAP MMC**, see Starting and Stopping the SAP System [page 110].

- **Windows Server 2003 only:**
  
  To start or stop the clustered (A)SCS instance or the database instance with the Cluster Administrator do the following:
  
  **Windows Server 2003 only:**
  
  To start or stop the clustered (A)SCS instance or the database instance with the Cluster Administrator do the following:
  
  2. To start or stop the (A)SCS instance of the SAP cluster group, right-click the relevant cluster resource SAP <SAPSID> <instance_no> Instance and choose Bring online or Take offline.
  3. To start or stop the database instance, right-click the database instance <database_resource> and choose Bring online or Take offline.

End of HA (MSCS)
© Copyright 2008 SAP AG. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP AG. The information contained herein may be changed without prior notice.

Some software products marketed by SAP AG and its distributors contain proprietary software components of other software vendors.

Microsoft, Windows, Excel, Outlook, and PowerPoint are registered trademarks of Microsoft Corporation. IBM, DB2, DB2 Universal Database, OS/2, Parallel Sysplex, MVS/ESA, AIX, S/390, AS/400, OS/390, OS/400, iSeries, pSeries, xSeries, zSeries, System i, System p, System p5, System x, System z, System z9, z/OS, AFP, Intelligent Miner, WebSphere, Netfinity, Tivoli, Informix, i5/OS, POWER, POWER5, POWER5+, OpenPower and PowerPC are trademarks or registered trademarks of IBM Corporation.

Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either trademarks or registered trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Oracle is a registered trademark of Oracle Corporation.

UNIX, X/Open, OSF/1, and Motif are registered trademarks of the Open Group.

Citrix, ICA, Program Neighborhood, MetaFrame, WinFrame, VideoFrame, and MultiWin are trademarks or registered trademarks of Citrix Systems, Inc.

HTML, XML, XHTML and W3C are trademarks or registered trademarks of W3C®, World Wide Web Consortium, Massachusetts Institute of Technology.

Java is a registered trademark of Sun Microsystems, Inc.

JavaScript is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by Netscape.

SAP, R/3, xApps, xApp, SAP NetWeaver, Duet, PartnerEdge, ByDesign, SAP Business ByDesign, and other SAP products and services mentioned herein as well as their respective logos are trademarks or registered trademarks of SAP AG in Germany and in several other countries all over the world. All other product and service names mentioned are the trademarks of their respective companies. Data contained in this document serves informational purposes only. National product specifications may vary.

These materials are subject to change without notice. These materials are provided by SAP AG and its affiliated companies (“SAP Group”) for informational purposes only, without representation or warranty of any kind, and SAP Group shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP Group products and services are those that are set forth in the express warranty statements accompanying such products and services, if any. Nothing herein should be construed as constituting an additional warranty.

This document was created using stylesheet 2006-12-31 (V5.1beta = 6.0 for E3) and XSLT processor SAXON 6.5.2 from Michael Kay (http://saxon.sf.net/), XSLT version 1.
Disclaimer
Some components of this product are based on Java™. Any code change in these components may cause unpredictable and severe malfunctions and is therefore expressly prohibited, as is any decompilation of these components. Any Java™ Source Code delivered with this product is only to be used by SAP’s Support Services and may not be modified or altered in any way.

Legal Software Terms

Terms for Included Open Source Software
This SAP software contains also the third party open source software products listed below. Note that for these third party products the following special terms and conditions shall apply.

1. This software was developed using ANTLR.
2. SAP License Agreement for STLport
   SAP License Agreement for STLPort between
   SAP Aktiengesellschaft
   Systems, Applications, Products in Data Processing
   Dietmar-Hopp-Allee 16
   69190 Walldorf, Germany
   (hereinafter: SAP)
   and
   you
   (hereinafter: Customer)
   a) Subject Matter of the Agreement
      A) SAP grants Customer a non-exclusive, non-transferable, royalty-free license to use the STLport.org C++ library (STLport) and its documentation without fee.
      B) By downloading, using, or copying STLport or any portion thereof, Customer agrees to abide by the intellectual property laws, and to all of the terms and conditions of this Agreement.
      C) The Customer may distribute binaries compiled with STLport (whether original or modified) without any royalties or restrictions.
      D) Customer shall maintain the following copyright and permissions notices on STLport sources and its documentation unchanged: Copyright 2001 SAP AG
      E) The Customer may distribute original or modified STLPort sources, provided that:
         ■ The conditions indicated in the above permissions notice are met;
         ■ The following copyright notices are retained when present, and conditions provided in accompanying permission notices are met:

         Copyright 1994 Hewlett-Packard Company
         Copyright 1996,97 Silicon Graphics Computer Systems Inc.
         Copyright 1997 Moscow Center for SPARC Technology.
         Copyright 1999,2000 Boris Fomitchev
         Copyright 2001 SAP AG

Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Hewlett-Packard Company makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.

Permission to use, copy, modify, distribute and sell this software and its documentation for any purpose is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Silicon Graphics makes no
representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.
Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. Moscow Center for SPARC makes no representations about the suitability of this software for any purpose. It is provided “as is” without express or implied warranty.
Boris Fomitchev makes no representations about the suitability of this software for any purpose. This material is provided “as is”, with absolutely no warranty expressed or implied. Any use is at your own risk. Permission to use or copy this software for any purpose is hereby granted without fee, provided the above notices are retained on all copies. Permission to modify the code and to distribute modified code is granted, provided the above notices are retained, and a notice that the code was modified is included with the above copyright notice.
Permission to use, copy, modify, distribute and sell this software and its documentation for any purposes is hereby granted without fee, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting documentation. SAP makes no representations about the suitability of this software for any purpose. It is provided with a limited warranty and liability as set forth in the License Agreement distributed with this copy. SAP offers this liability and warranty obligations only towards its customers and only referring to its modifications.

b) Support and Maintenance
SAP does not provide software maintenance for the STLport. Software maintenance of the STLport therefore shall be not included.
All other services shall be charged according to the rates for services quoted in the SAP List of Prices and Conditions and shall be subject to a separate contract.

c) Exclusion of warranty
As the STLport is transferred to the Customer on a loan basis and free of charge, SAP cannot guarantee that the STLport is error-free, without material defects or suitable for a specific application under third-party rights. Technical data, sales brochures, advertising text and quality descriptions produced by SAP do not indicate any assurance of particular attributes.

d) Limited Liability
A) Irrespective of the legal reasons, SAP shall only be liable for damage, including unauthorized operation, if this (i) can be compensated under the Product Liability Act or (ii) if caused due to gross negligence or intent by SAP or (iii) if based on the failure of a guaranteed attribute.

B) If SAP is liable for gross negligence or intent caused by employees who are neither agents or managerial employees of SAP, the total liability for such damage and a maximum limit on the scope of any such damage shall depend on the extent to which its occurrence ought to have anticipated by SAP when concluding the contract, due to the circumstances known to it at that point in time representing a typical transfer of the software.

C) In the case of Art. 4.2 above, SAP shall not be liable for indirect damage, consequential damage caused by a defect or lost profit.

D) SAP and the Customer agree that the typical foreseeable extent of damage shall under no circumstances exceed EUR 5,000.

E) The Customer shall take adequate measures for the protection of data and programs, in particular by making backup copies at the minimum intervals recommended by SAP. SAP shall not be liable for the loss of data and its recovery, notwithstanding the other limitations of the present Art. 4 if this loss could have been avoided by observing this obligation.

F) The exclusion or the limitation of claims in accordance with the present Art. 4 includes claims against employees or agents of SAP.

3. Adobe Document Services
High Availability with Microsoft Cluster Service

7.4 Post-Installation

Adobe, the Adobe logo, Acrobat, PostScript, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. For information on Third Party software delivered with Adobe document services and Adobe LiveCycle Designer, see SAP Note 854621.

Documentation in the SAP Service Marketplace
You can find this document at the following address: https://service.sap.com/instguides
This page is intentionally left blank.